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LICENSE AGREEMENT FOR ZIFF-DAVIS' WINBENCHâ 4.0 
READ  THIS  AGREEMENT  CAREFULLY  BEFORE  USING  THE  SOFTWARE  EMBODIED  IN  THE 
WINBENCHâ 4.0 DISKETTE (OR, IF DOWNLOADED, IN THE DOWNLOADED FILE(S)).  Embodied in 
the  WinBench 4.0  diskette  ("diskette")  (or,  if  downloaded,  in the  downloaded file(s))  is  the WinBench 4.0 
computer program and related documentation (the "Software").  Ziff-Davis Publishing Company, L.P., having a 
place of business at One Park Avenue, New York, New York 10016 ("Ziff") is the licensor under this Agreement 
and you are the licensee.  By using the Software, in whole or in part, you agree to be bound by the terms of this  
Agreement. If you do not agree to the terms of this Agreement, promptly return the Software (or, if downloaded,  
delete the Software) to the Ziff-Davis Benchmark Operation at One Copley Parkway, Suite 510, Morrisville, 
North Carolina 27560.  Title to the Software and all copyrights, trade secrets and other proprietary rights therein 
are owned by Ziff.  All rights therein, except those expressly granted to you in this Agreement, are reserved by  
Ziff.  

1.  Limited License
This  Agreement  grants  you  only  limited rights  to  use  the Software.  Ziff  grants  you a non-exclusive,  non-
transferable license to use the Software on a single dedicated computer or on a  file  server networked with  
multiple PC computers  for  the  sole  purpose of  conducting benchmark tests  to  measure  the performance of 
computer hardware and operating system configurations.  You have the right to  make a single  copy of the 
Software for archival purposes and the right to transfer a copy of the Software across a network only to the PC 
computers attached to the network.  Ziff hereby grants you the right to publish benchmark test results obtained  
by you from your use of the Software provided that with the publication of each such result you: 

A. Identify Ziff-Davis, the name and version number of the benchmark Software used (i.e., Ziff-Davis' 
WinBenchâ Ver. 4.0);

B. Identify the exact name, processor speed and type, amount of RAM, amount of secondary RAM cache, if 
any, hard disk size, type of hard disk controller, and size of hardware hard disk cache, if any, of the PC 
used for the test (e.g., WXY Corp. Model 466 with 66-MHz Intelâ 486DX2-66 CPU, 8MB of RAM, 64KB 
RAM cache, 200MB hard disk, IDE controller, and no hardware disk cache); 

C. Identify the exact video adapter name, amount and type of RAM on it, video driver name and date, and 
refresh rate that produced the result (e.g., XYZ Corp. XYZ Video adapter with 2MB VRAM with 
XYZ.DRV version 1.1 driver and a refresh rate of 72 Hz); 

D. Identify the operating system version (e.g., MS-DOSÒ 5.0), size and type of software disk cache, if any 
(e.g., SMARTDRV 2MB cache), video resolution and color depth (e.g., 800 by 600 pixels with 256 colors), 
and any other special conditions used to achieve the result (e.g., disk compression utility ABC version 1.0 
enabled); 

E. State that all products used in the test were shipping versions available to the general public;
F. State that the test was performed without independent verification by Ziff; and 
G. Follow proper trademark usage and acknowledge Ziff's trademark rights (e.g., "[ ] achieved a score of X 

Graphics WinMarkä units or a score of Y Disk WinMarkä units on the WinBenchâ 4.0 test. WinBench 
and WinMark are trademarks of Ziff-Davis Publishing Company, L.P."). 

This Agreement and your rights hereunder shall automatically terminate if you fail to comply with any provision  
of this Agreement.  Upon such termination, you agree to cease all use of the Software, to delete the Software and 
to destroy all copies of the diskette and other materials contained in this package in your possession or under  
your control, or, if downloaded, to destroy any and all copies of the Software in your possession or under your  
control.
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2.  Additional Restrictions
A. You shall not (and shall not permit other persons or entities to) rent, lease, sell, sublicense, assign, or 

otherwise transfer the Software or this Agreement.  Any attempt to do so shall be void and of no effect.
B.   You shall not (and shall not permit other persons or entities to) reverse engineer, decompile, disassemble, 

merge, modify, include in other software or translate the Software, or use the Software for any commercial 
purposes, except for the publication of test results, as provided above.

C. You shall not (and shall not permit other persons or entities to) remove or obscure Ziff's copyright, 
trademark or other proprietary notices or legends from any of the materials contained in this package or 
downloaded.

3.  Limited Warranty and Limited Liability
THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED,  INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY AND 
FITNESS  FOR  A  PARTICULAR  PURPOSE.  THE  ENTIRE  RISK  AS  TO  THE  RESULTS  AND 
PERFORMANCE  OF  THE  SOFTWARE  IS  ASSUMED  BY  YOU,  AND  ZIFF  ASSUMES  NO 
RESPONSIBILITY FOR THE ACCURACY OR APPLICATION OF OR ERRORS OR OMISSIONS IN THE 
SOFTWARE.  IN  NO  EVENT  SHALL  ZIFF  BE  LIABLE  FOR  ANY  DIRECT,  INDIRECT,  SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 
THE SOFTWARE, EVEN IF ZIFF HAS BEEN ADVISED OF THE LIKELIHOOD OF SUCH DAMAGES 
OCCURRING.  ZIFF SHALL NOT BE LIABLE FOR ANY LOSS, DAMAGES OR COSTS, ARISING OUT 
OF, BUT NOT LIMITED TO, LOST PROFITS OR REVENUE, LOSS OF USE OF THE SOFTWARE, LOSS 
OF DATA OR EQUIPMENT, THE COSTS OF RECOVERING SOFTWARE, DATA OR EQUIPMENT, THE 
COST OF SUBSTITUTE SOFTWARE OR DATA, CLAIMS BY THIRD PARTIES, OR OTHER SIMILAR 
COSTS.

THE ONLY WARRANTY MADE BY ZIFF IS THAT THE ORIGINAL PHYSICAL MEDIA IN WHICH THE 
SOFTWARE IS EMBODIED AND WHICH IS DISTRIBUTED BY ZIFF SHALL BE FREE OF DEFECTS IN 
MATERIALS  AND  WORKMANSHIP.   ZIFF'S  ENTIRE  LIABILITY  AND  THE  USER'S  EXCLUSIVE 
REMEDY SHALL BE LIMITED TO THE REPLACEMENT OF THE ORIGINAL PHYSICAL MEDIA IF 
DEFECTIVE. THE WARRANTIES AND REMEDIES SET FORTH HEREIN ARE EXCLUSIVE AND IN 
LIEU  OF  ALL  OTHERS,  ORAL  OR  WRITTEN,  EXPRESS  OR  IMPLIED.   NO  ZIFF  AGENT  OR 
EMPLOYEE, OR THIRD PARTY, IS AUTHORIZED TO MAKE ANY MODIFICATION OR ADDITION TO 
THIS WARRANTY.

SOME STATES DO NOT ALLOW EXCLUSION  OR LIMITATION  OF IMPLIED  WARRANTIES  OR 
LIMITATION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES; SO THE ABOVE 
LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU.
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4.  U.S. Government Restricted Rights
The Software is licensed subject to RESTRICTED RIGHTS.  Use, duplication or disclosure by the Government 
or any person or entity acting on its behalf is subject to restrictions as set forth in subdivision (c)(1)(ii) of the  
Rights in Technical Data and Computer Software Clause at DFARS (48 CFR 252.227-7013) for DoD contracts, 
in paragraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights clause in the FAR (48 CFR 
52.227-19) for civilian agencies,  on in other comparable agency clauses. The contractor/manufacturer is  the 
Ziff-Davis Benchmark Operation, One Copley Parkway, Suite 510, Morrisville, North Carolina 27560. 

5.  General Provisions
Nothing in this Agreement constitutes a waiver of Ziff's rights under U.S copyright laws or any other Federal,  
state, local or foreign law.  You are responsible for installation, management, and operation of the Software.  
This Agreement shall  be construed, interpreted and governed under New York law.  If any provision of this  
Agreement  shall  be  held  by a  court  of  competent  jurisdiction to  be  illegal,  invalid  or  unenforceable,  the  
remaining provisions shall remain in full force and effect.  
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registered trademarks and 
First Looksä, MacBenchä, NetBenchä, PC Benchä, PC Direktä, 
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Preface
This manual tells you how to use and understand the WinBenchâ 
4.0 benchmark.

In this preface, you can find:

· Notes about WinBench

· A reading path to the manual that explains who needs to read 
which parts of the manual

· A list of the on-line documentation

· Information on the general Windowsä conventions that 
WinBench uses and the general conventions this manual uses

Introducing WinBench 

WinBench is a subsystem-level benchmark that tests the graphics 
and disk performance of PCs you use to run Microsoftâ 
Windowsä and Windows-based applications. WinBench consists 
of graphics and disk tests that reflect how such applications use the 
Windows environment. WinBench runs as a Windows application. 

NOTE:Unlike Ziff-Davis' Winstoneä 94 benchmark, WinBench 
does not run actual applications. Instead, it performs tests 
based on the operations that applications perform. 
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Information about these operations comes from extensive 
profiling of the applications. 

WinBench returns two key scores: the Graphics WinMarkä is a 
score based on a combination of graphics operations that leading 
Windows applications use most frequently, and the Disk WinMark 
is a measure of the throughput of the disk operations typical 
applications perform. WinBench also provides scores for 
individual graphics and disk tests. 

While WinBench tests the speed of graphics and disk operations, it 
does not provide a complete measure of your PC's performance. To 
get a complete view of your PC's performance, use WinBench in 
combination with two other 
Ziff-Davis benchmarks:

·  Winstone 94. Use this benchmark to measure the overall 
performance of your PC as it runs actual Windows-based 
applications. 

· PC Benchä. Use this benchmark to measure the speed of the 
processor subsystem of your PC.

NOTE:PC Bench also can test a PC's graphics and disk 
subsystems. The difference between the WinBench 
graphics and disk tests and the corresponding PC Bench 
subsystem tests is that the WinBench tests use 
Windows. Since the PC Bench tests do not execute on 
top of Windows, they will often produce different 
results.

You can get copies of WinBench and other Ziff-Davis benchmarks 
free of charge by contacting the Ziff-Davis Benchmark Operation 
(ZDBOp). See Appendix C for information on how to request 
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benchmarks.

Notes about WinBench

Please note the following before you run WinBench:

1. You must read and agree to the license information in the front 
of this manual before you use WinBench. This same licensing 
information appears on your screen the first time you start 
WinBench. If you do not 
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agree to the licensing information, please remove WinBench from 
your PC, delete all copies of it and return the WinBench 
diskette to

Ziff-Davis Benchmark Operation
One Copley Parkway, Suite 510
Morrisville, North Carolina 27560

 For more information on licensing WinBench, see Chapter 2.

2. The test results from WinBench 4.0 are not compatible with the 
test results of previous versions of WinBench. You can 
meaningfully compare WinBench 4.0 test results only with 
other WinBench 4.0 test results. 

Who should read this manual

This manual is for people interested in using WinBench and 
understanding what its different scores mean. Anyone using 
WinBench should already be familiar with PCs in general and with 
using Windows on them. (If you have any questions about your PC 
or the applications you use on it, consult the documentation that 
came with it and the applications.)

This manual's organization makes it easy for you to find the 
information you need. The information in the manual gets more 
technical as the manual progresses. The early chapters explain 
WinBench without going into a great deal of technical detail. The 

Licensed Material¾Property of Ziff-Davis Publishing Company, L.P.



Table of Contents · xiii

µ §

later chapters provide a more technical look at WinBench. This 
organization lets you choose the degree of technical information 
you need without having to read everything.
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If you need to: Read these chapters: 
µ §(Concepts)

Understand generally what WinBench is Chapter 1
Understand the Graphics WinMark Chapter 5
Understand the Disk WinMark Chapter 5
Determine what affects the WinMarks Chapter 6
Understand generally the test results Chapter 5
Understand generally how the tests work Chapters 5, 7, 

Appendix A
See how your PC compares to others Chapter 8
Use other benchmarks with WinBench Chapter 1, 8
Determine the limitations of WinBench Chapter 1, 7

(Tasks)
Install, license, and register WinBench Chapter 2
Generate a Graphics or Disk WinMark Chapter 3
Determine the hardware/software requirements Chapter 2
License WinBench Chapter 2
Run WinBench interactively or from a batch file Chapter 3
Run individual tests Chapter 3
Create a test suite Chapter 3
Print the test results Chapter 4
Save test results Chapter 4
Compare your test results Chapter 4
Select a baseline machine for comparing results Chapter 4
Add test results from other PCs Chapters 4, 8
Get tips for running WinBench Chapter 3
Note information about your PC Chapters 3, 6
Run WinBench, Winstone 94, and PC Bench Chapter 1
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Look at all the tests in WinBench Appendix A
Perform troubleshooting Appendix B
Get copies of Ziff-Davis benchmarks Appendix C,

Benchmark Request Form
Order printed copies of benchmark manuals Manual Order Form

µ §
To make information easy for you to find, each chapter in this 
manual contains numerous small sections. The section headings 
indicate what information is in each section. Because this manual 
goes to an audience with widely varying technical skills, some of 
the information in the manual may be more basic than you need. 
When you see a section heading that deals with material you 
already understand, just skip that section.

Outline of this manual

The following list contains a summary of the information in this 
manual.

Chapter 1 An Overview of WinBench 
Presents a brief description of WinBench and gives 
an overview of the scores WinBench produces, 
especially the Graphics and Disk WinMarks. Talks 
about using WinBench with Winstone 94 and PC 
Bench.

Chapter 2 Installing WinBench
Gives you the software and hardware requirements 
for WinBench. Tells you how to install WinBench 
and how to license and register your copy of 
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WinBench. 

NOTE:In most cases, you must install WinBench before 
you receive this manual. If, however, you received 
a copy of the manual without first loading 

WinBench on your PC, you can use the 
instructions here to install it.

Chapter 3 Running WinBench
Explains the different options you have for running 
WinBench. Tells how to create custom test suites. 
Contains tips for running WinBench to get optimum 
results.

Chapter 4 Working with WinBench's Results
Tells the different ways you can display 
WinBench's results. Explains how to save and print 
test results. Also tells how to compare your current 
results to results from other tests you ran previously 
or from tests you ran on other PCs. Explains how 
WinBench normalizes scores relative to the set of 
results you specify as the baseline machine.

Chapter 5 Understanding WinBench's Results
Gives details on what the Graphics and Disk 
WinMarks are and how WinBench computes them. 
Also gives information on the other test suites and 
tests that come with WinBench.

Chapter 6 What Affects WinBench's Results
Talks about the different factors that can affect your 
PC's WinBench scores. Explains how to use the 
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Disclosure Questionnaire to record and track your 
system information.

Chapter 7 Concepts Behind the WinBench Tests
Describes the concepts that went into creating 
WinBench's tests. These concepts include profiling 
market-centered applications, using test parameters 
based on the distribution, using a weighted 
harmonic mean, and duplicating GDI and disk 
operations that applications perform.

Chapter 8 How Does Your PC Compare
Directs you to published sources where you can find 
information on how other PCs performed on 
WinBench's tests. 

Appendix A A Closer Look at the Tests
Presents information about the different tests 
WinBench uses. Contains a list of all the tests 
WinBench includes. Also explains the built-in test 
suites and lists the tests they contain.

Appendix B Troubleshooting
Explains what to do if a problem occurs while you 
are running WinBench. Lists all of the possible 
error messages.
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Appendix C Technical Support
Tells how to contact the Ziff-Davis Benchmark 
Operation.

Benchmark Request Form

Manual Order Form

On-line documentation

WinBench comes with the following on-line documentation:
README.WRI This file contains the WinBench license 

agreement and tells you how to install 
WinBench on your system. It also contains last-
minute information about WinBench that did 
not get into the manual. 

WINBENCH.HLP This is the on-line help file for WinBench. 
You can access this file while you run 
WinBench. 

WINBENCH.DOC This is  an on-line version of this manual in 
Microsoftâ Word for Windowsä (version 2.0) 
format.  If you have Microsoft Word version 2.0 
(or an application that accepts this format), you 
can print a copy of this manual. ZDBOp used 
Microsoft Word to create the manual.
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Windows conventions WinBench uses

WinBench takes advantage of common Windows features. This 
approach benefits you because you do not have to learn new ways 
to do things and select items. 

The Windows features that WinBench uses include:

· Clicking and double-clicking with your mouse's left button to 
select and activate items. In most cases, if you click on an item, 
such as an icon or a test name, WinBench selects that item and 
highlights it. If you click on a button, WinBench performs an 
action. For example, if you click on the Display Results button, 
WinBench opens the Chart of Results and the Table of Results. 
If you double-click on an item, WinBench performs an action 
associated with that item. For example, if you double-click on 
an icon, WinBench opens that icon window. If you double-
click on a test name in the Select Tests window, WinBench 
moves that test to the list of tests you have selected. If you 
click on a test name, WinBench highlights it. 

· Combining clicking your mouse's left button and pressing 
either the Shift key or the Control key to select multiple items. 
If you are selecting a range of tests from WinBench's Select 
Tests window, you can click on the first test and then press the 
Shift key and click on the last test. If you are selecting multiple 
tests in a random order, you can click on the first test and then 
press the Control key and click on any other tests you want to 
select. 
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· Using drop-down menus from the Windows main menu bar. 
WinBench presents its options as menu titles in the Windows 
menu bar. When you select one of these menu titles, such as 
Run, a drop-down menu appears displaying the menu items 
available. In most cases, the drop-down menus duplicate 
actions that are available through WinBench's Functions 
buttons. In many cases, the drop-down menus also give you 
additional options, such as the ability to copy or print results. 
The Windows menu bar changes depending on which window 
is active in WinBench. For example, if the Table of Results 
window is active, the Windows menu bar displays the menu 
titles File, Edit, Run, Suite, Table, Window, and Help. If the 
Chart of Results window is active, the Windows menu bar 
displays the options File, Edit, Run, Suite, Chart, Window, and 
Help. 

· Resizing and moving windows. You can minimize, maximize, 
and resize most of WinBench's windows, such as the Table of 
Results window, the same way you work with other windows 
in the Windows environment. You can also close the window 
using the drop-down control menu that appears when you click 
on the box in the upper left corner of the window. The 
exception is the Test Screen window, in which WinBench runs 
its tests. This window is always either maximized or an icon.

· Minimizing windows and using icons. WinBench lets you 
minimize its windows as icons. You do this by clicking on the 
minimize button (the down caret) in the upper right corner of 
the window. The easiest way to restore the window is to 
double-click on the icon. You can also restore the window by 
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clicking once on the icon and then, when the pop-up menu 
appears, clicking on Restore. 

· Using keyboard commands to select items instead of using the 
mouse. To do so, press the Alt key and the underlined access 
(or shortcut) character of the item you want to select. This item 
can be one of the controls in an active window, a menu title, or 
a menu item within a drop-down menu. 

General manual conventions

This manual uses a few general conventions. These are:

· Using the terms "click" and "double-click" to tell you when to 
select or activate an item with your mouse. (If you are using 
keyboard commands instead of an mouse, you will need to 
enter the corresponding keyboard command when you see the 
instruction to click or double-click on an item.)

· Displaying directory names and file names in capital letters, 
such as saying \WINBENCH\RESULTS to refer to the 
subdirectory that contains the WinBench results files. 

· Displaying in monospace or typewriter font information that 
you enter, such as:

setup

which is the command you use to install WinBench on your 
PC.
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Contacting ZDBOp

Please contact the Ziff-Davis Benchmark Operation if you have 
any questions or comments about WinBench. In addition you can 
request free copies of WinBench and other Ziff-Davis benchmarks 
from ZDBOp.

ZDBOp is located at One Copley Parkway, Suite 510, Morrisville, 
NC 27560.

You can contact ZDBOp by mailing questions, faxing questions, or 
sending questions electronically via ZiffNet, the Ziff-Davis on-line 
service. Appendix C contains details on these ways to contact 
ZDBOp.

End of Preface
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Chapter 1
An Overview of WinBench

This chapter provides general information about WinBenchâ and 
the test results it produces. It gives a brief overview of the 
Graphics and Disk WinMark tests and explains the kind of 
information you can get from these tests. It also discusses how you 
can use WinBench with other Ziff-Davis benchmarks to get a more 
complete measure of your PC's performance.

The WinBench basics

The WinBench benchmark is one of several Ziff-Davis 
benchmarks that can help you evaluate your PC's performance. 
Each Ziff-Davis benchmark lets you test different aspects of your 
PC's performance.

WinBench is a subsystem-level benchmark you can use to measure 
your PC's graphics and disk performance in a Microsoftâ 
Windowsä environment. WinBench contains tests that reflect 
how your PC's graphics and disk subsystems will perform when 
running Windows-based applications. 

The WinBench tests stress the graphics and disk subsystems in the 



same ways that applications use them. By profiling leading 
applications, the Ziff-Davis Benchmark Operation (ZDBOp) was 
able to make these tests perform many of the same operations that 
applications commonly execute. The profiled applications include 
those in Ziff-Davis' Winstoneä 94 benchmark and cover such 
product areas as graphics, word processing, desktop publishing, 
spreadsheet programs, database programs, and multifunction 
applications.

NOTE:WinBench does not run actual applications during its tests. 
The WinBench tests simply mimic the graphics and disk 
operations that leading Windows-based applications 
perform. 

WinBench returns two main scores that provide you with an 
overview of how well your PC's graphics and disk subsystems 
perform. The Graphics 
WinMarkä gives an overall measure of your graphics subsystem 
speed while the Disk WinMark evaluates your PC's disk 
subsystem. In addition, WinBench includes numerous other 
graphics and disk tests that let you more precisely evaluate 
different aspects of the performance of these two subsystems.

While WinBench lets you measure your PC's graphics and disk 
subsystems in a Windows environment, it does not provide a total 
picture of how well your PC performs. You can use WinBench 
with two other Ziff-Davis benchmarks, Winstone 94 and PC 
Benchä, to get a more complete evaluation of your PC's total 
performance. Winstone 94 measures your PC's overall 
performance as it runs actual, Windows-based applications, while 
PC Bench contains a test that measures the speed of your PC's 
processor subsystem. For information on using WinBench with 
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Winstone and PC Bench, see the section "Using WinBench with 
other benchmarks" later in this chapter.

NOTE:The two key points that distinguish WinBench from 
Winstone 94 and 
PC Bench are:

· Unlike Winstone 94, WinBench does not run actual 
applications.

· Unlike PC Bench, WinBench executes on top of 
Windows.

WinBench 4.0 is the most recent release of the 
WinBench benchmark. This release significantly differs 
from the previous releases. As a result, you can 
meaningfully compare WinBench 4.0 results only with 
other WinBench 4.0 results. You will not get a valid 
comparison if you attempt to compare WinBench 4.0 
test results with the test results from a previous version 
of WinBench.
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The subsystems WinBench measures

WinBench's tests target your PC's graphics and disk subsystems. 
Each of these subsystems consists of more than just hardware. In 
evaluating these subsystems, WinBench's tests can stress both the 
software and hardware that make up each subsystem.

The elements that compose the graphics subsystem include both 
the video adapter and its Windows device driver, as well as the 
monitor for your PC.

The disk subsystem includes the hard disk, the controller, any 
device driver software, and any hardware and software disk 
caches.

In addition, the PC's main processor, system RAM, and system bus 
inevitably play a role in the performance of these subsystems. Both 
the graphics and disk subsystems at least occasionally need help 
from the processor and both also move data to and from RAM.

The WinBench tests

WinBench contains more than 200 tests that you can use to 
measure your PC's graphics and video performance. 

The two main WinBench test suites¾the Graphics WinMark and 
the Disk WinMark¾provide overall measures of the speed of your 
PC's graphics and disk subsystems. Both WinMark test suites use 
synthetic workloads to measure the performance of these 
subsystems. The workloads are based on profiling the graphics 
and disk operations of leading applications.
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The individual tests exercise a variety of graphics and disk 
operations. Some of these tests focus entirely on one operation, 
while other tests include a mix of operations. 
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The Graphics WinMark tests

The Graphics WinMark is the overall performance score of your 
graphics subsystem. The Graphics WinMark test suite consists of 
seven tests that each perform a mix of GDI painting operations. 
These are the operations that leading Windows-based applications 
use. The tests perform such operations as memory to screen BitBlts 
and screen to screen BitBlts, as well as operations that draw 
geometric objects, such as lines, circles, and rectangles. The tests 
also mix the operations to reflect more closely the actions of actual 
applications. The application profiles determine the distribution, 
frequency, and typical parameters of these calls. WinBench 
weights the results of these tests and then calculates a harmonic 
mean of these weighted results to produce the Graphics WinMark 
score. 

You can use your PC's Graphics WinMark score to determine how 
effectively graphics accelerator cards operate in a Windows 
environment and process Windows Graphics Device Interface 
(GDI) calls. The Graphics WinMark also lets you determine the 
relative speeds of different screen resolutions and color depths on a 
single video card. Knowing the information that the Graphics 
WinMark supplies can help you select the graphics subsystem that 
best suits your needs. Performance is, of course, only one factor in 
any purchase decision.

The Disk WinMark test

The Disk WinMark is an overall score representing the 
performance of your PC's disk subsystem. The Disk WinMark uses 
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a single test called the "Disk, Mix," which contains a mixture of 
disk operations that reflect the disk usage patterns of leading 
applications. The Disk Mix is essentially a synthetic application 
that focuses on disk operations. It performs a variety of disk 
operation across a large set of files in six directories. Its tests files 
include data from source code, text, database, binary, executable, 
and bitmap files. It creates and deletes files, moves data in chunks 
of different sizes, intersperses write and read operations, and works 
with multiple files at the same time. 
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The resulting score, the Disk WinMark, shows how well your PC's 
hard disk subsystem performs. Because the Disk Mix test reflects 
the kind of work typical applications do, you can use it to show the 
kind of throughput you'll see when using disk caching software 
and/or hardware. The Disk WinMark can help you select the disk 
subsystem that best suits your needs.

The individual tests

You can also use WinBench to produce scores for the individual 
GDI operations that make up the Graphics WinMark as well as for 
the other individual graphics and disk tests it provides. The ability 
to exercise individual tests lets you check the performance of your 
PC on specific operations. 

The individual graphics tests let you measure the performance of 
almost any Windows GDI screen painting operation. You can also 
check your disk throughput using the individual disk tests that 
WinBench contains.

You can run the individual tests one at a time or as a group. You 
can also create a test suite you can save in a file and rerun later. A 
test suite is a group of tests that you execute with a single 
command. By combining WinBench tests to create a test suite, you 
can run tests that more closely mimic the operations of the 
applications you use most. For example, if you use an application 
that spends a lot of time drawing polygons, then you might want to 
run the specific tests that draw polygons in addition to the 
WinMark tests. 

NOTE:Keep in mind that WinBench tests only your PC's graphics 
and disk subsystems. Thus, while you can use WinBench to 
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see which subsystem configurations are faster than others, 
changing subsystem configurations rarely increases the 
speed of applications by the same amount that the new 
subsystem is faster than the old one. For example, suppose 
that one video card is 10 percent faster than another one. If 
you switch to the faster video card, you probably will not 
get a 10 percent increase in the overall speed of your 
application. This is because applications do more than just 
display graphics and text. The 
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percentage of overall improvement you get will depend on the how 
much time your application spends displaying graphics and 
text relative to the amount of time it spends doing other 
things.

The philosophy behind the tests

The graphics tests that make up WinBench reflect extensive 
profiling of the leading Windows-based applications in the 
Winstone 94 benchmark. These applications include:

· CorelDRAW!â 4.0

· Microsoftâ PowerPointâ for Windowsä 3.0

· Paradoxâ for Windowsä 1.0

· Clarisâ FileMakerâ Pro for Windowsä 2.0v1

· Microsoftâ Accessä for Windowsä 1.10

· Aldus PageMakerâ for Windowsä 5.0

· Microsoftâ Worksä for Windowsä 2.0a

· Borlandâ Quattroâ Pro for Windowsä 1.0

· Lotusâ 1-2-3â Release 4 for Windowsä

· Microsoftâ Excel for Windowsä 4.0

· Microsoftâ Word for Windowsä 2.0c

· WordPerfectâ for Windowsä 5.2. 

WinBench's Disk Mix test is also based on profiling of popular 
applications.
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The Graphics WinMark score represents the harmonic mean of 
seven combined graphics test scores. WinBench weights these 
scores to account for the different levels of importance the 
operations within the test groups. WinBench then generates a 
weighted harmonic mean from these scores that is the Graphics 
WinMark score. A harmonic mean is a way of combining several 
test scores to create a single representative score for that test group. 
(See Appendix A for detailed information on how WinBench 
computes the Graphics WinMark score.)

The score for the Disk WinMark represents the performance of 
your disk subsystem as it runs a single test containing a mix of disk 
operations. Rather than performing these operations sequentially 
and then stopping, the Disk WinMark mixes the operations 
together and changes the frequency of the operations to reflect 
information gathered by profiling popular DOS applications. 

By using the Disk WinMark, you can determine, among other 
things, the effect caching has on your disk subsystem and the 
general efficiency of your disk subsystem. 

What you can do with the WinMark scores

You can use the Graphics and Disk WinMark scores in assessing 
the performance of your PC. WinBench provides a measure of 
both the graphics and disk performance of PCs running Microsoft 
Windows and Windows-based applications. This information can 
help you:

· Match your PC and its graphics and disk subsystems to the 
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applications you use.

· Determine the relative speeds of different screen resolutions 
and color depths on a single video card.

· Compare different disk caching programs.

· Compare SMARTDrive (or other cache software) sizes.

· Make purchase decisions involving your graphics and disk 
subsystems.
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Using WinBench with Winstone 94 and 
PC Bench 

While WinBench tests the speed of graphics and disk operations in 
a Windows environment, it does not provide you with a complete 
measure of your PC's performance. To get a complete view of your 
PC's performance, use WinBench in combination with two other 
Ziff-Davis benchmarks, Winstone 94 and 
PC Bench:

· Winstone 94. Use this benchmark to measure the overall 
performance of your PC as it actually runs Windows-based 
applications. With Winstone 94 you can also measure the effect 
that changing individual system components has on your PC's 
overall Windows performance. 

Winstone 94 provides a single score that measures how well 
your PC performed as it ran twelve leading Windows 
applications. Winstone 94 uses scripts to perform typical tasks 
with these applications. 

NOTE:WinBench works well as a partner to Winstone 94, but 
it does not yield exactly the same results as Winstone 
94. Even if you hold every part of a system constant 
except the graphics subsystem, WinBench and 
Winstone 94 will not always rank system or video cards 
in exactly the same order. One reason is that WinBench 
is by design a graphics stress test that constantly 
exercises a PC's graphics subsystem. Winstone 94 is an 



Licensed Material¾Property of Ziff-Davis Publishing Company, L.P.

overall system benchmark that performs a great deal of 
disk and CPU activity and is less stressful on the 
graphics subsystem. WinBench goes a step beyond 
Winstone 94 and puts additional stress on graphics 
subsystems by using dithered colors. This is an activity 
that many Windows graphics adapters don't handle well 
and that applications in Winstone 94 don't, at least right 
now, use heavily. 

· PC Bench. Use this benchmark to measure the 
performance of your PC's processor subsystem. 
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In addition to providing a test that measures the speed of your PC's 
processor subsystem, PC Bench also lets you measure how 
your PC's disk and video subsystems perform in a DOS 
environment. WinBench's disk tests are similar to the PC 
Bench disk tests; but the scores for the WinBench tests will 
often differ from the scores for the PC Bench tests. This is 
because WinBench performs its tests on top of Windows, while 
PC Bench performs its tests using DOS.

What's next

This chapter provided you with an overview of WinBench. It told 
you:

· The basics of what WinBench is.

· The elements that comprise the subsystems WinBench tests.

· The types of tests WinBench provides, including its key tests, 
the Graphics WinMark and the Disk WinMark.

· Some ways you can use your scores.

· How you can use WinBench with two other Ziff-Davis 
benchmarks, Winstone 94 and PC Bench.

The rest of this manual contains information on how you can 
install, run, and use your WinBench results. It also provides you 
with information about what affects your WinBench results and 
where you can find information to compare your PC to other PCs. 
For more information about:
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· Installing WinBench as well as how to license and register your 
copy of the benchmark, see Chapter 2.

· Running WinBench interactively and in batch mode as well as 
the different combinations of tests you can run, see Chapter 3. 
This chapter also contains tips to help you get the most 
accurate results possible for your PC.

· Creating and modifying test suites, see Chapter 3.

· Saving, printing, and comparing your test results, see Chapter 
4.

· Understanding the results you get when you run the WinBench 
tests, see Chapter 5 and Appendix A.

· Determining what affects your WinBench results as well as 
how you can track your system information, see Chapter 6.

· Understanding the concepts used to develop WinBench, such 
as profiling, see Chapter 7. This chapter also notes some things 
the tests do not do.

· Comparing your PC's test results to test results from other PCs, 
see 
Chapter 8.

In addition, Appendix A lists all the tests in WinBench, Appendix 
B provides troubleshooting tips if you encounter a problem, and 
Appendix C tells you how you can contact ZDBOp.

End of Chapter
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Chapter 2
Installing WinBench

This chapter explains what you need to do to install WinBench on 
your PC and get it ready to run. This chapter contains:

· A list of the minimum hardware and software requirements 
your PC must meet to be able to run WinBench.

· Information on how to install WinBench.

NOTE:The README.WRI file that comes with WinBench 
also contains information on how to install WinBench.

· Instructions on how to license and register WinBench.

· Information on how to remove WinBench from your PC.

In most cases, you will have installed WinBench before getting a 
copy of this manual. If, however, you are installing WinBench on 
another PC or if you received a copy of this manual before you 
installed WinBench, you can follow the installation instructions in 
this chapter.

Chapter 6 What Affects WinBench's Results · 19
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Getting a copy of WinBench

You can get a free copy of WinBench by downloading WinBench 
from ZiffNet or by requesting a diskette from ZDBOp. For details 
on how to get a copy of WinBench, see Appendix C.

NOTE:If you get a copy of Winstone 94, you will also have a copy 
of WinBench and PC Bench. All three benchmarks are on 
the 
Winstone 94 CD-ROM.

ZiffNet contains copies of WinBench in compressed form.

Hardware and software requirements

To run WinBench on your PC, the PC must have a minimum of:

· Windows 3.1, Windows for Workgroups 3.1, or Windows 
NTä 3.1.

· MS-DOSâ 5.0 (or later), Novellâ DOS 7, or OS/2â 2.1. 

NOTE:ZDBOp did not test WinBench on earlier versions of 
these operating systems. Hence, ZDBOp does not 
guarantee that WinBench will run on them or, if it does, 
that its test results will be valid.

· An 80386 (or compatible) or higher processor. 

NOTE:ZDBOp did not test WinBench on PC's containing 
80286 processors. Hence, ZDBOp does not guarantee 
that WinBench will run on an 80286 processor or, if it 
does, that its test results will be valid.

Chapter 8 How Does Your PC Compare · 20
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· A VGA resolution or higher resolution video adapter. 
WinBench will work on any video adapter with a horizontal 
resolution of at least 640 pixels and a vertical resolution of at 
least 480 pixels.
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· 4 MB of RAM.

NOTE:While you can run WinBench on PCs with less RAM, 
its test results will not be valid because of the paging 
activity that will occur due to the limited memory.

· Approximately 3 MB of free space on your hard disk for the 
WinBench software.

· Approximately 32 MB of additional free space on your hard 
disk for temporary files the Disk WinMark test uses.

Using a downloaded copy of WinBench

WinBench is available on ZiffNet as a self-extracting file called 
WB40.EXE. You can download this file to your PC. (See 
Appendix C for information on ZiffNet forums that contain 
WinBench.)

Once you have a copy of WB40.EXE, you will need to decompress 
it before you can install WinBench. To do this:

1. Move WB40.EXE to a temporary directory (for example, 
\TMP).

2. Run WB4.0.EXE from the Windows File Manager or Program 
Manager.

NOTE: You can place WB40.EXE in any directory you like. 
Just use the correct directory name in the command line 
when you execute the file.

You now have the same WinBench files, including the 
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SETUP.EXE and README.WRI files, that come on the 
WinBench diskette. To install WinBench, see the next two 
sections.
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Quick installation for experienced users

If you are an experienced PC user, you can install WinBench 
quickly without going through the step-by-step installation 
procedure explained in the next section.

The basic WinBench installation procedure involves executing 
SETUP.EXE from the distribution diskette, CD-ROM, or directory 
where you decompressed the downloaded ZiffNet file. WinBench 
will ask you for the installation directory. It will then display a 
series of screens and ask whether you want to continue. The 
screens are self-explanatory.

If you are a less experienced PC user, read the next section, which 
takes you through each step of the installation process.

Installing WinBench

To install WinBench, begin in the Windows File Manager. 

NOTE: If you already have a version of WinBench on your 
PC, you should delete that version before staring the Setup 
program (see the section "Removing WinBench from your 
PC" later in this chapter). The Setup program will delete 
the current WinBench files and replace them with the new 
WinBench files. If you have version 3.11 of WinBench or 
an earlier version, just delete the directory containing 
WinBench.
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Follow these steps to install WinBench. (If you have questions 
during the procedure, select the Help button.)

1. Open the Windows File Manager.
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2. Go to the directory containing the WinBench files:

· If you have WinBench on a diskette, insert the diskette into 
the correct drive and change to that drive. (If you are 
installing WinBench from the Winstone 94 CD-ROM, 
insert the CD-ROM into the correct drive, change to that 
drive, and go to the \WINBENCH directory.)

· If you downloaded WinBench from ZiffNet, change to the 
directory that contains the decompressed WinBench files.

3. Select SETUP.EXE and execute it. (Windows 
automatically executes this file when you double-click on 
the file name SETUP.EXE.)

4. Click on Continue in the WinBench 4.0 Setup screen. 

Figure 2-1: The WinBench Setup window
 

You can also halt the installation procedure at this point by 
selecting Exit. If you do this, WinBench displays a Quit screen 
that says the installation is incomplete and gives you the 
opportunity to resume the installation by selecting Continue. 
To halt the installation, select Exit again. WinBench then 
displays a screen telling you that the benchmark has not been 
properly installed. Select OK. WinBench terminates its 
installation procedure. Ignore the rest of these steps. 
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5. Enter the name of the directory in which you want to install 
WinBench. The default directory is C:\WINBENCH. You can 
enter another directory name if you choose or accept the 
default directory. Now select Continue to go to the next 
screen.

Figure 2-2: The WinBench directory window
 

The WinBench Setup Disk screen appears. In this screen, 
WinBench displays information about the progress of the 
installation. When the installation finishes, WinBench displays 
a screen indicating that the installation was successful. 
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6. Click on OK to end the installation process.

Figure 2-3: WinBench installation window
 

During the installation, WinBench creates a Windows Program 
Manager group called Ziff-Davis Benchmarks. If this group 
already exists, WinBench just adds the WinBench application icon 
to it. WinBench also installs two Dynamic Link Libraries, 
CTL3D.DLL and BWCC.DLL, in the Windows system directory. 
WinBench uses these libraries with its user interface; they have no 
effect on the WinBench test results. If you have a newer version of 
either these system files on your PC than WinBench has, 
WinBench uses the version on your PC. WinBench does not 
overwrite newer versions of the files.

Figure 2-4: The WinBench application icon
 

When the installation finishes, the Ziff-Davis Benchmarks group 
appears in the Program Manager. If you want to start WinBench, 
double-click on the icon labeled WinBench 4.0.
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Licensing and registering WinBench

Before you can run any of WinBench's tests, you must license 
WinBench. The license agreement for WinBench appears just after 
the title page in this manual, in the README.WRI file that comes 
with WinBench, and as a topic in the Help file. In addition, 
WinBench displays this agreement the first time you execute this 
benchmark. 

If you agree to the WinBench 4.0 license agreement, register your 
copy of WinBench. You do this the first time you start WinBench 
after installing it. The following steps explain how to license and 
register your copy of WinBench:

1. Start WinBench by double-clicking on the application icon 
labeled WinBench 4.0. WinBench displays the licensing 
information. 

NOTE: If you don't see the WinBench 4.0 icon, double-click 
on the Program Manager group icon labeled Ziff-Davis 
Benchmarks. Double-clicking on this icon opens the 
Ziff-Davis Benchmarks program group window. This 
window contains all the Ziff-Davis benchmarks you 
have installed on your PC that work with Windows. If 
you have installed WinBench, then the WinBench icon 
will be in that window.
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2. Read the licensing information. You will need to use the scroll 
bar to view all the licensing information. 

Figure 2-5: The WinBench License window
 
Once you reach the end of the license agreement, you have two 
choices:

a. To continue, select the Proceed button. WinBench displays 
the registration form. 

b. To halt, select the Exit button. This stops WinBench.
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3. At the WinBench Registration form, enter your name in the 
box next to Name. If you want to register WinBench, you must 
enter a name here. If you do not, WinBench will not continue.

Figure 2-6: The WinBench Registration window
 

NOTE:By default, when you run WinBench, it will display the same 
registration information in this window that you used when you 
registered Windows on your PC.

4. If you belong to a company or organization, enter that name in 
the box next to Organization.

NOTE: This step is optional. If you do not belong to a 
company or organization, you can skip this step.

5. At the bottom of the Registration window, WinBench asks 
whether you agree to abide by the terms of the license 
agreement. You have three options:

a. Click on Yes if you agree to the terms of the license 
agreement. You can now execute the WinBench tests.

b. Click on No if you don't agree to the license agreement. 
Please delete all copies of WinBench. Return the 
WinBench product (the diskette if you installed WinBench 
from a diskette rather than downloading it from ZiffNet and 
any documentation you have) to ZDBOp.

c. Click on Reread if you did not read or fully understand the 
license agreement. Once you have read this information, 
you can select either Proceed or Exit. If you select Proceed, 
WinBench takes you back to the Registration window. If 
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you select Exit, WinBench halts.
Once you have entered the registration information, WinBench 
will not display this form again. The next time you execute 
WinBench, it will display the registration information you entered.

Removing WinBench from your PC

WinBench comes with a program called UNINSTAL.BAT that 
you can use to remove the benchmark from your PC. You can run 
the UNINSTAL program from the Windows File Manager or from 
a DOS command line.

When you run UNINSTAL, the program warns that it will remove 
the WinBench directory and all its files except the BWCC.DLL 
and CTL3D.DLL files it installed in the system directory. 
WinBench then asks if you want to continue.

NOTE: WinBench does not remove CTL3D.DLL and 
BWCC.DLL from the system directory because other 
applications may use them.

If you run UNINSTAL from Windows, WinBench leaves an 
inactive uninstall window on your window that tells you the 
directory was successfully removed. This window will stay there 
until you close it. Since UNINSTAL runs under Windows in a 
DOS virtual machine, you may need to update the File Manager 
display by pressing F5. This action redisplays the File Manager 
window so you can see that UNINSTAL removed the WinBench 
directory and its files.
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The UNINSTAL program fails if you have placed any non-
WinBench files in the WinBench directory.

NOTE:If you are executing the UNINSTAL.BAT file from the 
Windows File Manager program, it may not run. If a 
problem occurs while running UNINSTAL.BAT, 
WinBench displays a message saying you may not have 
enough Environment space and suggests you run the .PIF 
version of the file. In that case, just run UNINSTAL.PIF.

Removing the WinBench icon

The UNINSTAL program removes the WinBench files from your 
PC, but it does not remove the WinBench icon from the Ziff-Davis 
Benchmark's program group. To remove the WinBench icon, 
follow these steps:

1. Click the WinBench icon in the Ziff-Davis Benchmarks 
window.

2. Press the delete key.

3. Answer Yes to the prompt.

The icon disappears.

What's next

This chapter provided you with information on installing and 
setting up WinBench. It told you:
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· WinBench's hardware and software requirements.

· How you can install WinBench.

· How to license and register your copy of WinBench.

· How you can remove WinBench from your PC.
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The rest of this manual contains information on how you can run 
and use your WinBench results. It also provides you with 
information about what affects your WinBench results and where 
you can find information to compare your PC to other PCs. For 
more information about:

· Running WinBench interactively and in batch mode as well as 
the different combinations of tests you can run, see Chapter 3. 
This chapter also contains tips to help you get the most 
accurate results possible for your PC.

· Creating and modifying test suites, see Chapter 3.

· Saving, printing, and comparing your test results, see Chapter 
4.

· Understanding the results you get when you run the WinBench 
tests, see Chapter 5 and Appendix A.

· Determining what affects your WinBench results as well as 
how you can track your system information, see Chapter 6.

· Understanding the concepts used to develop WinBench, such 
as profiling, see Chapter 7. This chapter also notes some things 
the tests do not do.

· Comparing your PC's test results to test results from other PCs, 
see 
Chapter 8.

In addition, Appendix A lists all the tests in WinBench, Appendix 
B provides troubleshooting tips if you encounter a problem, and 
Appendix C tells you how you can contact ZDBOp.
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Chapter 3
Running WinBench

This chapter explains the different ways you can run WinBench 
and generate its test scores. This chapter explains how to:

· Start WinBench.

· Exit from WinBench.

· Halt a series of tests.

· Use the features in the WinBench application window.

· Run the WinMark tests, test suites, and individual tests.

· Run WinBench in batch mode.

· Run WinBench in demo mode.

· Create and modify test suites.

· Get the best test scores from your PC.

Starting WinBench

To start WinBench:

1. Make sure you have properly installed and licensed WinBench 
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(see Chapter 2 for instructions on installing and licensing 
WinBench).

2. Double-click on the Ziff-Davis Benchmarks program manager 
group icon. The Ziff-Davis Benchmarks program window 
opens.

3. Double-click on the WinBench icon. 

WinBench briefly displays its About window, which contains the 
registration information you entered. Then the main WinBench 
window appears and displays the WinBench function buttons.

NOTE:The first time you start WinBench 4.0, the WinBench 
licensing and registration windows appear. You must agree 
to the WinBench license agreement and register WinBench 
before you can use WinBench. This window appears only 
the first time you start WinBench after you install it. Once 
you supply the registration information, WinBench does 
not display the licensing window again regardless of how 
many times you restart WinBench. If you want to read the 
license agreement, select the About Function button. When 
the About window appears, select the License button.

Exiting from WinBench 

When you have finished running WinBench, you can minimize 
WinBench so that it is an icon or you can exit from WinBench. 
There are five ways to exit from WinBench:

· Click on the Exit button.

Appendix B   Troubleshooting · 40
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· Select Exit from the File menu.

· Select Close from the system menu.

· Press the Alt-F X key combination.

· Press the Alt-space C key combination.

If you attempt to exit WinBench without saving your test results, 
WinBench displays a window and asks if you want to save your 
test results. You can select Yes (save), No (don't save), or Cancel 
(don't exit from WinBench). 

If you choose:

Yes Depending on whether you have entered a name in the 
Test Description field of the Disclosure 
Questionnaire, WinBench either returns you to the 
WinBench application window and continues to run 
or lets you supply a name for the results file and then 
halts.

If you have not entered the Test Description, 
WinBench tells you that you need to supply this name 
and returns you to the WinBench application window. 
WinBench continues to run. 

If you have already entered the Test Description 
information, WinBench places you at the Save As 
window. Once you enter the name of the results file 
and click on OK, WinBench saves the results to a file 
and halts.
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No WinBench halts without saving your current test 
results.

Cancel WinBench continues to run.

Interrupting a series of tests

You can interrupt a sequence of tests by pressing any key or 
clicking the mouse. When you do this, WinBench finishes the test 
it is performing and asks, 

Do you want to terminate the running tests?

Select Yes to terminate the tests and No to resume running the 
selected tests. 

WinBench finishes the test it is currently running before giving 
you the option of stopping the rest of the tests. Some WinBench 
tests take a long time to run. If you attempt to terminate the rest of 
the tests when a long test is running, you may have to wait quite a 
while time before WinBench finishes its current test and asks if 
you want to terminate the rest of the tests.

NOTE:If you use the mouse to halt a series of tests, you must click 
it. WinBench does not query you about stopping if you 
simply move the mouse around.

If you want to halt WinBench immediately even when a test is 
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executing, press the Ctrl-Alt-Del key sequence and then restart 
Windows.

Options on the basic WinBench window

When you start WinBench after you have registered your copy, it 
briefly displays the About window and then opens the WinBench 
application window. WinBench always maximizes this window. 
(You can iconize it if you want to do other things without halting 
WinBench.) On the left side of the application window is the 
Functions window, which contains the buttons you can use with 
WinBench. In the Windows menu bar at the top of the window are 
WinBench's drop-down menus. 

In some cases, you can perform the same tasks by using either the 
function buttons or the drop-down menus. For example, you can 
quit WinBench by clicking on the Exit button or by choosing Exit 
from the File menu. In some other cases, the buttons and the menus 
let you perform different tasks. The Settings button, for example, 
lets you specify settings for your disk tests, while the Suites menu 
lets you create custom test suites. 

Your menu options will change depending on which window 
within WinBench is currently active. For example, when the Table 
of Results window is active, the menu bar includes a menu called 
Table. When the Chart of Results window is active, the menu bar 
includes a menu called Chart. 

WinBench uses several different windows. You can minimize most 
of the windows WinBench uses so they appear as icons on your 
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screen. This approach makes it easy for you to reopen them. Also, 
once you run at least one WinBench test, WinBench displays an 
icon that contains the last screen image the test used.

Figure 3-1:  The WinBench application window
 

The next few sections explain the options you have in the 
WinBench application window.
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The Functions window

The Functions window contains six function buttons.

Figure 3-2: The Functions window
 

These buttons have the following functions:

· About WinBench. Clicking on this button displays copyright 
information for WinBench. It also gives you the option of re-
reading the license agreement or viewing the names of the 
primary WinBench development team.

· Run. Use this button to run a built-in test suites or a selected 
set of tests. To select the test suite or group of tests you want to 
run, use the drop-down list in the box next to the word Run. 
You can activate this list by clicking on the down arrow. This 
list contains the names of all the test suites you 
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can run, such as All Tests, All WinMarks, the Graphics 
WinMark, and the Disk WinMark. In addition, if you choose 
Selected... in the drop-down list, WinBench opens its Select 
Tests dialog box and lets you choose which tests you want to 
run.

Figure 3-3: The drop-down list for the Run button
 

· Settings. When you click on this button, WinBench opens the 
Test Settings dialog box. In that dialog box, you can specify 
options for the Disk WinMark test and for the individual disk 
tests. 

· Display Results. Clicking on this button opens the Chart of 
Results and the Table of Results windows. You can use these 
two windows to display the different combinations of test 
results. Once you open the Chart of Results and the Table of 
Results, you can either close them or minimize them.

· Help. Clicking on this button opens a window that contains the 
table of contents for the WinBench help file. You can then 
double-click on the topic you want, and WinBench displays the 
help text for that topic. Because WinBench incorporates this 
manual as its on-line help, the list of help topics corresponds to 
this manual's table of contents. You will need to use the 
vertical scroll bar to view all of the available help topics. 

NOTE:In addition to clicking on the Help button, WinBench 
provides you with two other ways to access its context-
sensitive help system. If you press the F1 function key, 
WinBench provides help information about the item 
that currently has the keyboard focus. If you press the 
Shift-F1 key sequence, your mouse cursor changes into 
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a question mark and WinBench displays help 
information about any control, icon, or menu that you 
then select with the mouse.

· Exit. Selecting this button ends the WinBench program.

The WinBench windows

Once you run WinBench, it opens several windows. You can close 
any of these windows, or you can minimize the windows. The 
windows that WinBench can display are:

· Test Screen. When you double-click on this icon, WinBench 
displays the last screen image that the most recently run 
WinBench test displayed. This screen can be useful in 
determining that the test finished correctly. When WinBench 
finishes a set of tests, it minimizes this window so that it 
appears as an icon on the application window. 

Figure 3-4: Test Screen for the Arc, Elliptical, Partial test
 

· Chart of Results. The Chart of Results window contains a 
chart showing the results for the set of the WinBench tests you 
specified. You can display the results of all the tests available 
in WinBench (even if you have not run them), all the WinMark 
scores, all the tests you have run, or the currently selected tests. 
If you want to save this chart, choose the option Save As from 
the File menu in the Windows menu bar. WinBench 
automatically displays the Chart of Results and the Table of 
Results when it finishes executing its current tests. You can 
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also open this window by clicking on the Display Results 
button. Clicking on this button brings up both the Chart of 
Results and the Table of Results.

· Table of Results. The Table of Results window contains a 
table showing the results for the set of the WinBench tests you 
specified. You can display all the results of all the tests 
available in WinBench (even if you have not run them), all the 
WinMark scores, all the tests you have run, or the currently 
selected tests. If you want to save the results, choose the option 
Save As from the File menu in the Windows menu bar. 
WinBench automatically displays both the Chart of Results and 
the Table of Results when it finishes executing its current tests. 
You can also open this window by clicking on the Display 
Results button. Clicking on this button brings up both the Table 
of Results and the Chart of Results.

· Disclosure. This window displays information about your PC's 
configuration and lets you edit this information. This includes 
information that the WinBench license agreement requires you 
to disclose if you publish any results from your WinBench 
tests. You can open the Disclosure window by clicking on the 
Disclosure button located in both the Chart of Results and the 
Table of Results or by selecting Disclosure from the File menu.

· Disclosure Questionnaire. This window lets you edit 
information about your PC's configuration. The Disclosure 
form uses the information you supply here. You can open the 
Disclosure Questionnaire window by selecting Questionnaire 
from the File menu or by clicking on the Edit button when you 
have the Disclosure window open. 
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The WinBench drop-down menus

WinBench also lets you use the drop-down menus from the 
Windows menu bar to perform different functions. The drop-down 
menus change based on which WinBench window is active. For 
example, when you start WinBench the initial Windows menu bar 
has the File, Edit, Run, Suite, Window, and Help menus. If the 
active window is the Chart of Results, WinBench inserts a Chart 
menu title between the Suite and Window menu titles. Similarly, if 
the active window is the Table of Results, WinBench inserts a 
Table menu title between the Suite and Window menu titles.

The next sections describe the tasks you can perform using 
WinBench's menus.

The File menu

Figure 3-5:  WinBench's File menu
  

Disclosure. View the information in the Disclosure 
questionnaire.
Questionnaire. Modify some of the information in the 
Disclosure questionnaire.
Save As. Save the current set of results in a text file or a 
chart file, depending on whether the Table of Results or 
the Chart of Results is the active results window.
Print. Print the information in the Chart of Results if 
that is the active window.
Print Setup. Set up your pages for the printer.
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Exit. Quit WinBench.

The Edit menu

Figure 3-6:  WinBench's Edit menu
 
This menu lets you copy information from the active 
window to the clipboard.

The Run menu

Figure 3-7:  WinBench's Run menu
 
WinMark Tests. Run the Graphics WinMark, the Disk 
WinMark or both the Graphics and the Disk WinMark 
suites (All).
Demo Mode. Run WinBench in demo mode using the 
currently selected tests in the drop-down list next to the 
Run button.
All Tests. Run all the WinBench tests.
Selected Tests. Run selected WinBench tests. When 
you select this option, WinBench opens the Select Tests 
window and lets you specify which tests you want to 
run. When you click on OK in the Select Tests dialog 
box, WinBench immediately starts running the tests.

The Suite menu

Figure 3-8:  WinBench's Suite menu
 
New. Create a test suite.
Open. Open an existing test suite and add its name to 
the 
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drop-down list next to the Run button.
Edit. Modify the test suite that is currently selected in 
the 
drop-down list next to the Run button.
Delete. Remove a test suite from the drop-down list 
next to the Run button.

The Table menu

This menu appears only when the Table of Results is 
active. When you take an action in this menu, it affects 
both the Table of Results and the Chart of Results. 
Figure 3-9:  WinBench's Table menu
 
Display. This menu option lets you specify different 
groupings of the WinBench tests even if you have not 
run the tests. You can display all of the WinBench tests 
(All Tests), both the Graphics and Disk WinMark tests 
(All Marks), all the tests you have run during this 
WinBench session (Tests Run), and the currently 
selected tests as indicated in the drop-down list next to 
the Run button (Selected Tests).
Compare. Open a results file and display those test 
results in the Table of Results and the Chart of Results. 
You can also use the Compare menu option to remove a 
results file from the Table of Results and the Chart of 
Results.
Clear. Remove all the test results for this WinBench 
session from the Table of Results and Chart of Results.
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The Chart menu

This menu only appears when the Chart of Results is 
active. When you take an action in this menu, it affects 
both the Chart of Results and the Table of Results.

Figure 3-10:  The Chart menu
 
Display. This menu option lets you specify different 
groupings of the WinBench tests even if you have not 
run the tests. You can display all of the WinBench tests 
(All Tests), both the Graphics and Disk WinMark tests 
(All Marks), all the tests you have run during this 
WinBench session (Tests Run), and the currently 
selected tests as indicated in the drop-down list next to 
the Run button (Selected Tests).
Normalize. Display all the test results as a percentage 
of the test results of the baseline machine.
Absolute. Display the test results as absolute values.
Include Current Results. Specify whether you want to 
include your current results in the Chart of Results. 
(You only have this option with the Chart of Results.)
Compare. Open a results file and display those test 
results in the Table of Results and the Chart of Results. 
You can also use the Compare menu option to remove a 
results file from the Table of Results and the Chart of 
Results.
Baseline. Specify a baseline machine from one of the 
currently open sets of results. When you specify a 
baseline machine, WinBench normalizes all the other 
test scores in the Chart of Results against the scores for 
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the baseline machine.
Clear. Remove all the test results for this WinBench 
session from the Table of Results and Chart of Results.

The Window menu

Figure 3-11:  WinBench's Window menu
 
Arrange Windows. Return all your open WinBench 
windows to their original position on the screen. This 
minimizes the Test Screen if it is open.
Arrange Icons. Line up your WinBench icons at the 
bottom of the screen.
1-6. Select the WinBench window you want to be 
active from a list of open windows.
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The Help menu

Figure 3-12:  The Help menu

 
Contents. Displays a list of all the information 
available in the 
on-line help. The on-line help consists of all the 
information in this manual.
Search for Help On. Displays a dialog box that lets 
you specify a topic on which you want help.
How to Use Help. Explains how to use the on-line 
help.
License. Displays the license agreement so you can 
read it again.
Contacting ZDBOp. Provides information on how to 
contact ZDBOp.
About WinBench. Displays the About screen for 
WinBench.

Running the WinBench tests

WinBench contains numerous tests that you can use to measure the 
performance of your PC's graphics and disk subsystems. 
WinBench provides three ways of executing tests:

· Suites. These are sets of two or more tests that you can execute 
with a single command. WinBench has two kinds of test suites: 
built-in test suites and custom test suites. A built-in test suite is 
one that comes with WinBench, such as the GDI Tests test 
suite. WinBench lists all its built-in test suites in the drop-down 
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list next to the Run button. A custom test suite is one that you 
created. When you create a custom test suite, WinBench lets 
you save the list of tests you specify as a file that you can later 
access or modify from within WinBench. 

NOTE:You do not have to create a test suite to run a group of 
tests. You can use the Select Tests window to specify a 
group of tests. However, WinBench does not remember 
this group of tests. When you change the selection in 
the drop-down list next to the Run button, the group of 
tests disappears. Thus, you cannot run this group of 
tests repeatedly the way you can a test suite. 

· WinMarks. A test suite that uses weights to determine a score. 
There are two WinMarks tests suites: the Graphics WinMark 
and the Disk WinMark. Whenever WinBench runs all the tests 
comprising a WinMark, it computes the WinMark score, even 
if you did not specifically run that WinMark suite.

· Tests. A single test that focuses either on one operation, such 
as the 
Lines, Horizontal test, or on several operations mixed together, 
such as the test
Combined GWM . 

As a result of these different ways to execute tests, you have a 
variety of options for running WinBench tests. You can:

· Run all the WinMark tests necessary to get the Graphics 
WinMark and Disk WinMark scores for your PC by issuing 
one command.
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· Run either the Graphics WinMark suite or the Disk WinMark 
suite.

· Run all the WinBench tests with a single command. Doing this 
produces the Graphics WinMark, the Disk WinMark, and 
results for all the individual tests in WinBench.

· Run one of the additional built-in suites (Disk Tests, GDI 
Tests, GWM Tests, or USER Tests). 

· Select the test or the group of tests you want to run using the 
Select Tests dialog box.

· Run a custom suite.

· Run WinBench in demo mode.

· Run WinBench in batch mode.

When you select tests using the drop-down list next to the Run 
button, you can specify settings for the disk tests by selecting 
the Settings button or by selecting the Settings button in the 
Select Tests dialog box. Once you have specified any Settings 
you want, click on the Run button. WinBench then executes the 
tests you specified.

During a single WinBench session, you can run or re-run as many 
WinBench tests as you like.

NOTE:The time WinBench needs to complete its tests varies 
depending on the speed of your PC and which tests you 
run. If you execute the option All Tests, WinBench can 
take as long as several hours to run.

As each test runs, WinBench displays the name of the test in the 
bottom left corner of the screen and a status message in the bottom 
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right corner of the screen. When the test or set of tests ends, 
WinBench displays the Chart of Results and the Table of Results 
with the scores for the tests you just ran.

NOTE:You can display different combinations of test results in the 
Chart of Results or the Table of Results. WinBench, by 
default, initially displays the tests you just ran; however, 
you can use the Chart menu or the Table menu to display 
different combinations of test results, such as all the 
WinMark tests or all the tests you have run during this 
WinBench session. You can also use the Compare option to 
display results from other test runs next to the results from 
your current test run. For more information on displaying 
and comparing test results, see Chapter 4.

The following sections explain your options for running WinBench 
tests. If you'd like to find out more about WinBench's built-in test 
suites and individual tests, see Appendix A.
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Specifying settings for the disk tests

WinBench lets you specify the drive on which you want individual 
disk tests to run regardless of whether you are executing the tests 
individually or as part of a test suite. You do not have to run all the 
disk tests in a test suite on the same drive. Any disk test for which 
you do not specify a setting will use the default drive. 

Figure 3-13:  The Settings dialog box
 

For example, suppose you are going to run the test suite Disk Tests 
and your default drive is C. You can specify that the Disk Mix run 
on drive D and that the Disk Read Random 200 bytes test run on 
drive E. Since those are the only two tests for which you specified 
drives settings, all the other disk tests in that suite will run on the 
default drive. Thus, when you execute the Disk Tests suite, 
WinBench will run one test on drive D, one test on drive E, and the 
rest of the tests on drive C. If you later execute the Disk WinMark 
test without changing the setting for the Disk Mix, WinBench will 
again run that test on drive D. Once you specify a drive for a disk 
test, WinBench uses that setting each time it runs that test unless 
you specify a different setting. 

The settings remain in place until you halt WinBench. Then, the 
next time you start WinBench, it will use the default drive for all 
the tests until you specify a different drive.

You specify settings for disk tests from the Test Settings dialog 
box. To open this dialog box:

· Select the Settings function button in the WinBench application 
window. 
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· Select the Settings button in the Select Tests dialog box. 

NOTE:WinBench will only open the Test Settings dialog box 
when you have a disk test selected. This means that you 
must have a test suite that includes at least one disk test 
selected in the box next to the Run button before you can 
open the Test Settings dialog box. If you are at the Select 
Tests dialog box, you must have selected at least one disk 
test and placed it in the Selected Tests window before you 
can open the Settings dialog box.

Once the Test Settings dialog box appears: 

1. Select the disk test for which you want to specify settings. The 
drop-down list next to Test contains the names of all the disk 
tests that are part of the test suite or group of tests currently 
selected.

2. Enter the Setting you want to change. Currently, your only 
option is Drive.

3. Enter the designation for that drive where you want to run the 
test in the box next to Value. For example, enter a "D" there to 
indicate drive D.

NOTE:You do not have to enter a colon after the drive letter.

4. Click on OK once you have specified settings for all the disk 
tests that you want to run on a drive other than the default 
drive.

NOTE:If you want to specify settings for other disk tests in the 
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drop-down list next to the Test box, repeat steps 1-4 
until you have entered the settings for each of those 
tests. If you do not specify a setting for a disk test, 
WinBench uses the default setting. Now select OK.

If you want to use the default WinBench settings for your PC, click 
on the Use Default button. WinBench then displays the default 
drive in the box next to Default.
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Running all the WinMark tests

If you just want to determine your PC's Graphics and Disk 
WinMark scores, you can choose the option to run all the 
WinMark tests. This option differs from the option to run All Tests 
because the WinMark tests are only a subset of the total set of tests 
you can execute from WinBench. Consequently, your PC takes 
less time to run all the WinMark tests than it does to run all the 
WinBench tests.

There are two ways to run all the WinMark tests:

· Select the option All WinMarks in the drop-down list next to 
the Run button. Once All WinMarks appears in the box, click 
on Run.

· Select the option WinMark Tests from the Run menu. When 
the cascading menu appears, select the option All.

The time it takes to run the All WinMarks suite varies based on 
your PC and how it is set up. As data points for comparison 
purposes, this test suite took 68 minutes to run on a 386/20 with a 
Video 7 VRAM adapter and 11 minutes to run on a COMPAQâ 
DESKPROâ 66M with a QVision video adapter.

Running either the Graphics or the Disk WinMark test

You can easily run either the Graphics WinMark suite or the Disk 
WinMark suite. There are two simple ways to run one of these 
WinMark tests:
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· Select either the option Graphics WinMark or Disk WinMark 
in the 
drop-down list next to the Run button. Once the name of the 
WinMark test you want to run appears in the window, click on 
Run.

· From the Run menu, select the option WinMark Tests. From 
the cascading menu that appears, select either Graphics for the 
Graphics WinMark or Disk for the Disk WinMark.

The time it takes to run the Graphics WinMark suite or Disk 
WinMark suite varies based on your PC and how it is set up. As 
data points for comparison purposes, the Graphics WinMark suite 
took 58 minutes to run and the Disk WinMark suite took 10 
minutes to run on a 386/20 with a Video 7 VRAM adapter. The 
Graphics WinMark took 7 minutes to run and the Disk WinMark 
suite took 4 minutes to run on a COMPAQ DESKPRO 66M with a 
QVision video adapter.

Running all the WinBench tests

WinBench gives you the option of running all of its tests with one 
command. When you choose this option, WinBench executes all of 
its tests and computes both WinMark.

There are two ways to run all the WinBench tests:

· Select the option All Tests in the drop-down list next to the 
Run button. Once All Tests appears in the box, click on Run.

· Select the option All Tests from the Run menu.

Because this action makes WinBench run every test it contains, 
executing this option can take up to several hours for WinBench to 
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complete. The time it takes to run the All Tests suite varies based 
on your PC and how it is set up. As data points for comparison 
purposes, this test suite took 345 minutes to run on a 386/20 with a 
Video 7 VRAM adapter and 140 minutes to run on a COMPAQ 
DESKPRO 66M with a QVision video adapter. 

Running the additional WinBench test suites 

WinBench comes with some special test suites you may want to 
use. These suites are:

· The Disk Tests. This suite includes the Disk Mix, which 
WinBench uses to calculate the Disk WinMark, and a group of 
sequential and random tests that read and write data to the disk 
using different size records. The complete set of disk tests read 
and write data in groups of 200 bytes, 512 bytes, 2048 bytes, 
and 4096 bytes.

As data points for comparison purposes, the Disk Tests suite 
took 105 minutes to run on a 386/20 with a Video 7 VRAM 
adapter and 42 minutes to run on a COMPAQ DESKPRO 66M 
with a QVision video adapter.

· The GDI Tests. This suite exercises additional GDI calls that 
do not appear in other tests. The GDI Tests exercise GDI calls 
that the profiled applications did not use. This suite includes 
most of the GDI painting calls supplied by Windows. 

As data points for comparison purposes, the GDI suite took 
110 minutes to run on a 386/20 with a Video 7 VRAM adapter 
and 55 minutes to run on a COMPAQ DESKPRO 66M with a 
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QVision video adapter.

· The GWM Tests. This suite includes the individual tests that 
exercise all the GDI calls the Graphics WinMark uses. Unlike 
the Graphics WinMark suite, this suite executes these 
operations as individual tests. 

As data points for comparison purposes, the GWM Tests suite 
took 52 minutes to run on a 386/20 with a Video 7 VRAM 
adapter and 27 minutes to run on a COMPAQ DESKPRO 66M 
with a QVision video adapter.

· The USER Tests. This suite exercises calls made through the 
USER component of windows. USER is a module that 
manages windows. These tests make USER calls that draw 
things, not GDI calls. 

As data points for comparison purposes, the USER Tests suite 
took 20 minutes to run on a 386/20 with a Video 7 VRAM 
adapter and 9 minutes to run on a COMPAQ DESKPRO 66M 
with a QVision video adapter. 

The easiest way to run one of these suites is to select the test in the 
drop-down list next to the Run button. The options are Disk Tests, 
GDI Tests, GWM Tests, or USER Tests. Once the suite you want 
appears in the window, click on the Run button.

NOTE:One way you can see which tests WinBench includes in 
each of these suites is to open the Select Tests dialog box 
and double-click on the name of the suite. WinBench then 
displays the names of all the tests that make up that suite in 
the Selected Tests list. Appendix A also contains a list of 
the individual tests that make up these suites.
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Running a custom test suite

You can also run any custom test suites you created. You select 
and execute a custom test suite the same way you select a built-in 
test suite. 

If, however, the name of the test suite you want is not in the drop-
down list next to the Run button, you will need to open the suite:

1. Click on the option Open from the Suite menu. The Read Suite 
from File dialog box appears. 

Figure 3-14:  The Read Suite from File dialog box
 

2. Click on the name of the test suite you want to open. By 
default, WinBench keeps its test suites in the directory 
\WINBENCH\SUITES. If you saved your test suite file in 
another directory, then you will need to open the file from that 
directory.

3. Click on OK. WinBench adds the test suite to the drop-down 
list next to the Run button and makes that suite the selected 
test.

NOTE:Unless you remove it, this test suite will remain in the 
drop-down list next to the Run button for the rest of 
your current WinBench session. If you want to remove 
it, select the option Delete from the 
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Suite menu. This removes the currently selected test suite from 
the drop-down list, but it does not delete the test suite 
file from your PC.

4. Click on Run to execute the test suite.

Selecting individual tests and groups of tests 

WinBench offers you the option of selecting and running tests 
other than the WinMark tests, the built-in test suites, or a custom 
test suite. 

You can choose an individual test or a group of tests from the 
Select Tests dialog box. There are two ways to get to the Select 
Tests dialog box:

· Select the option Selected... from the drop-down list next to the 
Run button. If you open the Select Tests dialog box this way, 
when you click on OK in that window, WinBench returns you 
to the WinBench application window and waits for you to click 
on Run before it executes the test or tests.

· Select the option Selected Tests from the Run menu. If you 
open the Select Tests dialog box this way, when you click on 
OK in that window, WinBench automatically starts running the 
tests you specified.

Figure 3-15:  The Select Tests dialog box
 
Both of these options open the Select Tests dialog box. This dialog box contains 
three smaller windows. The Test Suites window is on the top left and contains the 
names of all the built-in test suites as well as the names of any custom test suites 
you have open. The Tests window is on the bottom left and contains a list of the 
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individual WinBench tests. The Selected Tests window is on the right and 
contains the names of all the currently selected tests. To choose a test or a set of 
tests:

1. Select the test or test suite you want. If you select a suite, 
WinBench displays all the individual tests that make up that 
suite in the Selected Tests window. To add tests to the Selected 
tests window either:

· Double-click on the name of the test or test suite you want. 
WinBench automatically adds that test or the individual 
tests in the test suite to the Selected Tests window.

· Click on the name of the test or test suite you want and then 
click on the Add button. WinBench adds that test or the 
individual tests in the test suite to the Selected Tests 
window.
If you want to select a group of tests, you can click on the 
first test and then use either the Control key or the Shift key 
when you click on another name. Once you have 
highlighted all the tests you want to add, click on the Add 
button to move these tests to the Selected Tests window.
NOTE: If you are using keyboard commands instead of a 

mouse, WinBench lets you use Shift-F8 and the 
Space bar to select a random group of tests. To do 
this:

a. Press Shift-F8 once. Use the arrow key to move 
through the list until the test you want is 
highlighted. 

b. Press the Space bar. That test is now one of your 
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selected tests and stays highlighted even when 
you move the cursor down. If you want to select 
a contiguous range of tests, press and hold the 
Shift key as you use the arrow key to move 
through the list of tests. 

c. Once you have selected all the tests you want, 
press the Tab key. This takes you to the Add 
button.

d. Now press the Space bar. WinBench moves all 
the highlighted tests to the Selected Tests 
window. 

To disable this keyboard feature, press Shift-F8 
again.

2. If you selected any disk tests, you can use the 
Settings button to specify the drive you want to 
run the tests on. 

3. Use the Remove and Remove All buttons to delete some or all 
of the tests from the Selected Tests list. The Remove button 
deletes only the tests in the list that are highlighted. The 
Remove All button deletes all the tests from the list.

4. Click on the OK button when you have the list of tests you 
want to run in the Selected Tests list. 

NOTE:Remember that if you entered the Select Tests dialog 
box from the drop-down Run menu in the Windows 
menu bar, WinBench automatically runs the tests you 
chose as soon as you click on OK. If you entered the 
Select Tests dialog box by choosing Selected... in the 
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box next to the Run button, then WinBench returns you 
to its main window and waits for you to click on Run 
before executing the tests.

For information on all the WinBench tests, see Appendix A.

Running WinBench in demo mode

WinBench contains an option that lets you execute it in demo 
mode. When you execute WinBench in demo mode, it runs a test, 
briefly displays the test results, and then runs another test and 
briefly displays its results. 

To run WinBench in demo mode, select the option Demo Mode 
from the Run menu. WinBench continues to run individual tests 
and display results until you stop demo mode by either pressing a 
key or clicking the mouse.

When you execute WinBench in demo mode, it runs whichever 
tests appear in the box next to the Run Function button. If you 
want WinBench to execute specific tests during demo mode, then 
select the option Selected... in the 
drop-down list next to the Run button. When the Select Tests 
dialog box appears, choose the tests you want to run and select 
OK. Now, instead of clicking on the Run button, select Demo 
Mode from the Run menu. WinBench will run only the tests you 
specified until you halt demo mode.
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Running WinBench in batch mode

You can also run WinBench in batch mode from the DOS 
command line. First you must edit the WinBench file RUNWB.INI 
so that it contains the information WinBench needs. Then, at a 
DOS prompt, enter the command:

win c:\winbench\winbench.exe auto c:\winbench\runwb.ini

This command starts windows and then executes WinBench in batch 
mode.

WinBench stores the file RUNWB.INI in the main WINBENCH 
directory. Before you make any changes to RUNWB.INI, make a 
backup copy of the file. Then use a text editor to edit the 
information in the file. You need to modify the following 
information in RUNWB.INI:

· Environment settings

· The path name of the test suites you want to run

· Names of the results files you want to save (you can have up to 
three)

The following is the RUNWB.INI file that comes with 
WinBench.

; This file is a prototype for the .ini file that you can
; use to run WinBench in batch mode; i.e. non-interactively.
;
; To run WinBench in batch mode, use the command line:
;
;    winbench auto runwb.ini
;
; This file supplies the environment settings,
; the tests WinBench will run, and the names of the results files. ;
; Copy and edit this file to include the environment settings
; for your computer.
; Create a suite file that describes the tests you want to run
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; and refer to it in the Suites section below.
; Change the settings in the Results section to specify
; the names of the result files.

[Environment]

; You must supply the following fields, which are part of the
; complete disclosure of the test environment.

; WinBench adds these environment settings to the results file. 
; These settings supply values that you would normally
; supply using the Disclosure Questionnaire when
; running WinBench in interactive mode.
; WinBench generally determines an appropriate value for
; the following fields.

; You can override WinBench's determination by replacing
; "To Be Supplied By Tester" with an appropriate string 
; and uncommenting the lines by removing the leading ";".

;Operating System=To Be Supplied By Tester
;Windows System=To Be Supplied By Tester 
;Processor=To Be Supplied By Tester 
;Processor Speed=To Be Supplied By Tester 
;Processor RAM=To Be Supplied By Tester 
;Video Driver=To Be Supplied By Tester 
;Video Adapter=To Be Supplied By Tester 
;Video Mode=To Be Supplied By Tester

; WinBench cannot determine an appropriate value for 
; the following fields.
; You must replace "To Be Supplied By Tester" with an 
; appropriate string.

Computer=To Be Supplied By Tester
Off-Chip Processor Cache=To Be Supplied By Tester 
Video DRAM=To Be Supplied By Tester
Video VRAM=To Be Supplied By Tester
Video Refresh Rate=To Be Supplied By Tester 
Hard Disk=To Be Supplied By Tester
Hard Disk Controller=To Be Supplied By Tester 
HD Controller RAM=To Be Supplied By Tester 
Software Disk Cache=To Be Supplied By Tester 
Software Cache Size=To Be Supplied By Tester

; The following fields are added to the results file. You would 
; normally change them by using the Disclosure Questionnaire 
; window. They are not required for a full disclosure.
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Description=To Be Supplied By Tester
Comments=To Be Supplied By Tester

; The following fields are for compatibility with existing 
; PC Labs automation systems.

; WinBench adds these fields to the results file.
; DOS environment variables of the same name in uppercase, 
; e.g. VARIANT1, can override these settings.

; Uncomment these settings by removing the leading ";"
; if you want to use them.
;PIN=To Be Supplied By Tester
;Variant1=To Be Supplied By Tester
;Variant2=To Be Supplied By Tester
;Variant3=To Be Supplied By Tester
;Variant4=To Be Supplied By Tester
;Variant5=To Be Supplied By Tester
;Type=To Be Supplied By Tester
;Project=To Be Supplied By Tester
;Tester Name=To Be Supplied By Tester
;Tester Organization=To Be Supplied By Tester

[Suites]

; The Suite1 setting specifies the path name of the suite 
; file that contains the list of tests to run.

; The custom.wbs suite contains all tests.  You can create 
; additional suite files by using the Suite/New menu item. 
; Only one suite is allowed here.

Suite1=suites\custom.wbs
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[Settings]

; WinBench looks for test settings here.  It first looks for 
; a setting in the form test-name:setting-name. If one is not 
; found, it looks for the more generic setting-name.  If one is 
; not found, WinBench uses the default setting.

; The Drive setting specifies which drive to test for the disk 
; tests.

Drive=C
;Disk, Mix:Drive=C

[Options]

; Setting ExitWindows to True causes WinBench to exit Windows 
; when WinBench terminates. 

ExitWindows=False
;ExitWindows=True

; Setting DemoMode to True causes WinBench to run the specified 
; test suit in demo mode.  WinBench will not save any results, 
; and it will ignore the ExitWindows setting.

DemoMode=FALSE
;DemoMode=TRUE

[Results]

; Edit the settings below, changing the name and directory
; to specify the results files you want to produce.

; Comment out any settings for result files you do not want. 
; You can produce all three types of result files or any
; subset, as you like.

TextFile=results\results.txt
XLSFile=results\results.xls
CSVFile=results\results.csv

Modifying the RUNWB.INI file

The RUNWB.INI file has several parts. This section of the manual 
steps you through the RUNWB.INI file and explains each part in 
the order that it appears in the file.
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The first part of the RUNWB.INI file contains environment 
information. You should modify the fields for the environment 
settings to reflect the way your PC is set up. You must make sure 
these fields are accurate since this is information you need if you 
want to publish any of your WinBench test results. 

NOTE: When you run WinBench interactively, you supply 
this information by editing the Disclosure Questionnaire. 

With some of these fields, WinBench can determine the 
appropriate value. You can override the value WinBench would 
supply by replacing the string: 

To Be Supplied By Tester

with the value you want that field to have and by uncommenting 
the lines. To uncomment the lines, remove the semicolon (;) that is 
in the first position of the line. The following are the fields for 
which WinBench normally supplies values:

;Operating System=To Be Supplied By Tester
;Windows System=To Be Supplied By Tester
;Processor=To Be Supplied By Tester
;Processor Speed=To Be Supplied By Tester
;Processor RAM=To Be Supplied By Tester
;Video Driver=To Be Supplied By Tester
;Video Adapter=To Be Supplied By Tester
;Video Mode=To Be Supplied By Tester

The next set of fields are ones for which you must supply a value 
because WinBench cannot determine the appropriate value. Enter 
the appropriate value in place of the string, To Be Supplied By 
Tester:

Computer=To Be Supplied By Tester
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Off-Chip Processor Cache=To Be Supplied By Tester
Video DRAM=To Be Supplied By Tester
Video VRAM=To Be Supplied By Tester
Video Refresh Rate=To Be Supplied By Tester
Hard Disk=To Be Supplied By Tester
Hard Disk Controller=To Be Supplied By Tester
HD Controller RAM=To Be Supplied By Tester
Software Disk Cache=To Be Supplied By Tester
Software Cache Size=To Be Supplied By Tester

The next set of fields are for information only. WinBench includes 
these fields in the results file. Each time you want to add or remove 
a comparison machine 
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from the Chart of Results or Table of Results, WinBench displays 
the information you supply for the Description field below. Change 
the following fields if you want something different to appear in 
the results file:

Description=To Be Supplied By Tester
Comments=To Be Supplied By Tester

The following fields exist to provide compatibility with the 
existing 
PC Magazine Labs testing automation systems. Other WinBench 
users will not need these fields. WinBench does, however, include 
these fields in results files. If you have any DOS variables with an 
uppercase version of any of these names, the values for those 
variables will override the values you supply here. If you want to 
use these fields, you must uncomment them.

;PIN=To Be Supplied By Tester
;Variant1=To Be Supplied By Tester
;Variant2=To Be Supplied By Tester
;Variant3=To Be Supplied By Tester
;Variant4=To Be Supplied By Tester
;Variant5=To Be Supplied By Tester
;Type=To Be Supplied By Tester
;Project=To Be Supplied By Tester
;Tester Name=To Be Supplied By Tester
;Tester Organization=To Be Supplied By Tester

You place entries in the five Variant boxes to make different test 
runs on the same PC easily identifiable. The project field lets you 
enter a name for this project. You can also enter the name of the 
WinBench tester and the organization the tester is with.
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The next part of the RUNWB.INI file contains information on the 
test suites you want to execute. For the SUITE1 value, specify the 
path name of the file that contains the suite of tests you want to 
run. For example, you might enter:

Suite1=suites\custom.wbs

The file CUSTOM.WBS, located in the \WINBENCH\SUITES 
directory, contains all the WinBench tests. You can use any custom 
test suite that you created and saved while running WinBench in 
interactive mode.

Now you must supply the setting for the tests, if any. The settings 
apply only to the disk tests. WinBench expects setting information 
to be in the form 
TEST-NAME:SETTING NAME. For example:

Disk, Mix:Drive=C

If WinBench does not find any information in this form, it looks 
for a more generic SETTING NAME:

Drive=C

If WinBench does not find any drive settings, it uses the default 
values 
(drive C). 

NOTE: This explanation of the file presents the 
RUNWB.INI file options in the order in which they appear. 
The information on setting up the results files is the last 
part of the RUNWB.INI file.

The next field lets you specify whether WinBench automatically 
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exits Windows when it finishes executing. If you select 
ExitWindows= False, WinBench does not halt Windows once it 
finishes its tests:

ExitWindows=False
;ExitWindows=True

If you select ExitWindows=True, WinBench halts Windows once 
it finishes its tests and returns you to the DOS prompt. 

You also have the option of executing WinBench in demo mode:

DemoMode=False
;DemoMode=True

If you select DemoMode=True, then WinBench runs the specified 
test suite in demo mode and does not save any of the test results. 
Also, if you specify this option, WinBench ignores whatever you 
specify in the ExitWindows option.

You also should specify where you want WinBench to store the 
results file and the format you want it to use when it stores the file. 
You can save the results files in the following three formats:

· A tab-delimited format suitable for use by Microsoft Excel 
(.XLS).

· A comma-delimited format suitable for use by Excel or Lotus 
1-2-3 (.CSV). 

· A plain text file (.TXT).

Edit the appropriate field to contain the correct path name for the 
file:

TextFile=results\results.txt
XLSFile=results\results.xls
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CSVFile=results\results.csv

You can save the results file in all three formats. If you don't want 
to save the file in all three formats, use semicolons to comment out 
the formats you do not want. For example, if you only wanted to 
save the results file as a text file, your RUNWB.INI file would 
include these lines:

TextFile=results\results.txt
;XLSFile=results\results.xls
;CSVFile=results\results.csv

Using custom test suites

A custom test suite is one you create. When you create a custom 
test suite, you can save it as a file that you can later access or 
modify from within WinBench. You can also move test suites you 
created on one PC to another PC.

You can use WinBench's test suite feature to create a set of tests 
tailored to the way you use your PC. For example, if you primarily 
use an application that spends a lot of time writing lines to the 
screen, then you might want to create a test suite that focuses on 
WinBench's line draw tests.

NOTE: While WinBench lets you create your own test 
suites, you cannot assign weights to the tests in such suites.

A custom test suite can include any combination of WinBench 
tests you choose. If you choose to save the test suite as a file, you 
can run that set of tests during other WinBench sessions or move 
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the test suite file to a different PC. In addition, you can move test 
suites from other PCs onto your PC. When you copy a test suite 
file to another PC, you should place it in the WinBench 
subdirectory SUITES. Then select the option OPEN from the Suite 
menu to add the new test suite to the list of available test suites. 
For details on how to do this, see the section "Adding a custom test 
suite to the list of available tests" later in this chapter.

The next sections explain how to create and modify test suites. For 
a list of all the tests available with WinBench, see Appendix A.

Creating custom test suites

You can include any WinBench tests in your test suite. To create a 
test suite:

1. Select the option New from the Suite menu. The Create Test 
Suite dialog box appears. 

NOTE:WinBench displays the names of all the currently 
selected tests in the Selected Tests list when it opens the 
Create Test Suite dialog box. These are the tests that 
make up the test suite selected in the box next to the 
Run button. For example, if you have the Graphics 
WinMark as the selected test suite next to the Run 
button, then WinBench lists the seven tests that make 
up the Graphics WinMark in the Selected Tests 
window. Thus, if you are creating a test suite that is 
similar to an existing test suite, make sure the existing 
test suite is the currently selected test suite. (If you don't 
want to use any of these tests, click on the Remove All 
button.)
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Figure 3-16:  The Create Test Suite dialog box
 

2. Enter the name you want to call the test suite. This is the name 
that will appear in the drop-down list next to the Run button and 
in the Test Suites list in the Select Tests dialog box. You can use 
any combination of characters and spaces for this name that you 
choose.

NOTE:If you save the test suite to a file, WinBench will 
associate a filename with the test suite you create. That 
filename must follow DOS filename conventions. Later, 
when you want to open the test suite, you will need to 
select the DOS filename, not the actual suite name. For 
example, suppose you create a suite named 
"All Text" and save it as a file named ALLTXT3.WBS. 
When you want to open that suite, WinBench displays a 
dialog box with the filename ALLTXT3.WBS in it, not 
the suite name All Text.

3. Select the tests you want in the test suite by double-clicking on 
the test names or clicking on a name and then clicking the Add 
button. You can select any of the existing test suites as well as 
any of the individual tests. If you select an existing test suite, 
WinBench displays in the Selected Tests list all the tests that 
make up that suite.

NOTE:WinBench does not save settings for disk tests with the 
test suite. To specify settings for any of the disk tests in 
your test suite, you must first select the test suite from 
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the drop-down list next to the Run button and then click 
on the Settings button.

To remove a test from the list of selected tests, highlight it and 
then select the Remove button. To remove all the tests, select 
the Remove All button.

4. Click on OK when you have all the tests you want listed in the 
Selected Test window. WinBench displays the Save Suite in 
File dialog box.

At this point, you have a WinBench test suite that you can run. 
You do not have to save the test suite to a file. If you want to 
save your test suite, go to step 5; otherwise, click on Cancel 
and stop now.

Figure 3-17:  The Save Suite in File dialog box
 

5. Enter the filename for the test suite with a .WBS extension. 
Choose the directory and drive where you want WinBench to 
save the file. By default, WinBench saves the file in the 
WinBench subdirectory SUITES. (You must follow DOS 
filename conventions when you enter the base name for this 
file.) 

Steps 5 and 6 are optional. You can run the test suite you just 
created without saving it to a file. However, once you end this 
WinBench session, your test suite will disappear.

6. Select OK. WinBench adds the test suite you just created to the 
list of available test suites in both the drop-down list next to the 
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Run function button and the Test Suites portion of the Selected 
Tests window.

Adding a custom test suite to the list of available suites

If you want to run a custom test suite that you created and saved 
during a previous WinBench session, you first must add it to the 
drop-down list of tests next to the Run button. To do this:

1. Select the option Open from the Suites menu. The Read Suite 
from the File dialog box appears. Go to the directory and drive 
where you saved the test suite. WinBench displays the names 
of all of the files in that directory with the extension .WBS.

NOTE:WinBench does not display the actual suite names in 
this window. Instead it displays only the DOS 
filenames associated with the suites.

2. Click on the filename for the test suite you want to add.

3. Click on OK.

WinBench adds the test suite you specify to the list of available 
test suites in both the drop-down list next to the Run button and the 
Test Suites list in the Selected Tests window.
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Modifying a custom test suite

You can also modify an existing test suite by adding or deleting 
tests. In addition, if you did not save the test suite to a file when 
you created it, you can do so now. To do this:

1. Select the test suite you want to modify from the drop-down 
list of test suites next to the Run button.

2. Select the menu option Edit from the Suites menu. WinBench 
displays the Edit Test Suite dialog box.

Figure 3-18:  The Edit Test Suite dialog box
µ §

3. Change the list of tests associated with this test suite by adding or 
deleting tests.

4. Click on OK. The Save Suite in File dialog box appears. You 
do not have to save your modified test suite to a file. You can 
run the test suite during this WinBench session even if you do 
not save it. If you want to save your changes to a file, go to 
step 5; otherwise, click on Cancel and stop now.

5. Specify the filename for this test suite as well as the directory 
and drive where you want WinBench to save it. By default 
WinBench saves the file in the WinBench subdirectory called 
SUITES. 

NOTE:The filename you supply must have an extension 
of .WBS and must follow DOS filename conventions. 
WinBench does not recognize this file as a test suite 
unless it has the .WBS extension.

6. Select OK. 



85 · Troubleshooting Appendix B

µ §

NOTE:If you modify a test suite that you have saved to a file, 
WinBench does not require you to save the revised test 
suite to the same DOS file. For example, you may modify 
the test suite All Text that is associated with the DOS file 
ALLTXT3.WBS. When you save your changes, you can 
enter a new filename for this test suite, such as 
ALLTXT4.WBS. 

Removing a custom test suite

To remove a custom test suite from the list of available tests, select 
that test suite in the drop-down list next to the Run button. Now 
select Delete from the drop-down menu Suite. WinBench removes 
the selected test suite from the list, but it does not delete the test 
suite's .WBS file from your system.

Checking your PC's configuration

You can check information about the state of your PC's 
configuration when you ran a set of tests by clicking on the 
Disclosure button in either the Chart of Results or the Table of 
Results or by selecting Disclosure from the File menu. When you 
select Disclosure, WinBench opens the Disclosure window. This 
window contains all the information the WinBench license 
agreement requires you to list when you publish WinBench scores. 
WinBench stores this information in the results file each time you 
save the test scores. 
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WinBench identifies the test results to which the disclosure 
information pertains by displaying a name for the results in the 
drop-down list box. If you have not modified the Test Description 
field in the Questionnaire dialog box, the name Current Results 
appears in the box. 

When you have multiple results files open, you can use the Next 
button to switch between the disclosure information for the 
different results files.

Editing the Disclosure Questionnaire

WinBench automatically supplies most of the disclosure 
information. You can add the missing information or modify 
current information that WinBench did not supply correctly by 
selecting the Edit button in the Disclosure window. This brings up 
the Disclosure Questionnaire, which lists many of the elements that 
make up the disclosure information and lets you change them. To 
change this information, click on the field you want, delete the old 
information, and type in the new information. Once you have 
modified the information in the Disclosure Questionnaire, select 
OK and WinBench saves your changes. If you select Cancel, 
WinBench ignores any changes you made.

You can also open the Disclosure Questionnaire window by 
selecting the menu option Questionnaire from the File menu.

In addition to storing your disclosure information when you save 
your test results, WinBench lets you copy your disclosure 
information to another file or program. To do this:

1. Open the Disclosure window.
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2. Highlight the information you want to copy.

3. Select Copy from the Edit menu.

When you copy the information, WinBench puts it on your 
Windows clipboard, where you can retrieve it later. You can also 
paste the information directly into a file. Open a file from an 
application such as Notepad and use that application's Paste option 
to paste the configuration information you copied into that file.
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Tips for running WinBench

You will get the most accurate WinBench scores for your PC if 
you follow these steps each time you run WinBench:

1.  Reformat your hard drive.

2.  Install the operating system (usually DOS). 

3. Install Windows.

4. Install any necessary video drivers. As you do this, note if the 
driver uses settings other than the default settings.

5.  Install WinBench.

6 Exit Windows.

7. Defragment your hard disk.

8. Reboot your PC.

9. Start Windows. Make sure you have not other applications 
running.

10. Run WinBench.

These steps ensure that you are running WinBench on a "clean" 
PC. A clean configuration is a freshly rebooted PC with an 
unfragmented disk that contains the operating system, Windows, 
and a minimum of other software. Because reinstalling your 
operating system is not always convenient, at a minimum you 
should do the following each time you run WinBench:

· Defragment your hard disk.
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· Reboot your PC.

You can get a utility that defragments your drive. Then, each time 
you want to run WinBench, run this utility first. This type of utility 
helps because the space available on your hard disk tends to 
fragment as you use your PC. This fragmentation can cause your 
WinBench scores to decrease. For example, if you compare two 
sets of test scores where you saved the first set after running 
WinBench using the steps described above and you saved the 
second set after performing your normal daily tasks and working 
with files on your PC, you will probably discover that the first set's 
scores are slightly faster than the second set's.

You may get slightly more reproducible scores if you run 
WinBench in batch mode because the state of Windows is more 
stable. When you run WinBench interactively, each time you move 
the mouse or press a key, you may be slightly affecting the 
environment in which WinBench is running, which could affect the 
repeatability of the test. 

You should always reboot your PC between test runs of 
WinBench.

You may also see some improvement in your test scores if you: 

· Avoid moving the mouse or pressing keys while the tests are 
running.

· Halt other applications you might normally run and run only 
WinBench.

· Use disk caching software, such as SMARTDrive.
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· Turn off any network drivers (if you have access to a network).

You should not have any other interrupt-level tasks running when 
you run WinBench. Avoid having TSRs or drivers that use 
interrupts loaded. If you do have such tasks running, they could 
affect your WinBench scores.

To use WinBench to your best advantage, consider how you 
normally use your PC. For example, if you use applications that 
rely heavily on graphics but very little on text, you might want to 
create a test suite that emphasizes key graphics functions rather 
than simply executing the WinMark scores. 

Sample test results

While there is no single base machine for WinBench, ZDBOp did 
test it on many of different PCs. A few of the results files from 
those test runs are in the directory WINBENCH\RESULTS. You 
can open these results files and use them as data points to help 
determine what your test results mean.
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What's next
This chapter explained how you can run WinBench. It told you:

· How to start WinBench, and how to exit WinBench, and as 
how to interrupt a series of WinBench tests.

· The options that WinBench provides in its main window. 
These options include function buttons, drop-down menus, and 
WinBench windows.

· The different ways you can execute the WinBench tests.

· How you can create and modify custom test suites.

· How to view your information the system configuration in 
effect when you ran the WinBench tests or that is currently in 
effect.

· Ways you get the most accurate results for your PC.

The rest of this manual contains information on how you can use 
your WinBench results. It also provides you with information 
about what affects your WinBench results and where you can find 
information to compare your PC to other PCs. For more 
information about:

· Saving, printing, and comparing your test results, see Chapter 
4.

· Understanding the results you get when you run the WinBench 
tests, see Chapter 5 and Appendix A.

· Determining what affects your WinBench results as well as 
how you can track your system information, see Chapter 6.
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· Understanding the concepts used to develop WinBench, such 
as profiling, see Chapter 7. This chapter also notes some things 
the tests do not do.

· Comparing your PC's test results to test results from other PCs, 
see 
Chapter 8.

In addition, Appendix A lists all the tests in WinBench, Appendix 
B provides troubleshooting tips if you encounter a problem, and 
Appendix C tells you how you can contact ZDBOp.

End of Chapter



Chapter 4
Working with WinBench's 
Results

WinBench gives you several options for viewing and using test 
results. You can:

· View them using either the Chart of Results or the Table of 
Results.

· Print them.

· Save them.

· Compare results from different test runs.

This chapter explains how to do these tasks. It also presents some 
tips on how to read and understand the test results. 

Before you read this chapter, you should understand the following 
terms:

· Baseline Machine. The baseline machine is the set of test 
results against which WinBench is comparing all other sets of 
test results in the Chart of Results. If you choose the Normalize 
option, WinBench sets the baseline machine's results to 1.0 and 



normalizes all the other open sets of results so that they appear 
in the chart as a fraction of the baseline machine's results. For 
example, if you compare three sets of results, the results for the 
baseline machine are always 1.0 in the chart; a slower test 
result might appear as 0.945 and a faster test result might 
appear as 1.07.

· Current Results. WinBench uses this term to refer to the 
results for the tests you ran most recently during this 
WinBench session. When you want to save your current results 
to a file, you must change the Test Description to something 
other than "Current Results."

Reading the test results

WinBench always displays test results in both the Chart of Results 
and the Table of Results. WinBench automatically opens these 
results windows when it finishes running the tests you specified. 

You can display a total of four sets of results at one time. In 
addition to your current test results, you can display results from 
up to three results files in these windows. These are results from 
previous test runs that you saved in files. When you open one of 
these test results files using the Compare option, WinBench 
displays the results in that file along with your current results. (See 
the section "Adding a results file to the results windows" later in 
this chapter for more information.)

NOTE:If you haven't run any tests, you can still use the Display 
Results button to open the results windows. Once the 
windows are open, you can either close them or minimize 

Licensed Material¾Property of Ziff-Davis Publishing Company, L.P.



§

them so they appear as icons on your WinBench screen. If 
you close them, you can use the Display Results button 
again to open them.

The Chart of Results

In the Chart of Results, WinBench displays the name of the test 
you ran and a horizontal bar graph showing how your machine 
performed on that test. If you have opened one or more comparison 
results files, WinBench also displays graphs of those results as 
well. 

The Chart of Results groups the different sets of results together 
test by test. For example, WinBench lists all the results for the 
Graphics WinMark together before it lists the results for the next 
test.

Figure 4-1:  The Chart of Results
 
To the left of the test's name, WinBench displays the score for each test. The 
graph itself shows the results in the units appropriate to that test. For example, 
WinBench reports most of the graphics test results in millions of pixels per 
second. Thus, when WinBench displays the results for one of these tests, the 
bar represents millions of pixels per second. When WinBench displays the 
results for a disk test, the bar represents thousands of bytes per second.

When you are viewing information in the Chart of Results, 
WinBench gives you the option of displaying the results as 
absolute values or normalized values. Absolute results are the 
actual scores for each test. If you select the option Absolute in the 



Chart menu, WinBench displays all the results in the chart as 
absolute scores. Normalized scores represent a ratio of the absolute 
scores of one PC to the absolute scores of the baseline PC. (See the 
section "Normalizing your test scores" later in this chapter for 
more information.) If you select the option Normalize from the 
Chart menu, WinBench displays the baseline machine's score as 
1.0 and all the other scores as a percentage of the baseline 
machine's score. (See the section "Specifying a baseline machine" 
later in this chapter for more information.)

The Table of Results

In the Table of Results, WinBench displays test information in a 
column format. 

The Table of Results has the following sections:

1. All the weighted test suites (i.e., the Graphics WinMark and 
the Disk WinMark), their scores, and the units (such as 
millions of pixels per second or thousands of bytes per second) 
for the scores. 

NOTE:WinBench computes the WinMark scores whenever 
you successfully run all the tests in a WinMark suite. In 
fact, if you are running individual tests, even in separate 
test runs, once you have run all the tests that compose a 
WinMark suite, WinBench computes that WinMark 
score and displays the score. As a result, you do not 
always need to explicitly run the Graphics WinMark 
suite or the Disk WinMark suite for WinBench to 
produce a score for these tests.
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Figure 4-2:  The Table of Results
 

2. All the individual tests that WinBench performed, their scores, and the units 
for the scores, such as "Thousand Bytes/sec" or "Million Pixels/sec." Next to 
the scores, WinBench displays numbers representing Notes about factors that 
might have affected the test results.

3. A list of Note numbers and an explanation of what those Notes 
mean. WinBench uses Notes to tell you about things that 
happened during the test that might have affected the test 
results. For example, if you move the mouse during a test, 
WinBench will include a Note next to that test's results to tell 
you about mouse motion.

The Table of Results also groups the sets of results by tests. When 
you have more than one set of comparison results open, WinBench 
displays the test name and the current results in the first two 
columns of the Table of Results. In the next columns, WinBench 
displays the results from the comparison machines. You will 
probably need to use the scroll bars at the bottom and on the left 
side of the Table of Results to view all the comparison results and 
all the tests.

Displaying different combinations of test results

From within the Chart of Results and the Table of Results, you can 
display different combinations of test results. The four options you 
have for displaying results are:



· Display a list of all tests that WinBench contains regardless of 
whether you have run them. To do this:

1. Open either the Chart of Results or the Table of Results. 
2. Select the option Display from either the Chart menu 

(Chart of Results) or Table menu (Table of Results). 
WinBench opens a cascading menu.

3. Select the option All Tests (this option is the same in both 
the Chart menu and the Table menu). 
WinBench now displays all its tests in the results windows. 
If it has not run a test, WinBench displays "Not Run" next 
to that test name.

· Display a list of just the WinMark tests regardless of whether 
you have run them. To do this:

1. Open either the Chart of Results or the Table of Results. 
2. Select the option Display from either the Chart menu 

(Chart of Results) or Table menu (Table of Results). 
WinBench opens a cascading menu.

3. Select the option All Marks (this option is the same in both 
the Chart menu and the Table menu). 
WinBench now displays the two WinMark tests in the 
results windows. If it has not run a test, WinBench displays 
"Not Run" next to that test name.

· Display the results for all the tests that you have run during this 
WinBench session. To do this:

1. Open either the Chart of Results or the Table of Results. 
2. Select the option Display from either the Chart menu 

(Chart of Results) or Table menu (Table of Results). 
WinBench opens a cascading menu.
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3. Select the option Tests Run (this option is the same in both 
the Table menu and the Chart menu).
WinBench now displays the current results of all the tests 
you have run. If you have run any tests more than once, 
WinBench only displays the most recent results for those 
tests.

· Display the test results for the currently selected tests. By 
default, when you select this option, WinBench displays the 
tests it just ran. If you want to specify a different set of tests:

1. Choose the option Selected from the drop-down list next to 
the Run button. The Select Tests dialog box appears.

2. Choose the tests for which you want to view results and 
move them to the Selected Tests box.

3. Click on OK. WinBench closes the Select Tests dialog box 
and displays Selected... as the choice in the drop-down list 
next to the Run button.

4. Activate either the Chart of Results or the Table of Results 
by clicking on one of these windows or, if they are closed, 
open one of them. Depending on which of these windows 
you activate, WinBench will add either the Chart menu 
(Chart of Results) or Table menu (Table of Results) to the 
Windows menu bar.

5. Select the option Display from either the Chart menu or 
Table menu. WinBench opens a cascading menu.

6. Select the option Selected Tests (this option is the same in 
both the Table menu and the Chart menu).
WinBench now displays the results for the tests you 
specified in the Select Tests dialog box.



Printing your PC's test results

You can print the information in the Chart of Results directly from 
WinBench if your PC is connected to a printer. To print the chart:

1. Activate the Chart of Results window by clicking in it.

2. Select the option Print from the File menu.

NOTE:If you need to set up your printer, select Printer Setup 
from the File menu before you select Print. You can 
only print to the default printer.

If you want to print the information in the Table of Results:

1. Copy the information to the Windows clipboard using the 
Copy option in the Edit menu. 

2. Paste that information into a file you opened from an 
application such as Notepad. 

3. Print the information from that application.

Creating a set of comparison results

WinBench lets you save your test results to files. You can then 
open the files later and compare test results from different test runs 
on your PC or from test runs on different PCs. In addition, 
WinBench comes with a small set of sample results files from test 
runs on PCs in the ZDBOp research center. These files are in the 
directory \WINBENCH\RESULTS. By default, WinBench saves 
all of its results files in the subdirectory RESULTS.
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The ability to compare different results files lets you see how well 
your current PC setup compares to other setups. You can also run 
before and after comparisons to see how a change you made to one 
of your PC's subsystems, such as switching to a different video 
card, affects the performance of that subsystem.

NOTE:To make valid comparisons between different PCs, you 
should generally run WinBench on both PCs the same way. 
For example, if you run the Disk WinMark suite on one PC 
with software disk caching enabled and on another PC with 
software disk caching disabled, you won't learn much about 
the relative speeds of the two disk subsystems. On the other 
hand, if you just want to see what effect a software disk 
cache has on your PC's disk subsystem, run the Disk 
WinMark on that PC with and without a software disk 
cache enabled.

You can check the setup of each PC by looking at the 
information in the WinBench Disclosure window. To see 
this information, select Disclosure from the File menu. 
(WinBench stores the current disclosure information at the 
end of each results file.)

The next sections describe how to save results files and how to add 
results files from other PCs to your PC. 

Saving your test results

WinBench lets you save your test results in one of four formats:

· A tab-delimited format suitable for use by Microsoft Excel 



(.XLS).

· A comma-delimited format suitable for use by Excel or Lotus 
1-2-3 (.CSV). 

· A plain text file (.TXT).

· A Windows metafile (.WMF).

When the Table of Results window is active, you can save your 
results in any of the first three formats. Once saved, you can open 
these files using either WinBench or a spreadsheet or text 
application program. 

When the Chart of Results window is active, you can save your 
results only as a chart in Windows metafile format. You can then 
open that chart using an application that accepts metafile format. 
You cannot, however, open that chart from within WinBench.

The next two sections explain the two ways you can save your 
results to a file.

Using the Table of Results to save files

By saving your current test results with the Table of Results 
window active, you can specify that WinBench save them in tab-
delimited format, 
comma-delimited format, or plain text. You can even save your 
results in all three of these formats by repeating the steps listed 
below for each format. Once you have created a results file in any 
of these three formats, you can open that file as a comparison set of 
results using WinBench. WinBench then displays all the test 
results in both the Table of Results and the Chart of Results. You 
can also open the file using Excel, Lotus, or a text application, 
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depending on the format you used to save the file.

NOTE:If you use another application to change anything in the 
results file, WinBench may no longer be able to read the 
file. 

Before you can save your current test results from the Table of 
Results, you must enter a unique description or name for the Test 
Description in the Disclosure form. By default, WinBench labels 
the test results "Current Results." You cannot save the results until 
you change this label. The following steps explain how to save 
WinBench test results to a file:

1. Open the Disclosure Questionnaire dialog box. There are two 
ways to do this: 

· Select the option Questionnaire in the File menu.
· Select the Edit button in the Disclosure window.
The Disclosure Questionnaire dialog box appears.

2. Enter a description or name in the box next to Test Description. 

NOTE:WinBench uses the text you enter here as the 
Comparison Machine name when you use the Compare 
option in either the Chart or Table menu.

3. Select OK.

4. Open the Table of Results Window.

5. Select Save As from the File menu. WinBench displays the 
Save Results in File dialog box.



Figure 4-3:  The Save Results in File dialog box
 

6. Specify the drive on which you want to save your results file, 
the directory in which you want to save your results in, and the 
name of the results file. By default, WinBench saves your file 
in the WinBench subdirectory RESULTS. 

You also need to specify the format in which you want to save 
the file. To save the file in:

· A tab-delimited format that an application such as 
Microsoft Excel can use, give the file name an extension 
of .XLS. This format often takes up less space than other 
formats.

· A comma-delimited format that an application such as 
Excel or 
Lotus 1-2-3 can use, give the file name an extension 
of .CSV.

· A plain text file, give the file name an extension of .TXT. 
This results file will also contain copies of your PC's 
AUTOEXEC.BAT, CONFIG.SYS, WIN.INI, and 
SYSTEM.INI files. (When you save the file in either of the 
other two formats, WinBench does not include the contents 
of these files in the saved results file.)

You can later open the results file with WinBench regardless of 
the format in which you saved it. You can also open the results 
file outside of WinBench using any application that accepts the 
file's format. For example, if you saved the file in .XLS format, 
then you can open the file with Excel. 

7. Select OK.
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If you want to save these results in more than one file format, 
repeat steps 5 through 7.

If you attempt to exit WinBench without saving your results, 
WinBench displays a window and asks if you want to save your 
test results. You can select Yes (save), No (don't save), or Cancel 
(don't exit from WinBench). 

If you select Yes and you have not changed the Test Description 
from the label "Current Results," you will need to go through the 
above steps. In this case, WinBench will not halt even after you 
save the file.

If you have already changed the Test Description, WinBench 
places you at the Save As window. Once you enter the data there, 
WinBench halts.

Using the Chart of Results to save files

You can save a set of test results as a chart by saving it when the 
Chart of Results is active. WinBench then saves the chart in 
Windows metafile format. This is the only format option you have 
with the Chart of Results. While you cannot later open this chart 
with WinBench, you can open it with any application that accepts 
the metafile format. To save your file as a Windows metafile, 
perform these steps:

1. Make the Chart of Results window the active window.

2. Select the option Save As from the Chart menu. The Save 
Chart as Metafile dialog box appears on your screen.



Figure 4-4:  The Save Chart as Metafile dialog box
 

3. Specify the drive on which you want to save the chart, the 
directory in which you want to save the chart, and the name of 
the file. Since you are saving the chart as a Windows metafile, 
give its name an extension of .WMF.

4. Select OK.

Adding results files from other PCs

If you have run WinBench on other PCs, you can save the results 
in files on those PCs and then move the results files to your current 
test PC. 

To move a WinBench results file, copy it to a diskette and then 
load the file on your current test PC. If the PCs are on a network, 
you may be able to move the information to your test PC using the 
network. When you load the file onto your test PC, you should 
load it into the WinBench subdirectory called RESULTS (e.g., 
\WINBENCH\RESULTS).
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Once you have the results file on your PC, you can display it by 
selecting the option Compare in either the Chart or the Table 
menu. 

NOTE: The window for the Chart of Results or the Table of 
Results must be active for you to be able to use the 
Compare feature.

Comparing results files

WinBench lets you easily compare multiple test results files in the 
Chart of Results and the Table of Results. WinBench displays the 
test results from these files in the two results windows along with 
your PC's Current Results. You can open up to three results files at 
the same time. WinBench always includes your PC's current 
results in the comparison shown in the Table of Results so that you 
can view of a total of four sets of results at one time. In the Chart 
of Results, you have the option of whether to display the current 
results. By default, WinBench displays them.

When you view the different results in the Chart of Results 
window, you can also normalize all of the results to the set of 
results (i.e., baseline machine) you specify. When you normalize 
the results, WinBench displays all of the results as a percentage of 
the baseline machine's results.

The next sections tell you how to add and remove different results 
files to both the Chart of Results and the Table of Results.



Adding a results file to the results windows

You can display up to three results files in the Chart of Results and 
the Table of Results windows. Because you can compare results 
from different machines, WinBench refers to the different results 
files as Comparison Machines, even when the results files are from 
the same PC. 

You can use WinBench's Compare option as one way to evaluate 
your PC. By having several results files open at the same time you 
can easily see how changing something in either your graphics or 
disk subsystem affects that subsystem's performance. For example, 
you can run the Disk WinMark with software disk caching enabled 
and with software disk caching disabled to determine the effect 
disk caching has on your PC's disk subsystem's performance. You 
can also see how your PC compares to other PCs by looking at 
WinBench results from tests run on other PCs.

To compare test results:

1. Open either the Chart of Results or the Table of Results 
window. 

NOTE:If you add a results file to either the Chart of Results or 
the Table of Results, WinBench displays the file in both 
results windows.

2. Select either Chart (for the Chart of Results window) or Table 
(for the Table of Results window) from the menu bar.

3. Select the option Compare. The Comparison Machines window 
appears.
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Figure 4-5:  The Comparison Machines window
 



4. Select Add. The Open Comparison File dialog box appears.

Figure 4-6:  The Open Comparison File dialog box
 

5. Specify the name of the file you want to add. WinBench lists 
all the files in the \WINBENCH:\RESULTS directory that have 
a .TXT, .CSV, or .XLS extension. You can change to another 
directory.

6. Once you have selected the file you want and it appears in the 
File Name box, select OK. WinBench returns you to the 
Comparison Machines dialog box and displays the information 
you entered in the Test Description box in the Questionnaire 
window. 

7. You can add another comparison machine or remove a 
comparison machine:

· To add another comparison machine, select Add and repeat 
steps 5 and 6. You can add up to three comparison 
machines.

· To remove a comparison machine, highlight the name of 
the comparison machine you don't want and select Remove. 

8. Click on OK when the Comparison Machines dialog box 
contains the machine (or machines) you want. WinBench adds 
the results information to the two results windows and you are 
done.
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Removing a set of results from the results windows

You can remove a set of results from the Chart of Results and the 
Table of Results windows by closing that results file. 

To remove a comparison set of results from the Chart of Results 
and the Table of Results, perform these steps:

1. Select the option Compare from either the Chart (Chart of 
Results) or the Table (Table of Results) menu. The Comparison 
Machines dialog box appears. Under the heading Comparison 
Machines, WinBench lists the names of all the open results 
files.

2. Highlight the name of the results file you want to remove from 
the Chart of Results and the Table of Results.

3. Click on Remove. 

NOTE:Clicking on Remove closes a currently open results file. 
It does not delete a results file from your PC.

If you want to remove another results file, repeat steps 2 and 3.

4. Click on OK when you have removed all the results files 
you want to remove.

Normalizing your test results

In the Chart of Results window, WinBench displays test results as 



either absolute or normalized. Absolute results are the actual scores 
for the tested PCs on the specified tests. Normalized results 
represent a ratio of the absolute results of one PC to the absolute 
results of the baseline PC. This ratio of the results can provide you 
with an easy basis for comparing the scores. You can compare up 
to three machines to the baseline machine.

The baseline machine can be any PC for which you have a set of 
results. The baseline machine can be your current results, results 
from tests you ran previously on your PC, or results from other 
PCs.

When you use the Normalize feature, WinBench sets the results for 
the baseline machine to 1.0 and displays all other results as a 
fraction of the base machine's results. For example, if you want to 
compare the different video boards you tested, you may want to 
select the board that produced the best WinBench scores and use 
that as your baseline results. Then you can see at a glance how the 
test results for the other boards compare to the test results for the 
baseline machine.

The Chart of Results is often easier to read if you normalize 
results. If one WinBench test ran very fast, while another 
WinBench test took much longer, the bar graph for the fast test 
would be almost too short to read because the graph for the slow 
test would need to be so long.

You can specify whether WinBench displays normalized scores or 
absolute scores by selecting either the menu option Normalized or 
Absolute from the Chart menu on the Windows menu bar. 

The next section explains how to select a baseline machine.



§

Specifying a baseline machine 

You can specify which set of results WinBench normalizes the 
other results against by selecting one set as the baseline machine. 

NOTE:You can only select a baseline machine for the Chart of 
Results. You cannot display normalized results in the Table 
of Results.



To select the baseline system, first make sure the Chart of Results 
window is active and you are viewing normalized results, not 
absolute results. If you are not sure, simply select the option 
Normalize from the Chart menu. Now follow these steps:

1. Select the option Baseline from the Chart menu. WinBench 
displays the Baseline Machine dialog box.

Figure 4-7:  The Baseline Machine dialog box
 

2. Select the name of the set of results you want to use for the 
baseline machine from the drop-down list of open results files.

3. Click on OK.

WinBench now displays all the results in the Chart of Results 
window as a percentage of the results for the baseline machine.

What's next

This chapter contained information on working with WinBench's 
results files. It told you:

· How to read the WinBench results in both the Chart of Results 
and the Table of Results.

· How to print your test results.

· How to save your test results to a file you can later open from 
within WinBench or from within a text editor, spreadsheet, or 
word-processing application. It also explained how to save 
your file as achart that you can open later with any application 
that accepts Windows metafile format.
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· How to compare different results files.

· How to specify a baseline machine against which WinBench 
normalizes all other test results.

The rest of this manual contains information about what affects 
your WinBench results and where you can find information to 
compare your PC to other PCs. For more information about:

· Understanding the results you get when you run the WinBench 
tests, see Chapter 5 and Appendix A.

· Determining what affects your WinBench results as well as 
how you can track your system information, see Chapter 6.

· Understanding the concepts used to develop WinBench, such 
as profiling, see Chapter 7. This chapter also notes some things 
the tests do not do.

· Comparing your PC's test results to test results from other PCs, 
see 
Chapter 8.

In addition, Appendix A lists all the tests in WinBench, Appendix 
B provides troubleshooting tips if you encounter a problem, and 
Appendix C tells you how you can contact ZDBOp.

End of Chapter



Chapter 5
Understanding 
WinBench's Results

This chapter discusses the different tests that come with WinBench 
and how you can use their results. 

The two key tests are the Graphics WinMark and the Disk 
WinMark. These tests use numerous operations determined by 
profiling to mimic the graphics and disk activities of popular 
applications. The Graphics WinMark tests and the Disk WinMark 
test each work like a synthetic application that focuses its 
operations on only one subsystem and excludes the other 
subsystems that actual applications invariably use also. Thus, these 
tests can stress a PC's graphics or disk subsystem in the same way 
that applications do without requiring as much time as running 
multiple applications would take and with more of a focus on those 
subsystems than the applications can provide. 

The Graphics WinMark

The Graphics WinMark is an overall measure of the performance 



of your PC's graphics subsystem. The tests in the Graphics 
WinMark suite exercise the painting operations that the Graphics 
Device Interface (GDI) calls in popular Windows applications 
perform regularly. WinBench weights each of the operations based 
on information received by profiling leading applications. 

To calculate the Graphics WinMark, WinBench runs seven test 
mixes and then determines a harmonic mean of their scores. 
Together, these seven test mixes, called Combined GWM tests, 
combine 66 tests of 18 different GDI operations. Instead of simply 
performing one operation after another, each Combined GWM test 
consists of a subset of these operations and executes the operations 
much the way actual applications perform graphics operations. 
These test mixes vary how frequently they perform a single GDI 
operation according to that operation's weight. Two factors 
determine the weight an operation receives:

· The market shares of the profiled applications that use the GDI 
calls being tested. An application's unit market share represents 
that application's percentage of the total number of products 
sold in that category of applications, such as spreadsheet 
programs. Thus, if one application has a higher unit market 
share than another application, the operation the first 
application performs most frequently will have a higher weight 
than the operation the second application performs most 
frequently (assuming that these are two different operations).

· The frequency of the operation's usage by the profiled 
applications.

Operations that appear frequently in the profiled applications also 
appear frequently in the Combined GWM tests. 



WinBench times how long each test mix in the Graphics WinMark 
takes to execute on your PC and then combines the results using a 
weighted harmonic mean. The resulting Graphics WinMark score 
represents the number of millions of pixels per second your PC can 
display.

Because WinBench does not run actual applications, its graphics 
tests can focus solely on graphics operations. They do not include 
any of the other operations that applications typically have 
interspersed with graphics operations. Thus, the Graphics 
WinMark represents the overall performance of a PC's graphics 
subsystem, but it does not provide an indication of overall 
application performance.

For more information on the tests in the Graphics WinMark, see 
Appendix A.

If you want to know which hardware and software factors affect 
the Graphics WinMark, see Chapter 6. 

The Disk WinMark

The Disk WinMark is a measure of the rate at which your PC 
performs disk operations. You can also use the Disk WinMark 
suite to measure the effect of disk caching under Windows. 

WinBench determines your PC's Disk WinMark by running a 
single, large test called the "Disk, Mix." This test mirrors the way 
applications use PC disk subsystems. It varies the operations it 
performs as well as the parameters for the operations just as actual 
applications do. The Disk Mix acts like a very large disk-intensive 
application. It uses more than 100 files spread across six 
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directories. It works with up to seven files at one time as well as 
creating and deleting files. In addition, the Disk Mix moves data in 
different-sized chunks and intersperses write and read operations. 
Its test files include data from source code, database, text, binary, 
executable and bitmap files.

The Disk Mix uses the standard Int 21H interface to access the disk 
subsystem, so it accurately measures your PC's disk performance 
regardless of whether you are using a software disk cache. The 
Disk Mix's data files compress the way real application files do. As 
a result, you can also use the Disk Mix to measure disk subsystems 
that use disk compression. 

WinBench times how long your PC takes to perform the Disk Mix 
and then returns your PC's Disk WinMark score in thousands of 
bytes per second.

Because WinBench does not run actual applications, the Disk Mix 
focuses on operations that affect the disk. It does not include other 
operations that an application would typically intersperse with disk 
operations. Thus, the Disk WinMark gives you an overall 
indication of how well your PC handles disk operations, but it does 
not provide an indication of overall application performance.

For more information about the Disk WinMark, see Appendix A.

If you want to know which hardware and software factors affect 
the Disk WinMark, see Chapter 6. 



WinBench's individual tests

The Graphics and Disk WinMark tests use only a subset of the 
tests in WinBench. WinBench contains more than 200 tests that 
you can use to measure different aspects of the performance of 
your graphics and disk subsystems.

NOTE:When you run any of the individual tests, WinBench does 
not weight the test results. WinBench uses weights only 
when you run the Graphics WinMark.

The graphics tests

WinBench lets you test the performance of almost any Windows 
GDI operation. The graphics tests use a distribution of operands 
that approximates the distribution of operands found in the profiled 
applications. For example, instead of simply drawing numerous 
lines that are all the same size, the WinBench Line tests draw lines 
of the average, minimum, and maximum lengths the applications 
drew. 

Also, the WinBench graphics tests in some ways go beyond the 
operations that many applications commonly perform in an effort 
to really test your PC's graphics subsystem. For example, the 
WinBench graphics tests put additional stress on PC graphics 
subsystems by using dithered colors.

As an added bonus, when you run all the graphics tests, you have a 
decent Windows video driver compatibility test. The WinBench 
graphics tests can be useful for locating incompatibilities in video 
adapters.
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The disk tests

WinBench includes numerous individual disk tests. By running 
these disk tests, you can measure how fast data can move to and 
from your PC's disk. The WinBench disk tests read and write data 
sequentially and randomly in blocks of 200 bytes, 512 bytes, 2048 
bytes, and 4096 bytes.

The sequential tests can help measure disk throughput as 
WinBench sequentially moves data to and from the disk. These 
tests repeatedly read or write records in order from the beginning 
to the end of the test disk file. By running the sequential disk tests, 
you can gauge the maximum throughput rates for the different 
block sizes of data.

With the random tests, you can gauge the access rate of the disk by 
randomly moving the disk head. The random tests transfer data to 
and from the disk using random file offsets. 

The 4096-byte sequential Read and Write tests can provide 
information on the maximum data throughput of the disk hardware 
if you have all disk caches turned off. The 512-byte random Read 
and Write tests can help indicate the mechanical positioning time if 
no caches are enabled. The 200-byte operations can be useful for 
exercising file buffering under DOS.

See Appendix A for more information on the disk tests.

WinBench's built-in test suites 

In addition to the two WinMark suites and the individual tests, 
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WinBench comes with some built-in test suites that you may want 
to run. These are groups of tests that you can execute with a single 
command. Each test suite focuses on a different aspect of either 
your PC's graphics or disk subsystem that you may want to 
measure. As with the other WinBench tests, the tests in these test 
suites are the result of profiling multiple applications.

WinBench ships with seven built-in test suites. 

The three most important built-in test suites are the Graphics 
WinMark, the Disk WinMark, and the All Tests suite. The other 
built-in test suites are the Disk Tests, the GDI Tests, the GWM 
Tests, and the USER Tests. For more information about these tests 
suites and the results they return, see Appendix A.

What's next

This chapter gave you general information about WinBench's tests. 
It provided information on:

· The Graphics WinMark.

· The Disk WinMark.

· The individual tests.

The rest of this manual contains information about what affects 
your WinBench results and where you can find information to 
compare your PC to other PCs. For more information about:

· Determining what affects your WinBench results as well as 
how you can track your system information, see Chapter 6.



· Understanding the concepts used to develop WinBench, such 
as profiling, see Chapter 7. This chapter also notes some things 
the tests do not do.

· Comparing your PC's test results to test results from other PCs, 
see 
Chapter 8.

In addition, Appendix A lists all the tests in WinBench, Appendix 
B provides troubleshooting tips if you encounter a problem, and 
Appendix C tells you how you can contact ZDBOp.

End of Chapter
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Chapter 6
What Affects WinBench's 
Results

This chapter contains information on some of the hardware and 
software factors that can affect how well your PC performs on 
WinBench's tests.

This chapter also talks about how you can check and modify the 
information WinBench gathers about your PC's configuration. You 
will need to include most of this information if you want to publish 
your WinBench test scores.

Factors that influence the test scores

Many factors can affect how well your PC performs on the 
WinBench tests, including such high-level issues as the kind of PC 
you have. WinBench notes some of the obvious factors in the 
Table of Results window and the Disclosure windows. These 
factors include whether you moved the mouse during the test and 
whether you had any other applications running when you ran the 
WinBench tests. (For more information, see "Tips for running 



WinBench" in Chapter 3.)

The hardware and software components on your PC that can affect 
its performance include:

· Operating system version

· Windows system, including your PC's Windows graphics 
driver software

· Processor type and speed

· Off-chip processor cache (if any)

· Amount of RAM

· Type of hardware bus or buses

· Type of hard disk

· Type of hard disk controller and size of your PC's hardware 
disk cache (if any)

· Disk fragmentation

· Video adapter and the amount and type of RAM (DRAM or 
VRAM) on it

· Video resolution and color depth

· Refresh rate

· Size, type, and version of software disk cache (if any)

· Any other special conditions, such as enabled disk compression 
utilities



Major factors that can affect the Graphics WinMark

Certain system factors can affect how well your PC performs on 
the Graphics WinMark tests and the individual graphics tests. 
These factors include:

· Operating system

· Windows system

· Type of computer 

· Processor

· Processor speed

· Off-chip processor cache, if any

· Processor RAM

· Type of hardware bus

· Video driver

· Video adapter

· Video DRAM

· Video VRAM

· Video refresh rate

· Video resolution and color depth

· Video driver options

For example, you may see different performances between two 
otherwise identical graphics boards when the boards have different 
amounts of graphics memory. Also, graphics driver software 
modules that have different revision levels or different 
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manufacturers can produce different scores. 

Major factors that affect the Disk WinMark

Certain system factors can affect how well your PC performs on 
the Disk WinMark and the individual disk tests. 

The major factors that can affect your Disk WinMark score 
include:

· Operating system

· Windows system

· Type of computer 

· Processor

· Processor speed

· Off-chip processor cache, if any

· Processor RAM

· Type of hardware bus

· Hard disk

· Hard disk controller

· Hard disk controller RAM

· Amount of controller cache memory

· Type, version, and size of the software disk cache (if any)

· Disk fragmentation



For example, you may see different performances between two 
otherwise identical disk controllers when the controllers have 
different amounts of hardware cache memory. Also, you may see 
different performances when you vary track buffering, writeback 
strategies or other disk caching parameters.

Tracking your system information

Because your system configuration has an effect on your 
WinBench results, you need to be able to determine this 
information so you can meaningfully interpret each set of test 
results. This is especially important when you are changing your 
PC's configuration between tests to see how a change affects 
performance. For example, you might run the disk tests with and 
without software caching enabled to see the effect software 
caching has on your disk subsystem. 

In addition, if you publish your WinBench results, you must 
include information about your system setup.

WinBench helps you keep track of your system configuration by 
providing a Disclosure Questionnaire. This questionnaire lists the 
types of information that you must supply if you publish 
WinBench results. Most of the information in this questionnaire is 
information that WinBench cannot determine. The questionnaire 
also contains additional information you may find helpful when 
you review the different results you can get from WinBench or 
compare your PC's results to other results from other PCs.

WinBench automatically fills in some of the information about 
your PC's configuration in the Disclosure Questionnaire. When it 
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cannot determine the correct answer, it leaves question marks in 
that space or states that the information is "unknown." You can add 
this information as well as modify information that WinBench 
supplied or that you added earlier. Each time you save your results 
to a file, WinBench stores this information with them.

The next sections explain what information WinBench lists about 
your system configuration. They also tell how you can open the 
Disclosure window to check the system information for all the 
currently open comparison results files and how you can modify 
information in the Disclosure window by using the Disclosure 
Questionnaire.

Viewing information about your PC's configuration

WinBench contains information about your PC in the Disclosure 
window. To view this information, you can either:

· Select Disclosure from the File menu.

· Click on the Disclosure button in the Chart of Results window 
or the Table of Results window.

When you perform any of these actions, WinBench opens the 
Disclosure window. This window contains the system 
configuration that is currently in effect as well as the system 
information for any comparison results files you have open. To 
view the system information about a comparison file, use the drop-
down list that contains the descriptive names for the test runs, such 
as "Current Results."



To see all the information in this window, you will need to use the 
vertical scroll bar.

Once you open the Disclosure window, you can either close it or 
minimize it so that it remains as an icon in the WinBench 
application window.
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Modifying information about your system configuration

WinBench lets you modify or change your current system 
information. There are two ways you can do this:

· Select Questionnaire from the File menu.

· Click on the Edit button in the Disclosure window.

Figure 6-1: The Disclosure Questionnaire
 

When you perform either of these actions, WinBench opens the 
Disclosure Questionnaire window. You can change any of the 
information in this window. Just click in the text box you want to 
modify, delete the old information, and 



type in the new information. The following list explains the 
information you can edit and tells you which information 
WinBench does not automatically supply:

· Test Description. Enter a description of your PC. For 
example: 

COMPAQ DESKPRO 66M, 1024x768 256 colors

You can enter a special name here to identify this run of 
WinBench. This is the information WinBench displays if you 
later use the Compare feature to add or remove test results for a 
comparison machine. 

· Computer. Enter the type of computer you are using.

· Processor. Enter the type of processor in your PC.

· Processor Speed. Enter the speed of your PC's processor.

· Off-Chip Processor Cache. Enter the size of this cache, if you 
have one on your PC. (WinBench cannot determine this value.)

· Processor RAM. Enter the amount of RAM in your PC.

· Video Adapter. Enter information about the video adapter 
your PC uses. For example:

COMPAQ QVision 1024x768 256 colors

· Video DRAM. Enter the amount of dynamic RAM your video 
adapter has, if any. (WinBench cannot determine this value.)

· Video VRAM. Enter the amount of video RAM your video 
adapter has, if any. (WinBench cannot determine this value.)

· Video Refresh Rate. Enter your PC's video refresh rate. 
(WinBench cannot determine this value.)
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· Hard Disk. Enter the name of the maker of your PC's hard disk 
and its name or model number. (WinBench cannot determine 
this value.)

· Hard Disk Controller. Enter the name of the maker of your 
PC's hard disk controller and its name or model number. 
(WinBench cannot determine this value.)

· HD Controller Cache Size. Enter the amount of hardware disk 
cache, if any, on your PC's hard disk controller. (WinBench 
cannot determine this value.)

· Software Disk Cache. Enter the name of the software disk 
cache your PC uses, if any. WinBench will detect 
SMARTDrive, but not any other software disk caches.

· Software Cache Size. Enter the size of your software disk 
cache, if any.

· Additional Comments. Enter any comments you have about 
this test run.

NOTE:You can only modify information for your current set of 
test results. You cannot change the information in any of 
the currently open comparison results files.

If you are running WinBench in batch mode, then the only way 
you can change the system information is by modifying the 
RUNWB.INI file. See Chapter 3 for information on running 
WinBench in batch mode.

Remember that if you want to save your test results to a file, you 
will need to change the Test Description that appears in the 



Disclosure Questionnaire.

Contents of the Disclosure window

When you open the Disclosure window, WinBench displays both 
the information you must report to publish your test results and 
additional important information about that test run. This is the 
same information that WinBench stores in the results files.

Figure 6-2: The Disclosure window
 

The first part of the Disclosure window displays the required 
information: 

· Name (i.e., Test Description).

· Benchmark. WinBench automatically fills in its name and 
version number. 

· Operating System. WinBench automatically fills in the version 
of the operating system you are using.

· Windows System. WinBench automatically fills in the version 
of your operating system and the mode in which you are 
running it. 

· Computer. 

· Processor. 

· Processor Speed. 

· Off-Chip Processor Cache.

· Processor RAM. 
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· Video Driver. 

· Video Adapter.

· Video DRAM. 

· Video VRAM. 

· Video Refresh Rate. 

· Video Mode. 

· Hard Disk. 

· Hard Disk Controller. 

· HD Controller Cache Size.

· Software Disk Cache. 

· Software Cache Size. 

For the most part, this is information that you can edit in the 
Disclosure Questionnaire.

The second part of the Disclosure window displays information 
that WinBench supplies, some of which is based on information 
you provided in other places, such as the registered name. This 
information is for your use only; it is not information you need to 
supply if you publish your WinBench results.

· Description. WinBench displays the Test Description you 
entered when you saved your results to a file.

· Time. WinBench automatically enters the time at which you 
started the WinBench session. 



· Registered Name. WinBench automatically enters the name 
you entered when you registered your copy of WinBench.

· Registered Organization. WinBench automatically enters the 
name of the organization (if any) you entered when you 
registered your copy of WinBench.

· Tester Name. WinBench automatically enters as the default the 
name you entered when you registered your copy of 
WinBench. When you run WinBench as a batch file using the 
RUNWB.INI file, you can specify the Tester Name. 

· Tester Organization. WinBench automatically enters as the 
default the name of the organization (if any) you entered when 
you registered your copy of WinBench. When you run 
WinBench as a batch file using the RUNWB.INI file, you can 
specify the Tester Organization.

· Comments. WinBench displays any comments you entered 
when you modified the Disclosure Questionnaire. 

· System Metrics. WinBench displays information about the 
system metrics, such as the height and width of objects on the 
screen. This information is useful to programmers.

· Video Capabilities. WinBench displays information about what 
your video device driver is capable of doing, such as the 
number of colors it can support and objects it can draw. For 
example, if your video device driver cannot draw filled 
polygons, then the GDI needs to handle that operation. This 
information is useful to programmers. 

· Disk Settings. WinBench displays information about your PC's 
disk settings that may affect how the disk tests perform. This 
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information comes from the file SYSTEM.INI.



WinBench comes with a set of comparison results when you install 
it. The following is a sample disclosure file.

µ §NAME DESKPRO 386/25M AdvancedVGA 640x480 16

REQUIRED DISCLOSURE

Benchmark Ziff-Davis' WinBench Version 4.0
Operating System MS-DOS 5.0
Windows System Windows 3.10 Enhanced Mode
Computer COMPAQ Deskpro 386/25M
Processor 80386+80387
Processor Speed 25 MHz
Off-Chip Processor Cache 16 KB
Processor RAM 4 MB
Video Driver vga.drv 3.10 Tue Mar 10 03:10:00 1992 

Size: 73200
Video Adapter VGA
Video DRAM 512 KB
Video VRAM 0 KB
Video Refresh Rate 60 Hz
Video Mode 640 X 480 4 bits/pixel
Hard Disk Conner CP30101
Hard Disk Controller IDE
HD Controller RAM 0 KB
Software Disk Cache SMARTDrive 4.0: A B C+
Software Cache Size 512 KB

ADDITIONAL INFORMATION

Description Deskpro 386/25M AdvancedVGA 640x480 16
Time Tue Oct 05 10:01:55 1993
Registered Name R.B. Bopps
Registered Organization  Lab Operations
Tester Name R.B. Bopps
Tester Organization Lab Operations
Machine Name None
Comments WinBench 4.0 sample results. Winstone base 
machine.
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System Metrics Screen: 640X480, Full Screen: 640X460 Frame: 4X4, 
Border: 1X1 DlgFrame: 4X4 Scroll V: 17X17 H: 17X17, 
Thumb V: 17 H: 17 Caption: 20 Menu: 18 Size: 18X18 

Icon: 32X32, Cursor: 32X32 MinTrack: 102X26, 
Min: 102X26 Mouse: 1 Swap: 0 Debug: 0 Kanji: 0
Video Capabilities Size: 640X480 pixels, 208X156 mm., 96X96 
pixels/inch Aspect: 36X36 51 Planes: 4 Bits/Plane: 1 Palette Size: 

0, Reserved: 0, Color Resolution 0 Brushes: -1, 
Pens:80, Fonts: 0, Colors 16 Capabilities: 

Clip 0x1, Raster 0x46d9, Curve 0x0, Line 0x22, Poly 0x8, Text 
0x2204
Disk Settings 32BitDiskAccess=off FileSysChange=off 

VirtualHDIrq=off

µ §

Printing the system information

When you save your tests results to a file, WinBench stores the 
current system information in the file. You cannot print the system 
information from within WinBench, but you can print it from other 
applications. 

To print the system information:

1. Save your current results to a file. (See Chapter 4 for 
information on how to do this.)

2. Start an editor (such as NotePad), word-processor application, 
or a spreadsheet application.

3. Open the results file from within that application.



4. Print the results file using that application's print command.

NOTE:If you saved your results as a text file, WinBench includes 
copies of your AUTOEXEC.BAT, CONFIG.SYS, 
WIN.INI, and SYSTEM.INI files in the results file. 
WinBench does not include these system files when you 
save your results as a .XLS or .CSV file. 

Requirements for publishing WinBench results

The WinBench license agreement requires you to disclose certain 
information each time you publish WinBench results. Thus, if you 
report your WinBench results, you might say something similar to:

Achieved a Graphics WinMarkä of 0.304 on the WinBenchâ 
4.0 test using WXY PC Corp. Model 466 with 66-MHz Intelâ 
486DX2 CPU, 8 MB of RAM, 64 KB RAM cache, 200 MB 
hard disk, IDE controller, and no hardware disk cache with 
XYZ Corp. XYZ Video adapter with 2MB VRAM with 
XYZ.DRV version 1.1 driver and a refresh rate of 72 Hz on 
MS-DOSâ 5.0 operating system with a SMARTDRV version 
A.B 2MB cache, a video color resolution and color depth of 
800 by 600 pixels with 256 colors, and with the disk 
compression utility ABC version 1.0 enabled.

WinBench is a registered trademark and WinMark is a 
trademark of 
Ziff-Davis Publishing Company., L.P.

For a precise list of all the system information you must 
include to publish WinBench results, see the license agreement 
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at the beginning of this manual and in the on-line help.

Reference hardware platform

WinBench does not normalize its results against a specific 
reference hardware platform. Ziff-Davis tested WinBench on a 
large variety of PCs. To help you understand your WinBench 
scores, your WinBench diskette contains several sample results 
files from different test PCs. You will find these files in the 
WINBENCH subdirectory called RESULTS (e.g., 
\WINBENCH\RESULTS).

What's next

This chapter provided you with information about what hardware 
and software affects your WinBench results. It told you:

· The major factors that affect the Graphics WinMark.

· The major factors that affect the Disk WinMark.

· How WinBench records some information about your system 
configuration and stores the information in results file.

· How you can modify the system information for your current 
results.

· How to print your system information.

The rest of this manual contains information about the concepts 



that went into designing WinBench and where you can find 
information to compare your PC to other PCs. For more 
information about:

· Understanding the concepts used to develop WinBench, such 
as profiling, see Chapter 7. This chapter also notes some things 
the tests do not do.

· Comparing your PC's test results to test results from other PCs, 
see 
Chapter 8.

In addition, Appendix A lists all the tests in WinBench, Appendix 
B provides troubleshooting tips if you encounter a problem, and 
Appendix C tells you how you can contact ZDBOp.

End of Chapter



Chapter 7
Concepts Behind the 
WinBench Tests

This chapter discusses some of the purposes behind WinBench and 
how you can use its test results. This chapter also explains some of 
the key factors that went into creating the WinBench tests and that 
let those tests reflect actual graphics and disk operations that 
applications perform. These factors include profiling leading 
applications, determining the parameter distributions of operations, 
and weighting operations. 

Design goals behind the tests

The main design goal behind WinBench is to provide the means to 
measure accurately the performance of the graphics and disk 
subsystems of a PC. You can use this information to help 
determine how well your PC performs in a Microsoft Windows 
environment when you use it to run Windows-based applications. 
WinBench does not give you an overall rating of your PC's 
performance in this environment the same way that the Winstone 
94 benchmark does, nor does it run actual applications. WinBench 



does, however, provide useful information about how these two PC 
subsystems perform. 

WinBench returns two key scores, the Graphics WinMark and the 
Disk WinMark. You can use these scores to compare the graphics 
and disk subsystems of your PC with those subsystems on other 
PCs. In addition, WinBench provides numerous other tests that let 
you create suites of tests tailored to reflect the applications you 
normally run.

WinBench does all it can to provide a fair test regardless of the 
particular PC on which you run it. For example, in the Table of 
Results, WinBench notes anything it can detect that happened 
during the test that might affect the test results, such as having 
other programs running in the background. In addition, WinBench 
maximizes the test screen when it runs to provide an equitable 
basis for testing PCs. This prevents someone from running 
WinBench in a very small window on one PC and in a large 
window on another PC and then comparing the results. (On the 
other hand, WinBench cannot stop you from comparing the results 
of two PCs running at different resolutions. See the note below.) 
These features help ensure that, when you compare the WinMark 
scores on different PCs, you are making a valid comparison. 

NOTE:You play the biggest role in generating valid comparison 
results. If you are switching subsystem components, make 
sure that everything else is the same on your PC except the 
subsystem component you want to test. If you are 
comparing different PCs, run WinBench with the same 
system setup on all of the PCs; otherwise, comparisons will 
not be valid. For example, if you run the Disk WinMark on 
one PC with software disk caching enabled and you run it 



on a second PC with software disk caching disabled, you 
will not get a valid comparison. This is because disk 
caching can significantly affect your disk score. 

To ensure that you have the same system configuration on 
all the test PCs, check the information in WinBench's 
Disclosure window.

WinBench is a "synthetic" benchmark. This means that instead of 
running applications, it contains tests that behave the way 
applications behave. These tests mimic the graphics and disk 
operations that leading applications perform. An advantage to 
using a synthetic benchmark is that it typically takes much less 
time to run than executing applications does, yet it can still reflect 
the major graphics and disk subsystem operations numerous 
applications perform. A synthetic benchmark can also provide tests 
that focus on a single PC subsystem.
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WinBench's tests accurately reflect how applications perform 
because they include the following factors in their design:

· They use operations that leading applications perform as their 
basis.

· They use application profiling to determine the most 
commonly used operations.

· They duplicate attributes, such as the types of Graphics Device 
Interface (GDI) operations, of the profiled applications.

· They duplicate the types of disk operations the applications 
perform.

· They vary the operations each test performs to reflect the way 
applications actually use operations.

· They use weighted harmonic means to report the Graphics 
WinMark score.

Using leading applications to determine test operations

WinBench's tests reflect the way typical users use their PCs as they 
perform routine tasks with leading applications. The tests succeed 
at this goal because of WinBench's market-centered orientation. 
Rather than profiling applications that target specialized users, 
such as architects or engineers who spend all day with CAD 
programs, ZDBOp selected top-selling applications¾those with the 
largest share by unit sales of the Windows software market¾and 
profiled them.



The WinBench tests reflect data gathered from profiling the 
applications in Winstone 94. Winstone 94 contains twelve top-
selling applications in the following six categories: Business 
Graphics, Database, Desktop Publishing, Multifunction, 
Spreadsheet, and Word Processing.

NOTE: Infocorp, an independent software industry research 
division of 
Ziff-Davis. supplied the research data that determined the 
historical and projected unit market shares for the 
categories 
Winstone 94 uses and for the applications within those 
categories.

This market-share information also determined the weights 
WinBench uses to calculate the Graphics WinMark.
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Profiling applications

Profiling is a method of logging each operation an application 
performs. The application profiles show which operations the 
applications perform and how frequently the applications perform 
them. By using these profiles, WinBench's tests can produce scores 
that correlate with the performance of the graphics display portions 
of typical Windows applications. The operations the Graphics 
WinMark tests and the Disk WinMark tests perform reflect the 
statistical profiles of the target applications.

ZDBOp used both commercially available profiling tools and in-
house tools to log the way different applications work with PCs 
while performing typical tasks. Profiling created a log file for each 
application. Each application's log file contained a list of every 
operation that application performed in the order that the 
application performed it. For example, each time a Windows 
application executed a GDI call to InvertRect, the profiling tools 
recorded that call. Specially developed analysis programs then 
produced from the log files such information as: 

· The types of operations the applications perform. 

· The typical parameters of those operations (including the 
distribution and frequency of the parameters).

· The number of operations the application scripts perform. 

· The number of pixels the operations draw. 

· How the applications interact with the GDI and USER 
components of Windows. The profiling tools trace every GDI 



and USER operation an application performs in the order the 
application performs it. 

NOTE: The log files contain all USER calls made by both 
the applications and the DLLs they use.

· The parameters and return values for most of these operations. 
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Using parameter distributions in the tests

Application profiling determined the distribution of operations and 
the parameters to those operations in the WinBench tests. 

Distribution is the process of varying parameters for operations 
and the operations themselves to reflect how applications actually 
perform them. The WinBench tests reflect the varied ways that 
applications use these operations by assigning different parameters 
to the same operations. For example, instead of drawing many 
lines that are the same size, the WinBench line tests draw a 
distribution of lines that have the same average, minimum, and 
maximum sizes as the lines the profiled applications used. 

Actions modeled by the graphics tests

The WinBench graphics tests mimic the following attributes of the 
way profiled applications used the GDI:

· The types of GDI operations. 

· The types of GDI objects used (pen and brush styles). 

· The number of pixels drawn using each GDI operation or 
special case of a GDI operation (i.e., squares are a special case 
of rectangles). 

· The number of pixels drawn using each type of GDI object. 

· The average parameter values for each GDI operation. 

· The relative number of painting and non-painting operations 



(i.e., operations that involve changing a pen or a brush). 

· The time-varying nature of parameters and operations. 

The GDI operations that WinBench tests are those that 
software device drivers or graphics hardware can implement or 
accelerate. WinBench minimizes calls to non-drawing routines. 
For example, WinBench does not include the GDI 
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operation SetBkColor in its tests because this operation just 
retrieves a background color. The WinBench graphics tests 
primarily use operations that paint pixels on the screen, such as the 
Line To and Polygon operations.

Determining the GDI calls

The Graphics WinMark tests exercise all the Graphics Device 
Interface (GDI) calls the profiled applications used. These calls all 
involve painting activities, such as displaying text, moving pixels 
from memory to screen and screen to screen, and drawing 
geometric objects (lines, circles, arcs, and so on).

You have three general options for executing the GDI calls 
included in the WinBench tests. You can execute:

· The Graphics WinMark suite. This test suite mixes GDI calls 
to mimic the frequency of those calls in the applications. The 
Combined GWM Tests that make up this suite also attempt to 
match the application's typical parameters for those calls. In 
addition, WinBench assigns weights to the Combined GWM 
Tests based on data from the application profiles.

· The Individual Combined GWM Tests. You can run each of 
the seven Combined GWM Tests that make up the Graphics 
WinMark separately. Each tests contains a mix of GDI calls 
that mimic how frequently actual applications make the 
different GDI calls. Thus, in these tests, some GDI calls occur 
a great deal while others only occur a few times. 

· Individual graphics tests. WinBench includes a large number 



of individual tests that exercise almost all the GDI calls 
available in Windows. The built-in graphics suites (GWM 
Tests and GDI Tests) also exercise these calls. See Appendix A 
for information on these tests.

Graphics test parameters

Each WinBench graphics test uses enough parameters to let it 
model the costs typically associated with that GDI operation. The 
tests exercise GDI operations the way the profiled applications do. 

WinBench bases the parameters it uses with each operation on the 
parameters the profiled applications used. These profiles contained 
the parameters different operations used and the distribution of 
those parameters (the average, minimum, and maximum values an 
operation, such as drawing horizontal lines, used). 

For example, a WinBench test that uses rectangles contains 
parameter descriptions for the average height and area of the 
rectangle. This test creates random rectangles that meet those 
height and area descriptions. This approach ensures that both 
WinBench and the profiled applications:

· Execute the same number of rectangle operations for a given 
number of pixels drawn.

· Draw the same number of scan lines (i.e., horizontal lines) 
when filling the rectangles for a given number of pixels drawn. 

Most, if not all, algorithms for drawing rectangles incur some 
cost for each rectangle, for each scan line drawn, and for each 
pixel drawn. WinBench incurs the same cost as the 
applications.
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WinBench uses this approach for all the graphics tests. 

Using weighted harmonic means

WinBench measures your PC's graphics performance based on the 
time it takes your PC to run a set of tests. The Graphics WinMark 
score that WinBench generates is a weighted harmonic mean of the 
pixel rates of the seven Combined GWM Tests.

A harmonic mean is a way of combining several test scores to 
create a single, representative score for that test group. By using a 
harmonic mean, you can account for more than just the speed of an 
activity when generating a score for that activity. For example, 
suppose you are comparing two machines to see how fast they 
draw a workload consisting of 1000 lines and 2000 rectangles. 
Machine A draws lines five times faster than Machine B. Machine 
B, however, draws rectangles five times faster than Machine A. 
Using a harmonic mean lets you account for the fact that more 
rectangles must be drawn, and therefore the result can show that 
Machine B is faster than Machine A. 

In determining the harmonic mean for the Graphics WinMark 
score, WinBench places weights on the individual tests to indicate 
how important that test's operation is in terms of operations actual 
applications perform. An operation that an application performs 
frequently has a higher weight than an operation that an application 
performs less frequently. For example, scrolling is more important 
to word-processing programs than drawing arcs. To mimic 
word-processing programs, you might want the BitBlt tests, which 
move blocks of information, to have a higher weight than the arc 



tests.

To determine the weighted harmonic mean of these seven tests, 
WinBench computes the average pixel rate it would achieve if it 
drew a number of pixels (the weight) from each combined test in 
succession. The weights WinBench uses reflect the relative 
frequency of the sets of operations in each combined test as seen in 
the profiled applications.

The Disk Mix

As with the graphics tests, the disk tests are the result of extensive 
profiling of popular applications to determine the disk operations 
these applications perform. The goal behind the Disk WinMark test 
is to enable you to measure the speed of your disk subsystem in a 
realistic way. The profiling tools captured the entire disk behavior 
of applications. The research data indicates how applications 
distribute disk operations, not just what the operations are. This 
approach lets the Disk Mix Test synthetically mimic the disk 
actions of applications.

How the individual disk tests work

The purpose behind the individual disk tests is to let you measure 
low-level disk operations. These tests use different block sizes and 
focus on moving data between the disk and memory. The block 
sizes the tests use are 200 bytes, 512 bytes, 2048 bytes, and 4096 
bytes. You can move each size block of data using sequential or 
random read and write tests.

These tests help you measure your disk's throughput capability. 
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What the tests don't do

The WinBench tests are subsystem-level tests. They let you 
measure the performance of your graphics and disk subsystems. 
These tests do not provide you with an overall measure of how 
well your PC performs when running Windows applications 
because they stress only those two subsystems.

If you want to get an overall rating of your PC's performance as it 
executes Windows-based applications, run Winstone 94. 

Also, because the tests in the Graphics and Disk WinMarks mimic 
leading applications performing common tasks, those tests may not 
completely reflect the applications you normally use. For example, 
an application package that has specialized users, such as architects 
who use CAD programs, is not as well represented in the Graphics 
WinMark and the Disk WinMark as more commonly used 
applications, such as spreadsheet programs. WinBench does, 
however, let you create your own suites of tests that more 
accurately reflect the operations your applications commonly 
perform. 

Keep in mind that you cannot change components in your graphics 
or disk subsystems to get a better corresponding WinMark score 
and expect to see the same amount of improvement in your 
applications. For example, if your Graphics WinMark score is 10 
percent faster with one video board than with another, you will not 
usually get a 10 percent improvement in the overall speed of your 
application by switching video boards. The amount of 
improvement you will see if you change video boards will depend 



on how much time your application spends doing graphics and text 
operations. 

In addition, WinBench does not currently measure the speed of 
clipping and some functions that display to off-screen memory.
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What's next

This chapter described the design process used to create 
WinBench. It told you:

· The process used to select applications for profiling.

· How the tests use distribution of parameters.

· The actions that the graphics tests model.

· How the Graphics WinMark uses a weighted harmonic mean.

· What went into designing the Disk Mix.

· What WinBench's tests don't do.

For more information about:

· Comparing your PC's test results to test results from other PCs, 
see 
Chapter 8.

In addition, Appendix A lists all the tests in WinBench, Appendix 
B provides troubleshooting tips if you encounter a problem, and 
Appendix C tells you how you can contact ZDBOp.

End of Chapter





Chapter 8
How Does Your PC 
Compare

This chapter talks about ways you can use the WinBench scores to 
compare your PC to others. It includes information on where you 
can find published results you can use in comparing your PC's 
WinBench results to the results of other PCs.

Checking published results

The best way to determine how your PC compares to other PCs is 
to check published benchmark results. Many Ziff-Davis 
publications, such as 
PC Magazineâ, provide PC reviews that include WinBench 
performance scores. You can find published results in 
"First Looksä" articles, comparative reviews, and other stories in 
such Ziff-Davis publications as:

United States

Computer Shopperâ



PC/Computingâ
PC Magazineâ
PC Weekâ
Windowsä Sourcesä

United Kingdom

PC Directä
PC Magazineä

France

PC Directâ
PC Expertâ

Germany

PC Direktä
PC Professionellä
Windowsä Activä

You can also find articles about Ziff-Davis benchmarks on 
Computer Library's Computer Selectâ CD-ROM, a database of 
computer-related product information. In addition, you can find 
information on WinBench in the 
PC MagNet, PC Week, and ZDBOp forums on ZiffNet (see 
Appendix C for information about ZiffNet).



Using multiple PCs 

If you have access to other PCs within your organization, you can 
run WinBench on them and use their results as comparison points. 
You can move the results files for all the PCs onto one PC by 
copying the files onto a diskette and then loading them onto that 
PC. If the PCs are on a network, you can copy these files across the 
network. 

NOTE:If you are comparing WinBench results on different PCs, 
make sure the PCs used the standard system setups. 
Otherwise, your comparisons may not be meaningful.
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Why results differ

If you run the same WinBench test on your system repeatedly, you 
will get the same score almost all the time. The repeatability for 
the WinBench scores is within about 99 percent. To achieve this, 
you need to run WinBench in batch mode from the DOS command 
line and degframent your disk. If you modify any of your system 
components, you probably will see a difference in results. 

In general, the scores reflect the rates at which your PC's graphics 
subsystem handles graphics operations and its disk subsystem 
handles disk operations. 

Chapters 5 and 6 contain information on what can affect your 
WinBench test results. For tips on how to get the best WinBench 
scores on your PC, see the section "Tips for running WinBench" in 
Chapter 3.

Which differences matter to you

Sometimes the components that make up one subsystem are simply 
faster than the components that make up another. Before you go 
looking for faster subsystems, though, you may want to consider 
such questions as:

· What is appropriate for your system and the work you do? If 
most of your work does not rely heavily on a specific 
subsystem, then you probably should not worry about the speed 
differences.



· How much of a difference will a particular subsystem really 
make to your overall application performance? WinBench tests 
the speed of the subsystems. Even if you change a component 
of one of the subsystems and get a faster WinBench score, you 
will not usually get the same of amount of improvement in the 
speed of an application. This is because WinBench only 
measures the speed of the graphics, text, and disk operations, 
not all the operations an application performs. Thus, the 
improvement you are likely to see if, for example, you switch 
to a faster graphics subsystem will depend on how much time 
the application performs graphics and text operations. If the 
application does not spend much time doing these operations, 
then you are not likely to see a large improvement. 



170 · Technical Support Appendix C

µ §

Publishing WinBench results

The WinBench license agreement requires that you include certain 
information about your PC any time you publish WinBench 
results. The license agreement at the front of this manual and in the 
README.WRI file states exactly what information you must 
include when you publish WinBench results. You can also find 
much of this information in the Disclosure window. In addition, an 
example of the information you must include is in Chapter 6.

Using WinBench with other benchmarks

To get a total picture of your PC's performance, use WinBench 
with other 
Ziff-Davis benchmarks. Running WinBench, Winstone 94, and 
PC Bench provides you with a more complete picture of your PC's 
performance.

Winstone 94 provides an overall rating of how your system 
performs as it runs actual Windows-based applications. 

PC Bench provides a processor test that lets you measure how well 
your processor performs.

For information on getting copies of these other benchmarks, see 
Appendix C.



What's next

This chapter provided information on how you can compare your 
PC's results to results from other PCs. It told you:

· Where to find published reports on WinBench.

· How you can use multiple PCs to compare results.

· What you must include if you publish WinBench results.
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In the rest of the manual, you can:

· Learn more about all the WinBench tests by reading Appendix 
A.

· Discover some troubleshooting tips in Appendix B.

· Learn how to request benchmarks and order printed manuals as 
well as how to contact ZDBOp by reading Appendix C.

End of Chapter



Appendix A
A Closer Look at the Tests

This appendix lists all the tests that come with WinBench. You can 
run these tests separately or you can combine them to create 
custom test suites. 

The names of all the WinBench tests

WinBench offers both more than 200 individual tests and 
built-in test suites. The built-in suites combine useful 
subsets of individual WinBench tests or other test suites. 
The built-in suites are:

· Graphics WinMark. Contains the Combined GWM 
Tests (1-7).

· Disk WinMark. Contains the Disk Mix test.

· All WinMarks. Contains the Graphics WinMark suite 
and the Disk WinMark suite.

· All Tests. Contains every test available in WinBench.

· Disk Tests. Contains the Disk Mix test and all the 
sequential and random read and write disk tests.

· GDI Tests. Contains all the individual tests that perform 
GDI operations that the profiled applications did not 
use or that are not based on the profiled applications.

· GWM Tests. Contains all the individual operation tests 



that are included in the seven Combined GWM Tests 
that comprise the Graphics WinMark. (Unlike the 
Combined GWM Tests, this test suite does not intermix 
the operations to reflect profiling information.)

· USER Tests. Contains all the individual tests that 
exercise Windows USER calls.

For more information on these test suites and the tests they 
use, see the sections "WinBench's graphics tests," 
"WinBench's disk tests," and "Other test suites" later in this 
chapter.

All the more than 200 tests you can execute from 
WinBench appear alphabetically in the list of tests. This list 
includes all the individual tests in WinBench. 

In general, the graphics test names consist of the GDI 
operation name followed by qualifiers that distinguish 
special cases of the GDI operations or specify something 
about the parameter distributions. Some points to keep in 
mind as you look at the different test names are:

· The term "aligned" means that the horizontal start and 
end points of a rectangle are multiples of 8 pixels from 
the left side of the screen. As a result, the width of the 
rectangle itself is a multiple of 8 pixels. Some hardware 
handles operations that occur on aligned rectangles 
more efficiently than operations that manipulate 
unaligned rectangles. 

· The term "unaligned" means the objects in question had 
no forced starting or ending points.

· The term "rounded" in a test using a square or a 
rectangle means that the corners have been rounded.

· The term "other" indicates that the test uses several 
common operations.

· The term "mono" in a test name indicates the memory 



bitmap used in the test is a monochrome image instead 
of a color image.

· In the text tests, WinBench displays the name of the 
test, the font name, and height of the font in pixels. If 
there is another number, it is the angle of the text. For 
example, "TextOut, Arial 10, 45" displays text at a 45 
degree angle in Arial font that is 10 pixels high. 

· The term "System" is the name of a font. For example, 
the test "GWM/TextOut, System" is an individual 
GWM Tests suite that displays text in System font.

· All the test names that begin "GWM/" are part of the 
GWM Tests suite. For example, GWM/Line, Diagonal 
is an individual GWM Test that draws diagonal lines 
using parameters (such as line length) based on 
parameters found in the application profiles.

· In the GWM/ExtTextOut, Square and the 
GWM/ExtTextOut, Rectangle tests, WinBench does not 
write any text. It uses this call to draw a rectangle with 
solid colors (i.e., no dithering). Profiling indicated that 
many applications use this method for drawing 
rectangles.

· Tests involving squares are actually rectangle operation 
tests that WinBench forced to use squares.

· BitBlt test names that include the letters "MS" move 
images from memory to the screen. BitBlt test names 
that include the letters "SM" move images from the 
screen to memory. BitBlt test names that include the 
letters "SS" move the images from screen to screen.

· In the disk tests, the number of bytes indicates the size 
of the block that the test uses. For example, "Disk, 
Write, Sequential, 512 bytes" writes 512 bytes of data 
sequentially.
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· The term "Few-sides" indicates that a region has fewer 
than 16 sides while "HVD" indicates that the region 
contains horizontal (H), vertical (V), and diagonal (D) 
sides. For example, in the test "PaintRgn, Few-sides, 
HV" WinBench paints a region that has fewer than 16 
sides, which are both horizontal and vertical. 

Arc, Circular, Complete 
Arc, Circular, Partial 
Arc, Elliptical, Complete 
Arc, Elliptical, Partial 
BitBltMonoMS, Other, Aligned 
BitBltMonoMS, Other, Unaligned 
BitBltMonoMS, PATPAINT, Aligned 
BitBltMonoMS, PATPAINT, Unaligned 
BitBltMonoMS, SRCCOPY, Aligned 
BitBltMonoMS, SRCCOPY, Unaligned 
BitBltMonoMS, SRCINVERT, Aligned 
BitBltMonoMS, SRCINVERT, Unaligned 
BitBltMonoSM, Other, Aligned 
BitBltMonoSM, Other, Unaligned 
BitBltMonoSM, PATPAINT, Aligned 
BitBltMonoSM, PATPAINT, Unaligned 
BitBltMonoSM, SRCCOPY, Aligned 
BitBltMonoSM, SRCCOPY, Unaligned 
BitBltMonoSM, SRCINVERT, Aligned 
BitBltMonoSM, SRCINVERT, Unaligned 
BitBltMS, Other, Aligned 
BitBltMS, Other, Unaligned 
BitBltMS, PATPAINT, Aligned 
BitBltMS, PATPAINT, Unaligned 
BitBltMS, SRCCOPY, Aligned 
BitBltMS, SRCCOPY, Unaligned 
BitBltMS, SRCINVERT, Aligned 
BitBltMS, SRCINVERT, Unaligned 



BitBltSM, Other, Aligned 
BitBltSM, Other, Unaligned 
BitBltSM, PATPAINT, Aligned 
BitBltSM, PATPAINT, Unaligned 
BitBltSM, SRCCOPY, Aligned 
BitBltSM, SRCCOPY, Unaligned 
BitBltSM, SRCINVERT, Aligned 
BitBltSM, SRCINVERT, Unaligned 
BitBltSS, Other, Aligned 
BitBltSS, Other, Unaligned 
BitBltSS, PATPAINT, Aligned 
BitBltSS, PATPAINT, Unaligned 
BitBltSS, SRCCOPY, Aligned 
BitBltSS, SRCCOPY, Unaligned 
BitBltSS, SRCINVERT, Aligned 
BitBltSS, SRCINVERT, Unaligned 
BltDIBits, 1 bpp, SRCCOPY, Unaligned 
BltDIBits, 24 bpp, SRCCOPY, Unaligned 
BltDIBits, 4 bpp, SRCCOPY, Unaligned 
BltDIBits, 8 bpp, SRCCOPY, Unaligned 
Chord, Circular 
Chord, Elliptical 
Circle 
Combined GWM1 
Combined GWM2 
Combined GWM3 
Combined GWM4 
Combined GWM5 
Combined GWM6 
Combined GWM7 
Disk, Mix 
Disk, Read, Random, 200 bytes 
Disk, Read, Random, 2048 bytes 
Disk, Read, Random, 4096 bytes 
Disk, Read, Random, 512 bytes 
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Disk, Read, Sequential, 200 bytes 
Disk, Read, Sequential, 2048 bytes 
Disk, Read, Sequential, 4096 bytes 
Disk, Read, Sequential, 512 bytes 
Disk, Write, Random, 200 bytes 
Disk, Write, Random, 2048 bytes 
Disk, Write, Random, 4096 bytes 
Disk, Write, Random, 512 bytes 
Disk, Write, Sequential, 200 bytes 
Disk, Write, Sequential, 2048 bytes 
Disk, Write, Sequential, 4096 bytes 
Disk, Write, Sequential, 512 bytes 
DrawFocusRect 
DrawIcon 
DrawText, MS Sans Serif 11 
DrawText, MS Sans Serif 13 
DrawText, MS Sans Serif Bold 11 
DrawText, System 
DrawText, Times New Roman 11 
DrawText, Times New Roman 13 
DrawText, Times New Roman 16 
Ellipse 
ExtFloodFill, Border 
ExtFloodFill, Surface 
FastWindowFrame 
FillRect 
FillRect, Square 
FillRgn, Few-sides, HV 
FloodFill 
FrameRect 
FrameRect, Square 
FrameRgn, Few-sides, HV 
GetNearestColor 
GrayString, MS Sans Serif 11 



GrayString, MS Sans Serif 13 
GrayString, MS Sans Serif Bold 11 
GrayString, System 
GrayString, Times New Roman 11 
GrayString, Times New Roman 13 
GrayString, Times New Roman 16 
GWM/BitBltMonoMS, Other, Unaligned 
GWM/BitBltMonoMS, SRCAND, Aligned 
GWM/BitBltMonoMS, SRCCOPY, Aligned 
GWM/BitBltMonoMS, SRCCOPY, Unaligned 
GWM/BitBltMonoSM, SRCCOPY, Aligned 
GWM/BitBltMonoSM, SRCCOPY, Unaligned 
GWM/BitBltMS, Other, Aligned 
GWM/BitBltMS, Other, Unaligned 
GWM/BitBltMS, SRCCOPY, Aligned 
GWM/BitBltMS, SRCCOPY, Unaligned 
GWM/BitBltSM, SRCCOPY, Aligned 
GWM/BitBltSM, SRCCOPY, Unaligned 
GWM/BitBltSS, SRCCOPY, Aligned 
GWM/BitBltSS, SRCCOPY, Unaligned 
GWM/Ellipse 
GWM/ExtTextOut, MS Sans Serif 11 
GWM/ExtTextOut, MS Sans Serif 13 
GWM/ExtTextOut, MS Sans Serif Bold 11 
GWM/ExtTextOut, Rectangle 
GWM/ExtTextOut, Square 
GWM/ExtTextOut, System 
GWM/ExtTextOut, Times New Roman 11 
GWM/ExtTextOut, Times New Roman 13 
GWM/ExtTextOut, Times New Roman 16 
GWM/FillRgn, Rectangular 
GWM/InvertRgn, Polygonal 
GWM/InvertRgn, Rectangular 
GWM/Line, Diagonal 
GWM/Line, Horizontal 
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GWM/Line, Vertical 
GWM/PaintRgn, Polygonal 
GWM/PaintRgn, Rectangular 
GWM/PatBlt, BLACKNESS, Unaligned 
GWM/PatBlt, DSTINVERT, Aligned 
GWM/PatBlt, DSTINVERT, Unaligned 
GWM/PatBlt, Other, Unaligned 
GWM/PatBlt, PATCOPY, Aligned 
GWM/PatBlt, PATCOPY, Unaligned 
GWM/PatBlt, PATINVERT, Aligned 
GWM/PatBlt, PATINVERT, Unaligned 
GWM/PatBlt, ROP(0A), Unaligned 
GWM/PatBlt, ROP(A0), Unaligned 
GWM/PatBlt, ROP(A5), Unaligned 
GWM/PatBlt, WHITENESS, Aligned 
GWM/PatBlt, WHITENESS, Unaligned 
GWM/Pie, Elliptical 
GWM/Polygon, Few-sides 
GWM/Polygon, Many-sides 
GWM/PolyLine 
GWM/PolyPolygon 
GWM/Rectangle 
GWM/Rectangle, Rounded 
GWM/SetDIBitsToDevice, 4 bpp, Unaligned 
GWM/Square 
GWM/Square, Rounded 
GWM/StretchBltMonoMS, SRCAND, Unaligned 
GWM/StretchBltMonoMS, SRCPAINT, Unaligned 
GWM/StretchBltMS, SRCCOPY, Unaligned 
GWM/StretchDIBits, 4 bpp, SRCCOPY, Unaligned 
GWM/TextOut, MS Sans Serif 11 
GWM/TextOut, MS Sans Serif 13 
GWM/TextOut, MS Sans Serif Bold 11 
GWM/TextOut, System 



GWM/TextOut, Times New Roman 11 
GWM/TextOut, Times New Roman 13 
GWM/TextOut, Times New Roman 16 
InvertRect 
InvertRect, Square 
InvertRgn, Few-sides, HV 
Line, Diagonal 
Line, Horizontal 
Line, Vertical 
MoveTo 
MoveToEx 
PaintRgn, Few-sides, HV 
PaintRgn, Few-sides, HVD 
PaintRgn, Rectangular 
PatBlt, BLACKNESS, Aligned 
PatBlt, BLACKNESS, Unaligned 
PatBlt, DSTINVERT, Aligned 
PatBlt, DSTINVERT, Unaligned 
PatBlt, PATCOPY, Aligned 
PatBlt, PATCOPY, Unaligned 
PatBlt, PATINVERT, Aligned 
PatBlt, PATINVERT, Unaligned 
PatBlt, WHITENESS, Aligned 
PatBlt, WHITENESS, Unaligned 
Pie, Circular 
Pie, Elliptical 
Pixel, Get 
Pixel, Set 
Polygon, Few-sides 
Polygon, Many-sides 
Polygon, Trapezoid 
Polygon, Triangle 
PolyLine 
PolyPolygon 
Rectangle 
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Rectangle, Rounded 
ScrollDC 
SetDIBitsBlt, 1 bpp, Unaligned 
SetDIBitsBlt, 24 bpp, Unaligned 
SetDIBitsBlt, 4 bpp, Unaligned 
SetDIBitsBlt, 8 bpp, Unaligned 
SetDIBitsToDevice, 1 bpp, Unaligned 
SetDIBitsToDevice, 24 bpp, Unaligned 
SetDIBitsToDevice, 4 bpp, Unaligned 
SetDIBitsToDevice, 8 bpp, Unaligned 
Square 
Square, Rounded 
StretchBltMonoMS, Other, Aligned 
StretchBltMonoMS, Other, Unaligned 
StretchBltMonoSM, Other, Aligned 
StretchBltMonoSM, Other, Unaligned 
StretchBltMS, Other, Aligned 
StretchBltMS, Other, Unaligned 
StretchBltSM, Other, Aligned 
StretchBltSM, Other, Unaligned 
StretchBltSS, Other, Aligned 
StretchBltSS, Other, Unaligned 
StretchDIBits, 1 bpp, SRCCOPY, Unaligned 
StretchDIBits, 24 bpp, SRCCOPY, Unaligned
StretchDIBits, 4 bpp, SRCCOPY, Unaligned 
StretchDIBits, 8 bpp, SRCCOPY, Unaligned 
TabbedTextOut, MS Sans Serif 11 
TabbedTextOut, MS Sans Serif 13 
TabbedTextOut, MS Sans Serif Bold 11 
TabbedTextOut, System 
TabbedTextOut, Times New Roman 11 
TabbedTextOut, Times New Roman 13 
TabbedTextOut, Times New Roman 16 
TextOut, Arial 10 



TextOut, Arial 10, 45 
TextOut, Arial 10, 90 

WinBench's graphics tests

WinBench contains graphics tests that let you exercise all 
the GDI drawing operations that applications used during 
the profiled tasks. You can run four built-in test suites that 
focus on WinBench's graphics tests. These suites are the 
Graphics WinMark, the GWM Tests, the GDI Tests, and 
the USER Tests. These test suites each combine different 
graphics tests in ways that let you measure different aspects 
of your graphics subsystem.

WinBench provides two basic types of graphics test suites:

· Suites that reflect how the profiled applications used 
operations. These suites vary the test parameters they 
use in the same ways the profiled applications varied 
those parameters.

· Suites that test operations the profiled applications did 
not use. These tests are useful for comparing similar 
operations and evaluating the speed of the operations 
the profiled applications did not use. 

The first type of test suite lets you perform operations using 
parameters that are based on parameters the profiled 
applications used. With these tests, you can see how your 
PC handles operations that applications perform. However, 
because the parameters differ, you cannot compare scores 
of even similar-looking tests, such as the GWM/Line, 
Diagonal and the GWM/Line, Vertical tests.

Both the Graphics WinMark suite and the GWM Tests 
suite use information based on the application profiles. The 
seven Combined GWM Tests that make up the Graphics 
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WinMark execute mixes of weighted operations that reflect 
the way applications use the operations. In addition, 
WinBench repeatedly changes the GDI objects the tests use 
as they execute. For example, WinBench frequently 
changes the color and type of pen it uses to draw lines 
during the tests. The rate at which WinBench makes these 
changes reflects information from the application profiles.

The tests in the GWM Tests suite do not mix the operations 
or use weights. They do, however, include parameters for 
the tests that reflect the profiling information. Thus, you 
cannot compare  one individual test result against 
another one. 

The second type of suite lets you directly compare different 
operations. The GDI Tests suite contains multiple 
operations that use essentially the same distribution of 
parameters. While these suites do not reflect how the 
profiled applications used the operations, they do provide a 
reasonable basis for comparing the results of different 
operations, such as the Line, Diagonal and Line, Vertical 
tests. 

The next sections provide more information on the different 
graphics tests.

The Graphics WinMark operations

The Graphics WinMark test consists of 66 different tests of 
Windows graphic functions divided among the seven 
Combined GWM Tests (i.e., Combined GWM1 Test 
through Combined GWM7 Test). Each of the Combined 
GWM Tests mixes together a subset of those Graphics 
Device Interface (GDI) functions so the GWM tests don't 
repeat the same graphics function over and over. The score 



for the Graphics WinMark is a weighted harmonic mean of 
the seven Combined GWM scores. 

The tests the Combined GWM Tests mix together are 
actually tests that the GWM Tests suite uses. The 
differences between the Combined GWM Tests and the 
GWM Tests are:

· Each Combined GWM Test is a single test that mixes 
different Windows graphics functions. 

The GWM Tests is a test suite that executes a single 
test for each graphics function.

· The Combined GWM Tests reflect information 
received from profiling leading Windows applications. 
Each Combined GWM Tests varies how often a 
graphics operation occurs in the test mix to reflect how 
often the operation occurred in the profiled 
applications. 

The GWM Tests suite does not weight the operations or 
vary their frequency. It simply executes these 
operations one at time. Thus, this suite does not reflect 
how the profiled applications actually used these GDI 
operations.

The groupings of the graphics operations in the different 
Combined GWM Tests reflect the frequency of these 
operations in the profiled applications. 

The Graphics WinMark test uses the seven Combined 
GWM Tests instead of the 66 individual tests found in the 
GWM Tests suite to provide a more accurate reflection of 
the way applications perform. As a rule, applications do not 
perform the same operation over and over again; instead, 
applications intermix operations.

WinBench assigns a weight to the individual graphics 
operations. That weight is based on the number of pixels 
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that each GDI operation draws as shown by the application 
profiles. Each Combined GWM Test mixes the individual 
GWM Tests together so that the combined test maintains 
the correct relative number of pixels drawn for each 
operation (i.e., it maintains the correct weight for each 
operation). WinBench bases the weight for each Combined 
GWM Test on the number of pixels drawn by the subset of 
operations in that test relative to the number of pixels 
drawn by the subset of operations in the next combined 
test. For example, consider the following two hypothetical 
Combined GWM tests:

Combined GWM1
Test A (pixel weight determined by profiling 
applications=Na)

Test B (pixel weight determined by 
profiling applications=Nb)

Test C (pixel weight determined by profiling 
applications=Nc)

Combined GWM2
Test D (pixel weight determined by profiling 
applications=Nd)

Test E (pixel weight determined by profiling 
applications=Ne)

Test F (pixel weight determined by profiling 
applications=Nf)

Test G (pixel weight determined by profiling 
applicationst=Ng)

Combined GWM1 is a mix of operations for Tests A, B, 
and C. For every Na pixels WinBench draws for the Test A 

operation, WinBench also draws Nb pixels for the Test B 



operations and Nc pixels for these Test C operations.

WinBench executes the mixed operation tests in Combined 
GWM1 and determines the test score by dividing the time it 
took your PC to perform this test by the number of pixels 
the test painted. 

WinBench follows the same process to determine the score 
for Combined GWM2. 

WinBench then determines the weight for the Combined 
GWM1 score based on the profiled pixel weight (Na + Nb 

+ Nc) that subset of operations drew as compared to the 

profiled pixel weight (Nd + Ne + Nf + Ng) of the 

operations in Combined GWM2. WinBench does this for 
each Combined GWM Test. WinBench averages the seven 
weighted scores using a harmonic mean to determine the 
Graphics WinMark score.

If WinBench put all the operations into one combined test 
mix, the weights on the most important operations would 
be orders of magnitude higher than the weights on the least 
important operations. Thus, WinBench would need to 
execute a very large number of operations with high 
weights for each operation with low weights. As a result, 
WinBench would spend inordinate amounts of time 
executing the operations with high weights so it could get a 
representative sample of the operations with low weights. 
WinBench avoids this problem by using seven tests, each 
of which combines individual operations that have similar 
weights.

In general, the order of the Combined GWM tests indicates 
the importance of the operations. Operations with the 
lowest weights appear in Combined GWM1, while the 
operations with the highest weights appear in Combined 
GWM7. 
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The time it takes to run the Graphics WinMark suite varies 
based on your PC and how it is set up. As data points for 
comparison purposes, this suite took 58 minutes to run on a 
386/20 with a Video 7 VRAM adapter and 7 minutes to run 
on a COMPAQ DESKPRO 66M with a QVision video 
adapter.

The following list displays all the individual GWM Tests 
that make up the each of the Combined GWM Tests. 

Combined GWM1

GWM/FillRgn, Rectangular

NOTE:The Combined GWM1 test only contains one 
operation for historical reasons.

Combined GWM2

GWM/Ellipse
GWM/PatBlt, ROP(0A), Unaligned 
GWM/StretchDIBits, 4 bpp, SRCCOPY, Unaligned

Combined GWM3

GWM/PatBlt, PATINVERT, Aligned
GWM/Pie, Elliptical
GWM/Rectangle, Rounded
GWM/Square, Rounded
GWM/PatBlt, Other, Unaligned 
GWM/BitBltMS, Other, Aligned 
GWM/BitBltSM, SRCCOPY, Aligned 
GWM/BitBltMonoSM, SRCCOPY, Unaligned 
GWM/BitBltMonoSM, SRCCOPY, Aligned 
GWM/BitBltMonoMS, SRCAND, Aligned 
GWM/PaintRgn, Rectangular

Combined GWM4

GWM/PolyPolygon



GWM/PatBlt, ROP(A0), Unaligned 
GWM/PatBlt, DSTINVERT, Aligned 
GWM/BitBltSS, SRCCOPY, Unaligned 
GWM/BitBltSM, SRCCOPY, Unaligned 
GWM/BitBltMonoMS, SRCCOPY, Aligned 
GWM/StretchBltMS, SRCCOPY, Unaligned 
GWM/SetDIBitsToDevice, 4 bpp, Unaligned 
GWM/InvertRgn, Rectangular 
GWM/PaintRgn, Polygonal

Combined GWM5

GWM/Polygon, Many-sides
GWM/Square
GWM/ExtTextOut, Square

GWM/PatBlt, WHITENESS, Unaligned 
GWM/PatBlt, WHITENESS, Aligned 
GWM/BitBltSS, SRCCOPY, Aligned 
GWM/BitBltMS, SRCCOPY, Aligned 
GWM/BitBltMS, Other, Unaligned 
GWM/StretchBltMonoMS, SRCAND, Unaligned 
GWM/StretchBltMonoMS, SRCPAINT, Unaligned 
GWM/InvertRgn, Polygonal
GWM/TextOut, Times New Roman 16 
GWM/TextOut, System
GWM/TextOut, Times New Roman 11 
GWM/TextOut, MS Sans Serif Bold 11 
GWM/TextOut, MS Sans Serif 11

Combined GWM6

GWM/Polygon, Few-sides
GWM/PolyLine
GWM/Line, Diagonal
GWM/Rectangle
GWM/PatBlt, DSTINVERT, Unaligned 
GWM/PatBlt, BLACKNESS, Unaligned 
GWM/PatBlt, ROP(A5), Unaligned 
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GWM/PatBlt, PATCOPY, Aligned 
GWM/BitBltMS, SRCCOPY, Unaligned 
GWM/BitBltMonoMS, SRCCOPY, Unaligned 
GWM/BitBltMonoMS, Other, Unaligned 
GWM/ExtTextOut, MS Sans Serif 13 
GWM/ExtTextOut, Times New Roman 16 
GWM/ExtTextOut, System
GWM/ExtTextOut, Times New Roman 11 
GWM/ExtTextOut, MS Sans Serif Bold 11 
GWM/ExtTextOut, MS Sans Serif 11 
GWM/TextOut, Times New Roman 13 
GWM/TextOut, MS Sans Serif 13

Combined GWM7

GWM/Line, Horizontal
GWM/Line, Vertical
GWM/ExtTextOut, Rectangle
GWM/PatBlt, PATINVERT, Unaligned
GWM/PatBlt, PATCOPY, Unaligned
GWM/ExtTextOut, Times New Roman 13

The GWM Tests

The GWM Tests is a test suite that contains 66 tests, each 
of which performs a single GDI operation. 

These individual tests are the same tests WinBench 
combines based on profiling data to create the Combined 
GWM tests that make up the Graphics WinMark. The 
difference between the GWM Tests suite and the Combined 
GWM Tests is that the GWM Tests perform the operations 
one after the other while each Combined GWM Test 
intermingles the operations it contains. Thus, you cannot 
use the GWM Tests to compute the Graphics WinMark; 



however, you can use the GWM Tests to help determine 
why different PCs have different Graphics WinMark 
scores. For example, if you run the GWM Tests on each of 
the PCs, you can see which operations execute faster on 
each of those PCs.

The GWM Tests suite includes each of the graphics 
operations the profiled applications used. The parameter 
distributions for the individual GWM tests reflect 
information from the application profiles. 

The time it takes to run the GWM Tests suite varies based 
on your PC and how it is set up. As data points for 
comparison purposes, this suite took 52 minutes to run on a 
386/20 with a Video 7 VRAM adapter and 27 minutes to 
run on a COMPAQ DESKPRO 66M with a QVision video 
adapter.

The following list contains all the tests in the GWM Tests 
suite. These tests are sorted in ascending order according to 
pixel weight, starting with the test with the smallest pixel 
weight. 

NOTE:Pixel weight is based on the number of pixels drawn 
using the operations in the profiled applications.

GWM Tests

GWM/PatBlt, PATINVERT, Aligned
GWM/Square, Rounded

GWM/PatBlt, Other, Unaligned 
GWM/Rectangle, Rounded 
GWM/DrawFocusRect 
GWM/BitBltMonoSM, SRCCOPY, Unaligned 
GWM/BitBltMonoMS, SRCAND, Aligned 
GWM/StretchDIBits, 4 bpp, SRCCOPY, Unaligned 
GWM/BitBltMS, Other, Aligned
GWM/PolyLine
GWM/StretchBltMS, SRCCOPY, Unaligned 
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GWM/PatBlt, ROP(A0), Unaligned 
GWM/Ellipse
GWM/ExtTextOut, Square
GWM/Line, Diagonal
GWM/Square
GWM/Pie, Elliptical
GWM/PolyPolygon
GWM/BitBltMonoSM, SRCCOPY, Aligned 
GWM/PatBlt, ROP(A5), Unaligned 
GWM/PatBlt, DSTINVERT, Aligned 
GWM/BitBltSM, SRCCOPY, Unaligned 
GWM/StretchBltMonoMS, SRCAND, Unaligned 
GWM/StretchBltMonoMS, SRCPAINT, Unaligned 
GWM/BitBltMS, Other, Unaligned 
GWM/BitBltMonoMS, SRCCOPY, Aligned 
GWM/SetDIBitsToDevice, 4 bpp, Unaligned 
GWM/PatBlt, ROP(0A), Unaligned 
GWM/Line, Vertical
GWM/Polygon, Many-sides
GWM/TextOut, Times New Roman 11 
GWM/TextOut, MS Sans Serif Bold 11 
GWM/BitBltSM, SRCCOPY, Aligned 
GWM/TextOut, MS Sans Serif 11 
GWM/TextOut, System
GWM/PatBlt, BLACKNESS, Unaligned 
GWM/PatBlt, PATINVERT, Unaligned 
GWM/TextOut, Times New Roman 16 
GWM/BitBltMonoMS, Other, Unaligned 
GWM/InvertRgn, Rectangular
GWM/TextOut, MS Sans Serif 13 
GWM/PaintRgn, Rectangular
GWM/FillRgn, Rectangular
GWM/PaintRgn, Polygonal
GWM/BitBltMS, SRCCOPY, Aligned 



GWM/Line, Horizontal
GWM/Polygon, Few-sides
GWM/TextOut, Times New Roman 13 
GWM/ExtTextOut, Times New Roman 11 
GWM/ExtTextOut, MS Sans Serif Bold 11 
GWM/ExtTextOut, MS Sans Serif 11 
GWM/ExtTextOut, System
GWM/PatBlt, DSTINVERT, Unaligned 
GWM/ExtTextOut, Times New Roman 16 
GWM/PatBlt, WHITENESS, Unaligned 
GWM/BitBltMS, SRCCOPY, Unaligned 
GWM/InvertRgn, Polygonal 
GWM/BitBltSS, SRCCOPY, Unaligned 
GWM/ExtTextOut, MS Sans Serif 13 
GWM/PatBlt, WHITENESS, Aligned 
GWM/BitBltMonoMS, SRCCOPY, Unaligned 
GWM/BitBltSS, SRCCOPY, Aligned 
GWM/ExtTextOut, Times New Roman 13 
GWM/ExtTextOut, Rectangle 
GWM/Rectangle
GWM/PatBlt, PATCOPY, Aligned 
GWM/PatBlt, PATCOPY, Unaligned

The GDI Tests

The GDI Tests suite contains tests of GDI drawing 
operations that the Graphics WinMark does not include. 
These tests use GDI operations that applications did not use 
in the profiled tasks.

The GDI Tests also include some of the same operations 
that the Combined GWM Tests and the GWM Tests suites 
perform, but the GDI Tests use essentially the same 
parameters for similar tests. These tests do not reflect 
application profiling. Thus, within the groups of tests that 
make up the GDI Tests, the parameter distributions for 
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similar tests (such as PatBlt, PATCOPY, Unaligned and 
PatBlt, PATCOPY, Aligned) are equivalent. This approach 
lets you measure the relative speeds of different operations. 
Thus you can compare 
screen-to-screen BitBlt tests with memory-to-screen and 
screen-to-memory BitBlt tests. You can compare StretchBlt 
tests with each other.

The time it takes to run the GDI Tests suite varies based on 
your PC and how it is set up. As data points for comparison 
purposes, this suite took 110 minutes to run on a 386/20 
with a Video 7 VRAM adapter and 55 minutes to run on a 
COMPAQ DESKPRO 66M with a QVision video adapter.

The GDI Tests actually consist of several different types of 
drawing operations. The following sections provide you 
with general information about the individual GDI Tests.

· Ellipse drawing tests. These tests draw GDI objects 
based on ellipses or parts of ellipses. For example, you 
can use the Arc tests to compare the difference in 
performance in graphics cards or drivers that have 
hardware or accelerated curve drawing operations and 
cards or drivers that do not.

Arc, Circular, Partial
Arc, Elliptical, Partial
Arc, Circular, Complete
Arc, Elliptical, Complete
Chord, Circular
Chord, Elliptical
Circle
Ellipse
Pie, Circular
Pie, Elliptical

· The PatBlt tests. These tests draw patterns on the 



screen using several different parameters. PatBlt is a 
simple version of a BitBlt; however, PatBlt just uses a 
brush to draw the objects. It does not have a source the 
way BitBlt does. PATCOPY is a relatively important 
operation that draws the background of Windows. The 
PATCOPY tests copy a pattern (brush) into a 
rectangular pattern on the screen. The PATINVERT 
tests copy inverted patterns. Inverting a pattern object 
means that all ones are replaced by zeroes and all 
zeroes are replaced by ones. The WHITENESS and 
BLACKNESS tests simply fill the background with 
white or black; PatBlt does not use a brush in these 
tests. Since the distribution of parameters in these tests 
is the same, you can compare the PatBlt tests results 
with each other.

PatBlt, PATCOPY, Aligned
PatBlt, PATINVERT, Aligned
PatBlt, DSTINVERT, Aligned
PatBlt, BLACKNESS, Aligned
PatBlt, WHITENESS, Aligned
PatBlt, PATCOPY, Unaligned
PatBlt, PATINVERT, Unaligned
PatBlt, DSTINVERT, Unaligned
PatBlt, BLACKNESS, Unaligned
PatBlt, WHITENESS, Unaligned

· Geometric figure drawing. This set of tests consists of 
geometric shapes you can draw with GDI calls. The 
Polygon tests exercise polygon filling operations that 
business graphics and drawing software often use. (To 
draw squares, WinBench uses the rectangle operation 
and forces the width to match the height.)

Polygon, Many-sides
Polygon, Few-sides
Polygon, Triangle
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Polygon, Trapezoid
PolyPolygon
Rectangle
Square
Rectangle, Rounded
Square, Rounded

· Text drawing operations. These tests use the Arial 
font to draw text at horizontal (0 degrees), vertical (90-
degree), and diagonal (45-degree) angles. (The 10 
indicates the font height in pixels). You can use these 
tests to see how much longer it takes to draw text at an 
angle.

TextOut, Arial 10
TextOut, Arial 10, 45
TextOut, Arial 10, 90

· BitBlt tests (screen to screen). These tests perform 
Boolean operations between a source and destination 
area of the screen. The source copy (SRCCOPY) 
operation is important because scrolling uses that 
operation. WinBench defines two rectangles of the 
same size on the screen, one as the source and the other 
as the destination. The tests then move blocks from the 
source to the destination. Since all BitBlt tests use the 
same parameter distributions, you can compare the 
results of these tests to the results of other BitBlt tests.

BitBltSS, SRCCOPY, Aligned
BitBltSS, SRCCOPY, Unaligned
BitBltSS, SRCINVERT, Aligned
BitBltSS, SRCINVERT, Unaligned
BitBltSS, PATPAINT, Aligned
BitBltSS, PATPAINT, Unaligned
BitBltSS, Other, Aligned



BitBltSS, Other, Unaligned

· BitBlt tests (memory to screen and screen to 
memory). These tests perform BitBlt operations 
between an off-screen bitmap and the screen. You can 
compare the results of these tests to the results of other 
BitBlt tests.

BitBltMS, SRCCOPY, Aligned
BitBltMS, SRCCOPY, Unaligned
BitBltMS, SRCINVERT, Aligned
BitBltMS, SRCINVERT, Unaligned
BitBltMS, PATPAINT, Aligned
BitBltMS, PATPAINT, Unaligned
BitBltMS, Other, Aligned
BitBltMS, Other, Unaligned
BitBltSM, SRCCOPY, Aligned
BitBltSM, SRCCOPY, Unaligned
BitBltSM, SRCINVERT, Aligned
BitBltSM, SRCINVERT, Unaligned
BitBltSM, PATPAINT, Aligned
BitBltSM, PATPAINT, Unaligned
BitBltSM, Other, Aligned
BitBltSM, Other, Unaligned
BitBltMonoMS, SRCCOPY, Aligned
BitBltMonoMS, SRCCOPY, Unaligned
BitBltMonoMS, SRCINVERT, Aligned
BitBltMonoMS, SRCINVERT, Unaligned
BitBltMonoMS, PATPAINT, Aligned
BitBltMonoMS, PATPAINT, Unaligned
BitBltMonoMS, Other, Aligned
BitBltMonoMS, Other, Unaligned
BitBltMonoSM, SRCCOPY, Aligned
BitBltMonoSM, SRCCOPY, Unaligned
BitBltMonoSM, SRCINVERT, Aligned
BitBltMonoSM, SRCINVERT, Unaligned
BitBltMonoSM, PATPAINT, Aligned
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BitBltMonoSM, PATPAINT, Unaligned
BitBltMonoSM, Other, Aligned
BitBltMonoSM, Other, Unaligned

· StretchBlt tests. These tests are like the BitBlt tests 
except that the source and destination areas do not need 
to be the same size; WinBench can stretch or shrink the 
source into the destination. These tests are normally 
slower than the BitBlt tests. You can compare the 
results of different StretchBlt Tests with each other.

StretchBltSS, Other, Aligned
StretchBltSS, Other, Unaligned
StretchBltMS, Other, Aligned
StretchBltMS, Other, Unaligned
StretchBltSM, Other, Aligned
StretchBltSM, Other, Unaligned
StretchBltMonoMS, Other, Aligned
StretchBltMonoMS, Other, Unaligned 
StretchBltMonoSM, Other, Aligned 
StretchBltMonoSM, Other, Unaligned

· Device Independent Bitmap (DIB) tests. These tests 
measure the speed at which WinBench can draw DIBs 
on the screen. DIBs are bitmap images like those 
produced by Paintbrush that you can build using 
independent Windows screen devices. You can 
compute the speed of drawing DIBs with different color 
depths (1, 4, 8, or 24 bits per pixel) using the various 
operations GDI supplies. 

SetDIBitsToDevice, 1 bpp, Unaligned 
SetDIBitsToDevice, 4 bpp, Unaligned 
SetDIBitsToDevice, 8 bpp, Unaligned 
SetDIBitsToDevice, 24 bpp, Unaligned 
SetDIBitsBlt, 1 bpp, Unaligned



SetDIBitsBlt, 4 bpp, Unaligned 
SetDIBitsBlt, 8 bpp, Unaligned 
SetDIBitsBlt, 24 bpp, Unaligned 
BltDIBits, 1 bpp, SRCCOPY, Unaligned 
BltDIBits, 4 bpp, SRCCOPY, Unaligned 
BltDIBits, 8 bpp, SRCCOPY, Unaligned 
BltDIBits, 24 bpp, SRCCOPY, Unaligned
StretchDIBits, 1 bpp, SRCCOPY, Unaligned 
StretchDIBits, 4 bpp, SRCCOPY, Unaligned 
StretchDIBits, 8 bpp, SRCCOPY, Unaligned 
StretchDIBits, 24 bpp, SRCCOPY, Unaligned 

· Line drawing tests. Line drawing operations are some 
of the most frequently used Windows graphics 
operations. One way you can use the line drawing tests 
is to see the difference in performance between 
graphics cards that have hardware support for line 
drawing operations and those cards that don't. The 
diagonal, horizontal, and vertical tests use lines that are 
the same length. This approach lets you compare the 
results from these tests. The PolyLines tests draw a 
mixture of connected line segments. Many drawing 
applications use PolyLines to simulate curved lines.

Line, Diagonal
Line, Horizontal
Line, Vertical
PolyLine

· Flood Fill tests. These tests involve filling an area on a 
screen until the GDI call reaches a border on the screen 
that is a particular color or reaches an area on the screen 
that is a different color from the fill color. The 
ExtFlood Fill, Border test starts at a point on the screen 
and fills the screen with a color until it reaches a black 
border.The ExtFloodFill, Surface test starts at a point 
on the screen and fills the screen with a new color as 
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long as the original color remains the same. The 
FloodFill test is an older GDI call that is equivalent to 
the ExtFloodFill, Border test.

ExtFloodFill, Border
ExtFloodFill, Surface

FloodFill

· Region tests. These tests invert, fill, and frame regions. 
A region consists of an area composed of an arbitrary 
set of rectangles. If the test has HV in its name, the 
region contains predominately horizontal and vertical 
sides. If the test has HVD in its name, the region 
contains horizontal, vertical, and diagonal sides. When 
a region contains diagonal lines, each scan line 
becomes a rectangle, which slows down the test. The 
term "Few-sides" indicates that the region contains 
fewer than 16 sides.



InvertRgn, Few-sides, HV
PaintRgn, Few-sides, HV
PaintRgn, Few-sides, HVD
PaintRgn, Rectangular
FillRgn, Few-sides, HV
FrameRgn, Few-sides, HV

· Miscellaneous tests. 

Pixel, Set 
This test sets a pixel to a color.

Pixel, Get 
This test retrieves the color of a pixel on the screen.

MoveTo
MoveToEx

These two tests do not perform any drawing; they 
change the current drawing position.

GetNearestColor
This operation determines the nearest color to a 
specified color that the system being tested can 
reproduce.

FastWindowFrame
Not all video drivers implement this operation. 
Therefore, you should not worry if you get an error 
message during this test. This operation draws a 
rectangular border for a window.

The USER Tests

The USER Tests suite consists of tests that measure the 
performance of the drawing operations in the USER 
module of Windows. This module is responsible for 
managing much of the Windows user interface. It also 
supplies operations that draw text and manipulate 
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rectangular portions of the screen. The USER module 
implements these operations by calling the GDI module, so 
the Graphics WinMark already reflects their GDI usage. 

The time it takes to run the USER Tests suite varies based 
on your PC and how it is set up. As data points for 
comparison purposes, this suite took 20 minutes to run on a 
386/20 with a Video 7 VRAM adapter and 9 minutes to run 
on a COMPAQ DESKPRO 66M with a QVision video 
adapter.

The following sections present the different tests that 
compose the USER Tests suite.

· Text tests. (Remember that the number indicates the 
height of the font in pixels.)

DrawText, Times New Roman 13
DrawText, MS Sans Serif 13 
DrawText, Times New Roman 16 
DrawText, System
DrawText, Times New Roman 11 
DrawText, MS Sans Serif Bold 11 
DrawText, MS Sans Serif 11 
GrayString, Times New Roman 13 
GrayString, MS Sans Serif 13 
GrayString, Times New Roman 16 
GrayString, System
GrayString, Times New Roman 11 
GrayString, MS Sans Serif Bold 11 
GrayString, MS Sans Serif 11 
TabbedTextOut, Times New Roman 13 
TabbedTextOut, MS Sans Serif 13 
TabbedTextOut, Times New Roman 16 
TabbedTextOut, System 
TabbedTextOut, Times New Roman 11 



TabbedTextOut, MS Sans Serif Bold 11 
TabbedTextOut, MS Sans Serif 11

· The next group of tests fill, frame, or invert rectangular 
portions of the screen:

FillRect
FrameRect
InvertRect
FillRect, Square
FrameRect, Square
InvertRect, Square

· The USER Tests suite also includes tests that scroll 
rectangular regions of the screen, draw rectangles that 
indicates selection or focus, and draw icons:

ScrollDC
DrawFocusRect
DrawIcon

WinBench's disk tests

WinBench provides two test suites that let you measure the 
disk performance of your PC's disk subsystem. These are 
the Disk WinMark and the Disk Tests. The Disk WinMark 
suite and the Disk Tests suite overlap in that the "Disk, 
Mix" test, which determines the Disk WinMark score, is 
also part of the Disk Tests suite. The next two sections 
describe these tests.

The Disk WinMark

Your Disk WinMark score is actually the score you get for 
a single large test, the Disk Mix. This test exercises your 
PC's disk subsystem using a variety of Interrupt 21 DOS 
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services. It uses about 32 MB of disk space as it executes.

The Disk Mix creates about 100 files in many directories 
and performs read, write, append, file lookup, creation and 
deletion operations. The mix of disk operations reflects 
profiles of application disk usage. The data in this test also 
reflects the level of compressibility of the data in the 
profiled applications. Thus, you can get meaningful results 
from this test even when you are running disk compression 
products on your PC.

The time it takes to run the Disk WinMark suite varies 
based on your PC and how it is set up. As data points for 
comparison purposes, this suite took 10 minutes to run on a 
386/20 with a Video 7 VRAM adapter and 4 minutes to run 
on a COMPAQ DESKPRO 66M with a QVision video 
adapter. 



The Disk Tests

This suite contains the Disk Mix test as well as 16 other 
disk tests. 

Each of the 16 individual disk tests creates an 8 MB file. 
WinBench then accesses the file using fixed-length records 
in either a sequential or random fashion. This suite includes 
both read and write tests.

While these tests are similar to the disk tests in WinBench 
3.11, you cannot compare their results to the results of the 
3.11 disk tests. WinBench's current disk tests exercise a 
fixed number of operations and run longer than the 
WinBench 3.11 tests, which executed for a minimum 
amount of time.

If you execute the disk tests without a disk-compression 
product on your PC and without hardware or software disk 
caches, these tests could give you an indication of the 
mechanical positioning speed and the maximum sustained 
data throughput capabilities of your PC's disk subsystem.

You can use the "Disk, Read, Sequential, 4096 bytes" and 
"Disk, Write, Sequential, 4096 bytes" tests to determine the 
maximum sustained data throughput of your PC's disk 
subsystem.

The mechanical positioning speed of the disk subsystem 
dominates the test results you receive when you execute the 
"Disk, Read, Random, 512 bytes" and "Disk, Write, 
Random, 512 bytes" tests.

The disk tests that use 200-byte records can help exercise 
the operating system's ability to block and unblock records.

The time it takes to run the Disk Tests suite varies based on 
your PC and how it is set up. As data points for comparison 
purposes, this suite took 105 minutes to run on a 386/20 
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with a Video 7 VRAM adapter and 42 minutes to run on a 
COMPAQ DESKPRO 66M with a QVision video adapter.

The Disk Tests suite contains the following tests:

Disk, Mix
Disk, Read, Sequential, 200 bytes
Disk, Read, Sequential, 512 bytes 
Disk, Read, Sequential, 2048 bytes 
Disk, Read, Sequential, 4096 bytes 
Disk, Write, Sequential, 200 bytes 
Disk, Write, Sequential, 512 bytes 
Disk, Write, Sequential, 2048 bytes 
Disk, Write, Sequential, 4096 bytes
Disk, Read, Random, 200 bytes 
Disk, Read, Random, 512 bytes 
Disk, Read, Random, 2048 bytes 
Disk, Read, Random, 4096 bytes 
Disk, Write, Random, 200 bytes 
Disk, Write, Random, 512 bytes 
Disk, Write, Random, 2048 bytes 
Disk, Write, Random, 4096 bytes

Other test suites

In addition to the test suites that perform strictly graphics or 
disk tests, WinBench has two other built-in test suites: All 
WinMarks and All Tests. 

The All WinMarks suite consists of all the tests in the 
Graphics WinMark and Disk WinMark suites. When you 
run this suite, WinBench calculates these two WinMarks. It 
also displays the results of the individual tests it ran to get 
these two WinMarks.



The time it takes to run the All WinMarks suite varies 
based on your PC and how it is set up. As data points for 
comparison purposes, this suite took 68 minutes to run on a 
386/20 with a Video 7 VRAM adapter and 11 minutes to 
run on a COMPAQ DESKPRO 66M with a QVision video 
adapter. 

The All Tests suite contains all the tests that WinBench 
offers. When your run this suite, WinBench generates the 
Graphics WinMark and the Disk WinMark. It also returns a 
score for each individual test in WinBench.

The time it takes to run the All Tests suite varies based on 
your PC and how it is set up. As data points for comparison 
purposes, this suite took 345 minutes to run on a 386/20 
with a Video 7 VRAM adapter and 140 minutes to run on a 
COMPAQ DESKPRO 66M with a QVision video adapter.

End of Appendix
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Appendix B
Troubleshooting

Normally, WinBench runs without problems. Occasionally, 
however, you may encounter a problem when you install or run 
WinBench. 

You should be aware of the following potential problems.

· If your PC crashes while WinBench's disk tests are running, 
WinBench may not clean up its test files. Check the directory 
where WinBench puts the Disk Mix files. You may need to 
clean up the files in that directory. To do this: 

1. Select \~WBDMTMP from the Windows File Manager. 
2. Select the option Delete from the File menu.
3. Answer "Yes" to the prompt "Delete All."

· If you receive error messages indicating that files are 
inaccessible or do not exist while installing WinBench, you 
may not have sufficient disk space to install WinBench. This 
error can also occur when you are running on a compressed 
drive because the disk compression product may be incorrectly 
estimating the compression ratio to be too high.

· If you are running a disk test and receive an error message 
indicating that files are inaccessible or do not exist, you may 
not have sufficient space for that WinBench test. This may 
occur if you are running on a compressed drive because the 
disk compression product could be incorrectly estimating the 
compression ratio to be too high.

· If you are trying to remove WinBench from your system, the 



UNINSTAL.BAT file may not run from the Windows File 
Manager program. If a problem occurs while running 
UNINSTAL.BAT, WinBench displays a message saying you 
may not have enough Environment space and suggests you run 
the .PIF version of the file. In that case, just run 
UNINSTAL.PIF.

Normally, if an error occurs while you are running a test, 
WinBench marks that test as "Failed" and continues with the next 
test. 

If you receive error messages and cannot resolve them, please do 
the following:

· Write down the error messages exactly. 

· Write down the contents of the status bar at the bottom of the 
WinBench screen.

· Describe how you were using the PC.

· Send this information to ZDBOp. See Appendix C for 
information on how to contact ZDBOp.

The next sections include some of the error messages that can 
occur in WinBench. 

WinBench error messages

The following sections list error messages you may receive while 
running WinBench. In all these cases, if the error persists, reinstall 
WinBench. If that does not fix the error, write down the exact 
wording of the message and what you were doing when it occurred 
and send this information to ZDBOp.

This section of error messages indicate system resources or 
memory is low. If you encounter one of these error messages:

1. Restart Windows.



2. Halt all other applications except WinBench.

3. Try WinBench again.

WinBench could not allocate memory.

WinBench could not create a brush.

WinBench could not create a pen.

WinBench could not register a window class. 

WinBench could not load a cursor or icon resource. 

WinBench could not copy the window image to the clipboard.

WinBench could not load the Accelerator Table resource. 

WinBench could not create a window. 

WinBench could not create a dialog box. 

WinBench could not start the Windows Help program.

WinBench could not create a procedure instance. 

WinBench could not install a message filter. 

WinBench could not change the color in a device context. 

WinBench could not extend the message queue length. 

WinBench could not manipulate a list box control. 

WinBench could not create a device context.

WinBench could not create a bitmap. 

WinBench could not perform a StretchBlt operation.

WinBench could not load the <name> resource. 

WinBench could not manipulate an edit control.

WinBench could not print the chart.

WinBench could not allocate memory while creating the results 
chart.
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WinBench could not create the results chart.

WinBench could not select a bitmap into a memory DC.

WinBench could not create a region object.

WinBench could not select a GDI object into the screen DC.

The following group of errors messages indicate the file is not 
accessible. If you encounter one of these error messages:

1. Make sure the file exists.

2. Make sure you have access to the file and its directory.

3. Check to see if the file is write protected.

4. Check to see if the file has been corrupted.

Be sure the file exists or if it is marked read-only. If it is on a 
network volume, be sure you have access to it.

WinBench could not open the file <name> to write to it. 

WinBench could not open the file <name> to read from it.

WinBench could not access the file <name>. 

WinBench could not read from the file <name>. 

WinBench could not write to the file <name>. 

WinBench could not get the full pathname for the file <name>. 
Check for invalid directories and filenames.

WinBench could not rename the file <name>.

WinBench could not read the file <name> because it is larger than 
64000 bytes.

WinBench could not create the file <name>.

WinBench could not access the chart file.

The following errors may occur during the disk tests. If you 



encounter one of these error messages:

1. Make sure you have enough disk space available on the drive 
where the test is running.

2. Make sure you have write access to the drive.

3. If the drive is compressed make sure the disk compression 
product is not calculating the compression ratio too high.

WinBench has detected an invalid file handle in the disk test script. 

WinBench has detected an error during a disk read request. 

WinBench has detected an error during a disk write request. 

WinBench has detected a file open attempt on an already open file. 

WinBench has detected an error while opening a file. 

WinBench has detected an error while closing a file. 

WinBench could not find a file.

WinBench has detected an error during an IOCTL operation.

WinBench has detected an unrecognized request in the disk test 
script. 

WinBench has detected a write request size that is too big.

WinBench has detected an illegal variable value in the disk test. 

WinBench has detected a bad user function in the disk test. 

WinBench could not access the specified disk.

WinBench could not get the current directory. 

WinBench could not change to a directory. 

WinBench could not make a directory. 

WinBench could not delete a directory.

These errors indicate you supplied an invalid drive setting for a 
disk test:
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The drive setting of <X> is invalid. 

It must be a valid drive letter from A-Z.

WinBench may display the following notes and warnings that 
involve test conditions.

DOS applications were running during this test and could affect the 
test results.

DOS Virtual machines can affect the performance of 
WinBench when Windows is running in enhanced mode. 
Terminate all DOS programs before starting WinBench. 

The following Windows tasks were running during this test: <name>

WinBench has detected active communication programs. WinBench 
tests may interfere with the communication programs. Do you 
want to run the test(s) anyway? 

 Running a WinBench test will interfere with an active 
communication program. Stop all such programs (e.g., Terminal) 
before running tests.

You moved the mouse during the test, possibly affecting the results. 

Moving the mouse generates interrupts that slow the 
performance of the test. Don't do it for maximum performance.

You could also get the following errors that indicate a compatibility 
problem with the a Library or the operating system. If you get one of these 
errors, you should:

1. Make sure you are using the correct version of the operating 
system.

2. Reinstall WinBench to get the correct libraries.

WinBench has detected an old version of Microsoft Windows. 

You can only run WinBench on Windows 3.1 or later.

WinBench has detected an old version of CTL3D.DLL. 



ZDBOp has only tested WinBench using version 2.0 of 
CTL3D.DLL. WinBench may not work correctly with the older 
version. You should reinstall the CTL3D.DLL file that came 
with WinBench. 

WinBench has detected an old version of BWCC.DLL. 

ZDBOp has only tested WinBench using version 1.03 of 
BWCC.DLL. WinBench may not work with the older version. 
You should reinstall the BWCC.DLL file that came with 
WinBench. 

WinBench has detected an old version of DOS. 

ZDBOp has only tested WinBench using version 5.0 of MS-
DOS. WinBench may not work correctly with the older version.

WinBench has detected an old version of OS/2. 

ZDBOp has only tested WinBench using version 2.1 of OS/2. 
WinBench may not work correctly with the older version.

WinBench has detected an old version of Novell DOS. 

ZDBOp has only tested WinBench using version 7 of Novell 
DOS. WinBench may not work correctly with the older version.

This group of errors indicates compatibility problems with the PC's 
screen resolution and font size. You can only run WinBench on a 
VGA, or larger, display.

Test results may not be meaningful on a display with pixels that are 
not square.

The application profiling WinBench is based on assumes 
square pixels (i.e., a pixel aspect ratio of 1:1). The results on 
displays without square pixels may not be meaningful. 

WinBench can not be run at the current screen resolution and font 
size. 

Increase the screen resolution or decrease the standard font 
size using Windows Setup or a Setup program supplied with the 
display drivers. WinBench cannot be run at VGA resolution with 
Large Fonts. You must use Small Fonts with VGA resolution. 
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Large Fonts may be used at 800x600 or higher resolution.
This group of errors refer to problems that might occur as you execute 
WinBench.

The WinBench window must be maximized to run the tests. Choose 
the Maximize item from the system menu and try again.

Do not obscure the WinBench window when running tests. Close 
other applications that have windows that are in front of 
WinBench.

You aborted the test.

You must run a test before copying the test screen image to the 
clipboard.

You must maximize the test screen to copy it to the clipboard.

A suite with the name <X> already exists. WinBench has not 
replaced the suite.

You cannot delete or edit the built-in test suite named <X>.

There are no tests to Run.

You clicked on the Run button when there are no currently 
selected tests.

There are no test results to display.

You selected Display/Tests Run when no tests have been run.
You supplied the following invalid command line to WinBench:. 

WinBench <argument>. Valid command lines include: 
WINBENCH [nomicroscope]
WINBENCH [nomicroscoope] auto <auto-file>

You have two command line options with WinBench. You 
can use "auto filename" to run WinBench in batch mode. You 
can use "nomicroscope" to turn off the detection of the CPU type 
and speed. You should only use this if WinBench fails during 
this detection when it is starting up. You must always place 



"nomicroscope" before "auto".
You must supply a suite using the Suite1 setting in the run file 

<name>. 

You ran WinBench in batch mode, using "winbench auto 
filename", but the file does not contain a "Suite1" setting 
indicating the suite of tests to run (see runwb.ini).

The comparison file contains an unterminated string.

The comparison file in not valid.

You edited the results file, or it has been corrupted. 

There may not be enough free system resources for WinBench to 
execute properly. 

Terminate other applications before running WinBench. 

There are no selected tests that have settings you may change. 

You do not have any disk tests in the set of currently selected 
tests.

Before performing this operation, you must save or cancel the 
changes you have made in the Disclosure Questionnaire. 

Choose the Questionnaire item in the File menu to view the 
Questionnaire, and click OK or Cancel. 

You tried to Save the results. But you have also made changes in the 
Questionnaire window without clicking OK or Cancel. 

Go to the Questionnaire window and click OK or Cancel and 
then Save the results.

You must supply a Test Description using the Disclosure 
Questionnaire dialog before you can save the results. Choose the 
Questionnaire item in the File menu to update the Test 
Description.

 You must change the test Description field in the Questionnaire 
before saving the results.

The FastWindowFrame GDI operation is not implemented in this 
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display device driver. It is an optional call used to accelerate 
window frame drawing. This is not an error. The absence of this 
operation will not affect your WinMark results.

WinBench could not perform a GDI painting operation.

 This error generally indicates a video driver failure or a low 
memory condition. Write down the error message. Try again 
after restarting Windows and running only WinBench (no other 
applications). If it still occurs contact the video driver vendor or 
ZDBOp.
NOTE: See the README.WRI file for a list of known 

incompatibilities with video drivers.

General Protection Faults.

Stack Faults.

Occasionally, you may encounter a general protection fault or stack 
fault. If these errors occur in WinBench or some other part of Windows, 
such as the Kernel, report the problem to ZDBOp.

If the fault occurs in the video driver, consult the README.WRI 
file for WinBench. This file contains a list of known video driver 
incompatibilities. Report the problem to the video driver vendor or 
ZDBOp.

The following errors should never occur. If they do, they may 
indicate that your WinBench files have become corrupted. If one 
of these errors occurs:

1. Restart Windows. 

2. Re-install WinBench,

3. Do not run other applications except WinBench.

If the error persists, contact ZDBOp.

An internal error occurred in WinBench.

WinBench ran out of Data Segment storage.



WinBench could not locate the <X> resource in WINBENCH.EXE. 

Check the file for corruption or inaccessibility.

WinBench found that the <X> resource in WINBENCH.EXE has an 
invalid size. 

Check the file for corruption or inaccessibility.

WinBench has detected that the file <X> is corrupted. 

Replace it with the original version.

The parameter distribution:     <X>  is not valid.

The parameter distribution:      <X> has values that are out of the 
allowable range.

WinBench could not locate the test parameter <X>.

WinBench could not load the string resource number <X>. 

Check for a corrupted file.

The test <name> does not exist.

The test description contains an invalid string token.

The test description contains a token that is too long.

The test description ended prematurely.

The test description is incorrect.

A weighted mark description refers to a test that does not exist.

A combination test description refers to a suite that does not exist.

The count parameter <X> is out of range.

A combination test description contains incompatible tests.

A test contains an invalid integer parameter.

A test contains an invalid alignment parameter.

A test contains an invalid floating-point parameter.

A test contains an invalid ratio parameter.
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A test contains an invalid font description.:

An internal error occurred in WinBench. Please contact ZD 
Benchmark Operation and report this error.

A test contains an invalid percentage parameter.

End of Appendix





Appendix C
Technical Support

This appendix tells you how to get copies of WinBench and other 
Ziff-Davis benchmarks as well as how to order printed copies of 
the manual. This appendix also explains the different ways you can 
contact the Ziff-Davis Benchmark Operation (ZDBOp).

Requesting a benchmark

WinBench is available free of charge on 3 1/2-inch diskettes. You 
can also get copies of WinBench and other Ziff-Davis benchmarks 
by contacting ZDBOp or by downloading them from ZiffNet, Ziff-
Davis' on-line service. (For information on using ZiffNet, see the 
section "Contacting ZDBOp.")

NOTE:The Winstone 94 CD-ROM also includes WinBench and 
PC Bench. Thus, if you get the Winstone 94 CD-ROM, you 
will actually get all three benchmarks. 

To request a benchmark from ZDBOp, use the form that comes 
after this appendix. You can fax the form to the ZDBOp dedicated 
benchmark request fax number (919-380-2879), or you can mail 
the form to ZDBOp using the address listed at the top of the form. 
The benchmark will arrive via third-class U.S. mail in four to six 
weeks.

If you want to receive this benchmark sooner and you have a 
Federal Express account, you can include your account number 
and shipping instructions on the fax form. The benchmark will 



then go out via Federal Express and ZDBOp will charge the cost of 
sending the benchmark to your Federal Express account.



Ordering a printed manual

You can order a perfect-bound, printed copy of this manual for a 
nominal fee. Each printed copy of the WinBench manual costs 
$10, which covers the cost of the manual and the cost of mailing it 
to you. To order a printed copy of the manual, use the Ziff-Davis 
Benchmarks' Manual Order Form, which appears after the 
Benchmark Request Form. 

Contacting ZDBOp

If you have comments or questions about WinBench, please 
contact ZDBOp. You can contact ZDBOp in several ways:

· If you have a modem and communications software, you can 
use the 
ZDBOp forum on ZiffNet, the Ziff-Davis on-line service. The 
ZiffNet forum is a way for you to communicate your questions 
and comments to ZDBOp, get tips for running WinBench, 
report bugs, offer suggestions for the future, and get the latest 
versions of the Ziff-Davis benchmark. (You can access ZiffNet 
via CompuServeâ. CompuServe is available for a fee.)

To get to the ZDBOp forum, type GO ZDBENCH at any 
prompt.

You can find information on WinBench in the PC MagNet and 
PC Week forums on ZiffNet

· You can fax your questions and comments directly to 
WinBench Technical Support at the ZDBOp benchmark fax 
number (919-380-2879).
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· You can mail your questions and comments to ZDBOp at the 
following address:

Ziff-Davis Benchmark Operation
One Copley Parkway, Suite 510
Morrisville, N.C. 27560

Attn.: WinBench Technical Support

End of Appendix



Benchmark Request Form

FAX OR MAIL THIS FORM TO:

Ziff-Davis Benchmark Operation
One Copley Parkway, Suite 510

Morrisville, NC 27560

fax: (919) 380-2879

WHO I AM:

Name: 
____________________________________________________________

Company: 
_________________________________________________________

Address: 
__________________________________________________________

City: _________________________ State: _____________ Zip: 
______________

Country: 
__________________________________________________________

Fax: ___________________________ Phone: 
_____________________________

We answer requests in the order we receive them. We ship all benchmarks 
via third-class US mail unless you supply a Federal Express account 
number. Please allow four to six weeks for delivery via regular mail.

Shipping information if you choose to use Federal Express:

Your Federal Express account number: 
______________________________

Check one: ___ priority overnight ___standard overnight

WHAT I WANT:



___ PC Benchä 8.0 ___ NetBenchä 2.1
___ WinBenchâ 4.0 ___ ServerBenchä 1.0 SCOâ 

UNIXâ*

___ Winstoneä 94 Version 1.0 (on CD-ROM)
___ MacBenchä 1.0

(All benchmarks EXCEPT Winstone are available only on 3.5" diskettes.)
* Other versions to follow



Ziff-Davis Benchmarks' Manual Order Form

To Order:

Fax this form to (919) 380-2879 or mail to:

Ziff-Davis Benchmark Operation
One Copley Parkway, Suite 510

Morrisville, NC 27560
Attn. Manual Orders

Title Price Qty. Total

Understanding and Using WinBenchâ 4.0 $10.00 ___ _______

Understanding and Using Winstone™ 94 Version 1.0 $10.00 ___ _______

Understanding and Using PC Bench™ 8.0 $10.00 ___ _______

Understanding and Using MacBench™ 1.0 $10.00 ___ _______

Understanding and Using NetBench™ 2.1 $10.00 ___ _______

Understanding and Using ServerBench™ 1.0 for SCOâ UNIXâ $10.00 ___ _______

Shipping and handling included TOTAL ___ _______

Allow 4-6 weeks for delivery

Ship to: (please print)
Name: 

_________________________________________________________
______

Company: 
_________________________________________________________
____

Address: 
_________________________________________________________
_____

City / State / Zip: 
________________________________________________________

Daytime phone: 
_________________________________________________________

Payment form:



__Check to Ziff-Davis Publishing Co. __Visa __MasterCard
__American Express

Credit Card #: _____________________________________   Exp. 
date: ___________
Signature: 
____________________________________________________________
_

For fastest shipment supply your Federal Express or UPS account number:
Your account 
number:_____________________________________________________
Check one: __Priority overnight

__Standard overnight
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	Preface
	· Notes about WinBench
	· A reading path to the manual that explains who needs to read which parts of the manual
	· A list of the on-line documentation
	· Information on the general Windowsä conventions that WinBench uses and the general conventions this manual uses
	Introducing WinBench
	NOTE: Unlike Ziff-Davis' Winstoneä 94 benchmark, WinBench does not run actual applications. Instead, it performs tests based on the operations that applications perform. Information about these operations comes from extensive profiling of the applications.

	· Winstone 94. Use this benchmark to measure the overall performance of your PC as it runs actual Windows-based applications.
	· PC Benchä. Use this benchmark to measure the speed of the processor subsystem of your PC.
	NOTE: PC Bench also can test a PC's graphics and disk subsystems. The difference between the WinBench graphics and disk tests and the corresponding PC Bench subsystem tests is that the WinBench tests use Windows. Since the PC Bench tests do not execute on top of Windows, they will often produce different results.

	Notes about WinBench
	1. You must read and agree to the license information in the front of this manual before you use WinBench. This same licensing information appears on your screen the first time you start WinBench. If you do not
	agree to the licensing information, please remove WinBench from your PC, delete all copies of it and return the WinBench diskette to Ziff-Davis Benchmark Operation One Copley Parkway, Suite 510 Morrisville, North Carolina 27560
	For more information on licensing WinBench, see Chapter 2.
	2. The test results from WinBench 4.0 are not compatible with the test results of previous versions of WinBench. You can meaningfully compare WinBench 4.0 test results only with other WinBench 4.0 test results.

	Who should read this manual
	Outline of this manual

	On-line documentation
	Windows conventions WinBench uses
	· Clicking and double-clicking with your mouse's left button to select and activate items. In most cases, if you click on an item, such as an icon or a test name, WinBench selects that item and highlights it. If you click on a button, WinBench performs an action. For example, if you click on the Display Results button, WinBench opens the Chart of Results and the Table of Results. If you double-click on an item, WinBench performs an action associated with that item. For example, if you double-click on an icon, WinBench opens that icon window. If you double-click on a test name in the Select Tests window, WinBench moves that test to the list of tests you have selected. If you click on a test name, WinBench highlights it.
	· Combining clicking your mouse's left button and pressing either the Shift key or the Control key to select multiple items. If you are selecting a range of tests from WinBench's Select Tests window, you can click on the first test and then press the Shift key and click on the last test. If you are selecting multiple tests in a random order, you can click on the first test and then press the Control key and click on any other tests you want to select.
	· Using drop-down menus from the Windows main menu bar. WinBench presents its options as menu titles in the Windows menu bar. When you select one of these menu titles, such as Run, a drop-down menu appears displaying the menu items available. In most cases, the drop-down menus duplicate actions that are available through WinBench's Functions buttons. In many cases, the drop-down menus also give you additional options, such as the ability to copy or print results. The Windows menu bar changes depending on which window is active in WinBench. For example, if the Table of Results window is active, the Windows menu bar displays the menu titles File, Edit, Run, Suite, Table, Window, and Help. If the Chart of Results window is active, the Windows menu bar displays the options File, Edit, Run, Suite, Chart, Window, and Help.
	· Resizing and moving windows. You can minimize, maximize, and resize most of WinBench's windows, such as the Table of Results window, the same way you work with other windows in the Windows environment. You can also close the window using the drop-down control menu that appears when you click on the box in the upper left corner of the window. The exception is the Test Screen window, in which WinBench runs its tests. This window is always either maximized or an icon.
	· Minimizing windows and using icons. WinBench lets you minimize its windows as icons. You do this by clicking on the minimize button (the down caret) in the upper right corner of the window. The easiest way to restore the window is to double-click on the icon. You can also restore the window by clicking once on the icon and then, when the pop-up menu appears, clicking on Restore.
	· Using keyboard commands to select items instead of using the mouse. To do so, press the Alt key and the underlined access (or shortcut) character of the item you want to select. This item can be one of the controls in an active window, a menu title, or a menu item within a drop-down menu.
	General manual conventions
	Contacting ZDBOp

	Table of Contents
	Chapter 1 An Overview of WinBench
	The WinBench basics
	NOTE: WinBench does not run actual applications during its tests. The WinBench tests simply mimic the graphics and disk operations that leading Windows-based applications perform.
	NOTE: The two key points that distinguish WinBench from Winstone 94 and PC Bench are:
	· Unlike Winstone 94, WinBench does not run actual applications.
	· Unlike PC Bench, WinBench executes on top of Windows.

	The subsystems WinBench measures
	The WinBench tests
	The Graphics WinMark tests
	The Disk WinMark test
	The individual tests
	NOTE: Keep in mind that WinBench tests only your PC's graphics and disk subsystems. Thus, while you can use WinBench to see which subsystem configurations are faster than others, changing subsystem configurations rarely increases the speed of applications by the same amount that the new subsystem is faster than the old one. For example, suppose that one video card is 10 percent faster than another one. If you switch to the faster video card, you probably will not get a 10 percent increase in the overall speed of your application. This is because applications do more than just display graphics and text. The
	percentage of overall improvement you get will depend on the how much time your application spends displaying graphics and text relative to the amount of time it spends doing other things.


	The philosophy behind the tests
	· CorelDRAW!â 4.0
	· Microsoftâ PowerPointâ for Windowsä 3.0
	· Paradoxâ for Windowsä 1.0
	· Clarisâ FileMakerâ Pro for Windowsä 2.0v1
	· Microsoftâ Accessä for Windowsä 1.10
	· Aldus PageMakerâ for Windowsä 5.0
	· Microsoftâ Worksä for Windowsä 2.0a
	· Borlandâ Quattroâ Pro for Windowsä 1.0
	· Lotusâ 1-2-3â Release 4 for Windowsä
	· Microsoftâ Excel for Windowsä 4.0
	· Microsoftâ Word for Windowsä 2.0c
	· WordPerfectâ for Windowsä 5.2.
	What you can do with the WinMark scores

	· Match your PC and its graphics and disk subsystems to the applications you use.
	· Determine the relative speeds of different screen resolutions and color depths on a single video card.
	· Compare different disk caching programs.
	· Compare SMARTDrive (or other cache software) sizes.
	· Make purchase decisions involving your graphics and disk subsystems.
	Using WinBench with Winstone 94 and PC Bench
	· Winstone 94. Use this benchmark to measure the overall performance of your PC as it actually runs Windows-based applications. With Winstone 94 you can also measure the effect that changing individual system components has on your PC's overall Windows performance.
	Winstone 94 provides a single score that measures how well your PC performed as it ran twelve leading Windows applications. Winstone 94 uses scripts to perform typical tasks with these applications.
	NOTE: WinBench works well as a partner to Winstone 94, but it does not yield exactly the same results as Winstone 94. Even if you hold every part of a system constant except the graphics subsystem, WinBench and Winstone 94 will not always rank system or video cards in exactly the same order. One reason is that WinBench is by design a graphics stress test that constantly exercises a PC's graphics subsystem. Winstone 94 is an overall system benchmark that performs a great deal of disk and CPU activity and is less stressful on the graphics subsystem. WinBench goes a step beyond Winstone 94 and puts additional stress on graphics subsystems by using dithered colors. This is an activity that many Windows graphics adapters don't handle well and that applications in Winstone 94 don't, at least right now, use heavily.

	· PC Bench. Use this benchmark to measure the performance of your PC's processor subsystem.
	
	In addition to providing a test that measures the speed of your PC's processor subsystem, PC Bench also lets you measure how your PC's disk and video subsystems perform in a DOS environment. WinBench's disk tests are similar to the PC Bench disk tests; but the scores for the WinBench tests will often differ from the scores for the PC Bench tests. This is because WinBench performs its tests on top of Windows, while PC Bench performs its tests using DOS.
	What's next
	· The basics of what WinBench is.
	· The elements that comprise the subsystems WinBench tests.
	· The types of tests WinBench provides, including its key tests, the Graphics WinMark and the Disk WinMark.
	· Some ways you can use your scores.
	· How you can use WinBench with two other Ziff-Davis benchmarks, Winstone 94 and PC Bench.
	· Installing WinBench as well as how to license and register your copy of the benchmark, see Chapter 2.
	· Running WinBench interactively and in batch mode as well as the different combinations of tests you can run, see Chapter 3. This chapter also contains tips to help you get the most accurate results possible for your PC.
	· Creating and modifying test suites, see Chapter 3.
	· Saving, printing, and comparing your test results, see Chapter 4.
	· Understanding the results you get when you run the WinBench tests, see Chapter 5 and Appendix A.
	· Determining what affects your WinBench results as well as how you can track your system information, see Chapter 6.
	· Understanding the concepts used to develop WinBench, such as profiling, see Chapter 7. This chapter also notes some things the tests do not do.
	· Comparing your PC's test results to test results from other PCs, see 
Chapter 8.

	Chapter 2 Installing WinBench
	· A list of the minimum hardware and software requirements your PC must meet to be able to run WinBench.
	· Information on how to install WinBench.
	NOTE: The README.WRI file that comes with WinBench also contains information on how to install WinBench.

	· Instructions on how to license and register WinBench.
	· Information on how to remove WinBench from your PC.
	Getting a copy of WinBench
	NOTE: If you get a copy of Winstone 94, you will also have a copy of WinBench and PC Bench. All three benchmarks are on the Winstone 94 CD-ROM.

	Hardware and software requirements
	· Windows 3.1, Windows for Workgroups 3.1, or Windows NTä 3.1.
	· MS-DOSâ 5.0 (or later), Novellâ DOS 7, or OS/2â 2.1.
	NOTE: ZDBOp did not test WinBench on earlier versions of these operating systems. Hence, ZDBOp does not guarantee that WinBench will run on them or, if it does, that its test results will be valid.

	· An 80386 (or compatible) or higher processor.
	NOTE: ZDBOp did not test WinBench on PC's containing 80286 processors. Hence, ZDBOp does not guarantee that WinBench will run on an 80286 processor or, if it does, that its test results will be valid.

	· A VGA resolution or higher resolution video adapter. WinBench will work on any video adapter with a horizontal resolution of at least 640 pixels and a vertical resolution of at least 480 pixels.
	· 4 MB of RAM.
	NOTE: While you can run WinBench on PCs with less RAM, its test results will not be valid because of the paging activity that will occur due to the limited memory.

	· Approximately 3 MB of free space on your hard disk for the WinBench software.
	· Approximately 32 MB of additional free space on your hard disk for temporary files the Disk WinMark test uses.
	Using a downloaded copy of WinBench
	1. Move WB40.EXE to a temporary directory (for example, TMP).
	2. Run WB4.0.EXE from the Windows File Manager or Program Manager.
	NOTE: You can place WB40.EXE in any directory you like. Just use the correct directory name in the command line when you execute the file.

	Quick installation for experienced users
	Installing WinBench
	NOTE: If you already have a version of WinBench on your PC, you should delete that version before staring the Setup program (see the section "Removing WinBench from your PC" later in this chapter). The Setup program will delete the current WinBench files and replace them with the new WinBench files. If you have version 3.11 of WinBench or an earlier version, just delete the directory containing WinBench.
	1. Open the Windows File Manager.
	2. Go to the directory containing the WinBench files:
	3. Select SETUP.EXE and execute it. (Windows automatically executes this file when you double-click on the file name SETUP.EXE.)
	4. Click on Continue in the WinBench 4.0 Setup screen.
	
	You can also halt the installation procedure at this point by selecting Exit. If you do this, WinBench displays a Quit screen that says the installation is incomplete and gives you the opportunity to resume the installation by selecting Continue. To halt the installation, select Exit again. WinBench then displays a screen telling you that the benchmark has not been properly installed. Select OK. WinBench terminates its installation procedure. Ignore the rest of these steps.
	5. Enter the name of the directory in which you want to install WinBench. The default directory is C:WINBENCH. You can enter another directory name if you choose or accept the default directory. Now select Continue to go to the next screen.
	The WinBench Setup Disk screen appears. In this screen, WinBench displays information about the progress of the installation. When the installation finishes, WinBench displays a screen indicating that the installation was successful.
	6. Click on OK to end the installation process.

	Licensing and registering WinBench
	1. Start WinBench by double-clicking on the application icon labeled WinBench 4.0. WinBench displays the licensing information.
	2. Read the licensing information. You will need to use the scroll bar to view all the licensing information.
	Once you reach the end of the license agreement, you have two choices:
	3. At the WinBench Registration form, enter your name in the box next to Name. If you want to register WinBench, you must enter a name here. If you do not, WinBench will not continue.
	NOTE: By default, when you run WinBench, it will display the same registration information in this window that you used when you registered Windows on your PC.

	4. If you belong to a company or organization, enter that name in the box next to Organization.
	NOTE: This step is optional. If you do not belong to a company or organization, you can skip this step.

	5. At the bottom of the Registration window, WinBench asks whether you agree to abide by the terms of the license agreement. You have three options:

	Removing WinBench from your PC
	NOTE: WinBench does not remove CTL3D.DLL and BWCC.DLL from the system directory because other applications may use them.
	NOTE: If you are executing the UNINSTAL.BAT file from the Windows File Manager program, it may not run. If a problem occurs while running UNINSTAL.BAT, WinBench displays a message saying you may not have enough Environment space and suggests you run the .PIF version of the file. In that case, just run UNINSTAL.PIF.
	Removing the WinBench icon
	1. Click the WinBench icon in the Ziff-Davis Benchmarks window.
	2. Press the delete key.
	3. Answer Yes to the prompt.

	What's next
	· WinBench's hardware and software requirements.
	· How you can install WinBench.
	· How to license and register your copy of WinBench.
	· How you can remove WinBench from your PC.
	· Running WinBench interactively and in batch mode as well as the different combinations of tests you can run, see Chapter 3. This chapter also contains tips to help you get the most accurate results possible for your PC.
	· Creating and modifying test suites, see Chapter 3.
	· Saving, printing, and comparing your test results, see Chapter 4.
	· Understanding the results you get when you run the WinBench tests, see Chapter 5 and Appendix A.
	· Determining what affects your WinBench results as well as how you can track your system information, see Chapter 6.
	· Understanding the concepts used to develop WinBench, such as profiling, see Chapter 7. This chapter also notes some things the tests do not do.
	· Comparing your PC's test results to test results from other PCs, see 
Chapter 8.

	Chapter 3 Running WinBench
	· Start WinBench.
	· Exit from WinBench.
	· Halt a series of tests.
	· Use the features in the WinBench application window.
	· Run the WinMark tests, test suites, and individual tests.
	· Run WinBench in batch mode.
	· Run WinBench in demo mode.
	· Create and modify test suites.
	· Get the best test scores from your PC.
	Starting WinBench
	1. Make sure you have properly installed and licensed WinBench (see Chapter 2 for instructions on installing and licensing WinBench).
	2. Double-click on the Ziff-Davis Benchmarks program manager group icon. The Ziff-Davis Benchmarks program window opens.
	3. Double-click on the WinBench icon.
	NOTE: The first time you start WinBench 4.0, the WinBench licensing and registration windows appear. You must agree to the WinBench license agreement and register WinBench before you can use WinBench. This window appears only the first time you start WinBench after you install it. Once you supply the registration information, WinBench does not display the licensing window again regardless of how many times you restart WinBench. If you want to read the license agreement, select the About Function button. When the About window appears, select the License button.


	Exiting from WinBench
	· Click on the Exit button.
	· Select Exit from the File menu.
	· Select Close from the system menu.
	· Press the Alt-F X key combination.
	· Press the Alt-space C key combination.
	Yes
	Depending on whether you have entered a name in the Test Description field of the Disclosure Questionnaire, WinBench either returns you to the WinBench application window and continues to run or lets you supply a name for the results file and then halts.
	If you have not entered the Test Description, WinBench tells you that you need to supply this name and returns you to the WinBench application window. WinBench continues to run.
	If you have already entered the Test Description information, WinBench places you at the Save As window. Once you enter the name of the results file and click on OK, WinBench saves the results to a file and halts.

	No
	WinBench halts without saving your current test results.

	Cancel
	WinBench continues to run.

	Interrupting a series of tests
	Do you want to terminate the running tests?
	NOTE: If you use the mouse to halt a series of tests, you must click it. WinBench does not query you about stopping if you simply move the mouse around.


	Options on the basic WinBench window
	The Functions window

	· Help. Clicking on this button opens a window that contains the table of contents for the WinBench help file. You can then double-click on the topic you want, and WinBench displays the help text for that topic. Because WinBench incorporates this manual as its on-line help, the list of help topics corresponds to this manual's table of contents. You will need to use the vertical scroll bar to view all of the available help topics.
	NOTE: In addition to clicking on the Help button, WinBench provides you with two other ways to access its context-sensitive help system. If you press the F1 function key, WinBench provides help information about the item that currently has the keyboard focus. If you press the Shift-F1 key sequence, your mouse cursor changes into a question mark and WinBench displays help information about any control, icon, or menu that you then select with the mouse.
	The WinBench windows
	


	· Disclosure. This window displays information about your PC's configuration and lets you edit this information. This includes information that the WinBench license agreement requires you to disclose if you publish any results from your WinBench tests. You can open the Disclosure window by clicking on the Disclosure button located in both the Chart of Results and the Table of Results or by selecting Disclosure from the File menu.
	The WinBench drop-down menus
	The File menu

	
	The Edit menu
	The Run menu
	The Suite menu
	The Table menu
	The Chart menu
	The Window menu
	The Help menu


	Running the WinBench tests
	· Suites. These are sets of two or more tests that you can execute with a single command. WinBench has two kinds of test suites: built-in test suites and custom test suites. A built-in test suite is one that comes with WinBench, such as the GDI Tests test suite. WinBench lists all its built-in test suites in the drop-down list next to the Run button. A custom test suite is one that you created. When you create a custom test suite, WinBench lets you save the list of tests you specify as a file that you can later access or modify from within WinBench.
	NOTE: You do not have to create a test suite to run a group of tests. You can use the Select Tests window to specify a group of tests. However, WinBench does not remember this group of tests. When you change the selection in the drop-down list next to the Run button, the group of tests disappears. Thus, you cannot run this group of tests repeatedly the way you can a test suite.

	· WinMarks. A test suite that uses weights to determine a score. There are two WinMarks tests suites: the Graphics WinMark and the Disk WinMark. Whenever WinBench runs all the tests comprising a WinMark, it computes the WinMark score, even if you did not specifically run that WinMark suite.
	· Tests. A single test that focuses either on one operation, such as the Lines, Horizontal test, or on several operations mixed together, such as the test Combined GWM .
	NOTE: The time WinBench needs to complete its tests varies depending on the speed of your PC and which tests you run. If you execute the option All Tests, WinBench can take as long as several hours to run.
	NOTE: You can display different combinations of test results in the Chart of Results or the Table of Results. WinBench, by default, initially displays the tests you just ran; however, you can use the Chart menu or the Table menu to display different combinations of test results, such as all the WinMark tests or all the tests you have run during this WinBench session. You can also use the Compare option to display results from other test runs next to the results from your current test run. For more information on displaying and comparing test results, see Chapter 4.
	Specifying settings for the disk tests

	· Select the Settings function button in the WinBench application window.
	· Select the Settings button in the Select Tests dialog box.
	NOTE: WinBench will only open the Test Settings dialog box when you have a disk test selected. This means that you must have a test suite that includes at least one disk test selected in the box next to the Run button before you can open the Test Settings dialog box. If you are at the Select Tests dialog box, you must have selected at least one disk test and placed it in the Selected Tests window before you can open the Settings dialog box.
	1. Select the disk test for which you want to specify settings. The drop-down list next to Test contains the names of all the disk tests that are part of the test suite or group of tests currently selected.
	2. Enter the Setting you want to change. Currently, your only option is Drive.
	3. Enter the designation for that drive where you want to run the test in the box next to Value. For example, enter a "D" there to indicate drive D.
	NOTE: You do not have to enter a colon after the drive letter.

	4. Click on OK once you have specified settings for all the disk tests that you want to run on a drive other than the default drive.
	NOTE: If you want to specify settings for other disk tests in the drop-down list next to the Test box, repeat steps 1-4 until you have entered the settings for each of those tests. If you do not specify a setting for a disk test, WinBench uses the default setting. Now select OK.

	Running all the WinMark tests

	· Select the option All WinMarks in the drop-down list next to the Run button. Once All WinMarks appears in the box, click on Run.
	· Select the option WinMark Tests from the Run menu. When the cascading menu appears, select the option All.
	Running either the Graphics or the Disk WinMark test

	· Select either the option Graphics WinMark or Disk WinMark in the drop-down list next to the Run button. Once the name of the WinMark test you want to run appears in the window, click on Run.
	· From the Run menu, select the option WinMark Tests. From the cascading menu that appears, select either Graphics for the Graphics WinMark or Disk for the Disk WinMark.
	Running all the WinBench tests

	· Select the option All Tests in the drop-down list next to the Run button. Once All Tests appears in the box, click on Run.
	· Select the option All Tests from the Run menu.
	Running the additional WinBench test suites

	· The Disk Tests. This suite includes the Disk Mix, which WinBench uses to calculate the Disk WinMark, and a group of sequential and random tests that read and write data to the disk using different size records. The complete set of disk tests read and write data in groups of 200 bytes, 512 bytes, 2048 bytes, and 4096 bytes.
	As data points for comparison purposes, the Disk Tests suite took 105 minutes to run on a 386/20 with a Video 7 VRAM adapter and 42 minutes to run on a COMPAQ DESKPRO 66M with a QVision video adapter.
	· The GDI Tests. This suite exercises additional GDI calls that do not appear in other tests. The GDI Tests exercise GDI calls that the profiled applications did not use. This suite includes most of the GDI painting calls supplied by Windows.
	As data points for comparison purposes, the GDI suite took 110 minutes to run on a 386/20 with a Video 7 VRAM adapter and 55 minutes to run on a COMPAQ DESKPRO 66M with a QVision video adapter.
	· The GWM Tests. This suite includes the individual tests that exercise all the GDI calls the Graphics WinMark uses. Unlike the Graphics WinMark suite, this suite executes these operations as individual tests.
	As data points for comparison purposes, the GWM Tests suite took 52 minutes to run on a 386/20 with a Video 7 VRAM adapter and 27 minutes to run on a COMPAQ DESKPRO 66M with a QVision video adapter.
	· The USER Tests. This suite exercises calls made through the USER component of windows. USER is a module that manages windows. These tests make USER calls that draw things, not GDI calls.
	As data points for comparison purposes, the USER Tests suite took 20 minutes to run on a 386/20 with a Video 7 VRAM adapter and 9 minutes to run on a COMPAQ DESKPRO 66M with a QVision video adapter.
	NOTE: One way you can see which tests WinBench includes in each of these suites is to open the Select Tests dialog box and double-click on the name of the suite. WinBench then displays the names of all the tests that make up that suite in the Selected Tests list. Appendix A also contains a list of the individual tests that make up these suites.
	Running a custom test suite
	1. Click on the option Open from the Suite menu. The Read Suite from File dialog box appears.
	2. Click on the name of the test suite you want to open. By default, WinBench keeps its test suites in the directory WINBENCHSUITES. If you saved your test suite file in another directory, then you will need to open the file from that directory.
	3. Click on OK. WinBench adds the test suite to the drop-down list next to the Run button and makes that suite the selected test.
	NOTE: Unless you remove it, this test suite will remain in the drop-down list next to the Run button for the rest of your current WinBench session. If you want to remove it, select the option Delete from the
	
	Suite menu. This removes the currently selected test suite from the drop-down list, but it does not delete the test suite file from your PC.

	4. Click on Run to execute the test suite.
	Selecting individual tests and groups of tests

	· Select the option Selected... from the drop-down list next to the Run button. If you open the Select Tests dialog box this way, when you click on OK in that window, WinBench returns you to the WinBench application window and waits for you to click on Run before it executes the test or tests.
	· Select the option Selected Tests from the Run menu. If you open the Select Tests dialog box this way, when you click on OK in that window, WinBench automatically starts running the tests you specified.
	1. Select the test or test suite you want. If you select a suite, WinBench displays all the individual tests that make up that suite in the Selected Tests window. To add tests to the Selected tests window either:
	NOTE: If you are using keyboard commands instead of a mouse, WinBench lets you use Shift-F8 and the Space bar to select a random group of tests. To do this:
	a. Press Shift-F8 once. Use the arrow key to move through the list until the test you want is highlighted.
	b. Press the Space bar. That test is now one of your selected tests and stays highlighted even when you move the cursor down. If you want to select a contiguous range of tests, press and hold the Shift key as you use the arrow key to move through the list of tests.
	c. Once you have selected all the tests you want, press the Tab key. This takes you to the Add button.
	d. Now press the Space bar. WinBench moves all the highlighted tests to the Selected Tests window.
	To disable this keyboard feature, press Shift-F8 again.

	2. If you selected any disk tests, you can use the Settings button to specify the drive you want to run the tests on.
	3. Use the Remove and Remove All buttons to delete some or all of the tests from the Selected Tests list. The Remove button deletes only the tests in the list that are highlighted. The Remove All button deletes all the tests from the list.
	4. Click on the OK button when you have the list of tests you want to run in the Selected Tests list.
	NOTE: Remember that if you entered the Select Tests dialog box from the drop-down Run menu in the Windows menu bar, WinBench automatically runs the tests you chose as soon as you click on OK. If you entered the Select Tests dialog box by choosing Selected... in the box next to the Run button, then WinBench returns you to its main window and waits for you to click on Run before executing the tests.


	For information on all the WinBench tests, see Appendix A.
	Running WinBench in demo mode
	Running WinBench in batch mode
	Modifying the RUNWB.INI file
	NOTE: When you run WinBench interactively, you supply this information by editing the Disclosure Questionnaire.
	NOTE: This explanation of the file presents the RUNWB.INI file options in the order in which they appear. The information on setting up the results files is the last part of the RUNWB.INI file.



	· A tab-delimited format suitable for use by Microsoft Excel (.XLS).
	· A comma-delimited format suitable for use by Excel or Lotus 1-2-3 (.CSV).
	· A plain text file (.TXT).
	Using custom test suites
	NOTE: While WinBench lets you create your own test suites, you cannot assign weights to the tests in such suites.
	Creating custom test suites
	1. Select the option New from the Suite menu. The Create Test Suite dialog box appears.
	NOTE: WinBench displays the names of all the currently selected tests in the Selected Tests list when it opens the Create Test Suite dialog box. These are the tests that make up the test suite selected in the box next to the Run button. For example, if you have the Graphics WinMark as the selected test suite next to the Run button, then WinBench lists the seven tests that make up the Graphics WinMark in the Selected Tests window. Thus, if you are creating a test suite that is similar to an existing test suite, make sure the existing test suite is the currently selected test suite. (If you don't want to use any of these tests, click on the Remove All button.)

	2. Enter the name you want to call the test suite. This is the name that will appear in the drop-down list next to the Run button and in the Test Suites list in the Select Tests dialog box. You can use any combination of characters and spaces for this name that you choose.
	NOTE: If you save the test suite to a file, WinBench will associate a filename with the test suite you create. That filename must follow DOS filename conventions. Later, when you want to open the test suite, you will need to select the DOS filename, not the actual suite name. For example, suppose you create a suite named "All Text" and save it as a file named ALLTXT3.WBS. When you want to open that suite, WinBench displays a dialog box with the filename ALLTXT3.WBS in it, not the suite name All Text.

	3. Select the tests you want in the test suite by double-clicking on the test names or clicking on a name and then clicking the Add button. You can select any of the existing test suites as well as any of the individual tests. If you select an existing test suite, WinBench displays in the Selected Tests list all the tests that make up that suite.
	NOTE: WinBench does not save settings for disk tests with the test suite. To specify settings for any of the disk tests in your test suite, you must first select the test suite from the drop-down list next to the Run button and then click on the Settings button.

	To remove a test from the list of selected tests, highlight it and then select the Remove button. To remove all the tests, select the Remove All button.
	4. Click on OK when you have all the tests you want listed in the Selected Test window. WinBench displays the Save Suite in File dialog box.
	At this point, you have a WinBench test suite that you can run. You do not have to save the test suite to a file. If you want to save your test suite, go to step 5; otherwise, click on Cancel and stop now.
	5. Enter the filename for the test suite with a .WBS extension. Choose the directory and drive where you want WinBench to save the file. By default, WinBench saves the file in the WinBench subdirectory SUITES. (You must follow DOS filename conventions when you enter the base name for this file.)
	Steps 5 and 6 are optional. You can run the test suite you just created without saving it to a file. However, once you end this WinBench session, your test suite will disappear.
	6. Select OK. WinBench adds the test suite you just created to the list of available test suites in both the drop-down list next to the Run function button and the Test Suites portion of the Selected Tests window.
	Adding a custom test suite to the list of available suites
	1. Select the option Open from the Suites menu. The Read Suite from the File dialog box appears. Go to the directory and drive where you saved the test suite. WinBench displays the names of all of the files in that directory with the extension .WBS.
	NOTE: WinBench does not display the actual suite names in this window. Instead it displays only the DOS filenames associated with the suites.

	2. Click on the filename for the test suite you want to add.
	3. Click on OK.
	Modifying a custom test suite

	1. Select the test suite you want to modify from the drop-down list of test suites next to the Run button.
	2. Select the menu option Edit from the Suites menu. WinBench displays the Edit Test Suite dialog box.
	3. Change the list of tests associated with this test suite by adding or deleting tests.
	4. Click on OK. The Save Suite in File dialog box appears. You do not have to save your modified test suite to a file. You can run the test suite during this WinBench session even if you do not save it. If you want to save your changes to a file, go to step 5; otherwise, click on Cancel and stop now.
	5. Specify the filename for this test suite as well as the directory and drive where you want WinBench to save it. By default WinBench saves the file in the WinBench subdirectory called SUITES.
	NOTE: The filename you supply must have an extension of .WBS and must follow DOS filename conventions. WinBench does not recognize this file as a test suite unless it has the .WBS extension.

	6. Select OK.
	NOTE: If you modify a test suite that you have saved to a file, WinBench does not require you to save the revised test suite to the same DOS file. For example, you may modify the test suite All Text that is associated with the DOS file ALLTXT3.WBS. When you save your changes, you can enter a new filename for this test suite, such as ALLTXT4.WBS.
	Removing a custom test suite

	Checking your PC's configuration
	Editing the Disclosure Questionnaire
	1. Open the Disclosure window.
	2. Highlight the information you want to copy.
	3. Select Copy from the Edit menu.

	Tips for running WinBench
	1. Reformat your hard drive.
	2. Install the operating system (usually DOS).
	3. Install Windows.
	4. Install any necessary video drivers. As you do this, note if the driver uses settings other than the default settings.
	5. Install WinBench.
	6 Exit Windows.
	7. Defragment your hard disk.
	8. Reboot your PC.
	9. Start Windows. Make sure you have not other applications running.
	10. Run WinBench.

	· Defragment your hard disk.
	· Reboot your PC.
	· Avoid moving the mouse or pressing keys while the tests are running.
	· Halt other applications you might normally run and run only WinBench.
	· Use disk caching software, such as SMARTDrive.
	· Turn off any network drivers (if you have access to a network).
	Sample test results

	What's next
	· How to start WinBench, and how to exit WinBench, and as how to interrupt a series of WinBench tests.
	· The options that WinBench provides in its main window. These options include function buttons, drop-down menus, and WinBench windows.
	· The different ways you can execute the WinBench tests.
	· How you can create and modify custom test suites.
	· How to view your information the system configuration in effect when you ran the WinBench tests or that is currently in effect.
	· Ways you get the most accurate results for your PC.
	· Saving, printing, and comparing your test results, see Chapter 4.
	· Understanding the results you get when you run the WinBench tests, see Chapter 5 and Appendix A.
	· Determining what affects your WinBench results as well as how you can track your system information, see Chapter 6.
	· Understanding the concepts used to develop WinBench, such as profiling, see Chapter 7. This chapter also notes some things the tests do not do.
	· Comparing your PC's test results to test results from other PCs, see 
Chapter 8.

	Chapter 4 Working with WinBench's Results
	· View them using either the Chart of Results or the Table of Results.
	· Print them.
	· Save them.
	· Compare results from different test runs.
	· Baseline Machine. The baseline machine is the set of test results against which WinBench is comparing all other sets of test results in the Chart of Results. If you choose the Normalize option, WinBench sets the baseline machine's results to 1.0 and normalizes all the other open sets of results so that they appear in the chart as a fraction of the baseline machine's results. For example, if you compare three sets of results, the results for the baseline machine are always 1.0 in the chart; a slower test result might appear as 0.945 and a faster test result might appear as 1.07.
	· Current Results. WinBench uses this term to refer to the results for the tests you ran most recently during this WinBench session. When you want to save your current results to a file, you must change the Test Description to something other than "Current Results."
	Reading the test results
	NOTE: If you haven't run any tests, you can still use the Display Results button to open the results windows. Once the windows are open, you can either close them or minimize them so they appear as icons on your WinBench screen. If you close them, you can use the Display Results button again to open them.
	The Chart of Results
	The Table of Results
	1. All the weighted test suites (i.e., the Graphics WinMark and the Disk WinMark), their scores, and the units (such as millions of pixels per second or thousands of bytes per second) for the scores.
	NOTE: WinBench computes the WinMark scores whenever you successfully run all the tests in a WinMark suite. In fact, if you are running individual tests, even in separate test runs, once you have run all the tests that compose a WinMark suite, WinBench computes that WinMark score and displays the score. As a result, you do not always need to explicitly run the Graphics WinMark suite or the Disk WinMark suite for WinBench to produce a score for these tests.

	2. All the individual tests that WinBench performed, their scores, and the units for the scores, such as "Thousand Bytes/sec" or "Million Pixels/sec." Next to the scores, WinBench displays numbers representing Notes about factors that might have affected the test results.
	3. A list of Note numbers and an explanation of what those Notes mean. WinBench uses Notes to tell you about things that happened during the test that might have affected the test results. For example, if you move the mouse during a test, WinBench will include a Note next to that test's results to tell you about mouse motion.
	Displaying different combinations of test results
	· Display a list of all tests that WinBench contains regardless of whether you have run them. To do this:
	· Display a list of just the WinMark tests regardless of whether you have run them. To do this:
	· Display the results for all the tests that you have run during this WinBench session. To do this:
	· Display the test results for the currently selected tests. By default, when you select this option, WinBench displays the tests it just ran. If you want to specify a different set of tests:

	Printing your PC's test results
	1. Activate the Chart of Results window by clicking in it.
	2. Select the option Print from the File menu.
	NOTE: If you need to set up your printer, select Printer Setup from the File menu before you select Print. You can only print to the default printer.

	1. Copy the information to the Windows clipboard using the Copy option in the Edit menu.
	2. Paste that information into a file you opened from an application such as Notepad.
	3. Print the information from that application.

	Creating a set of comparison results
	NOTE: To make valid comparisons between different PCs, you should generally run WinBench on both PCs the same way. For example, if you run the Disk WinMark suite on one PC with software disk caching enabled and on another PC with software disk caching disabled, you won't learn much about the relative speeds of the two disk subsystems. On the other hand, if you just want to see what effect a software disk cache has on your PC's disk subsystem, run the Disk WinMark on that PC with and without a software disk cache enabled.
	You can check the setup of each PC by looking at the information in the WinBench Disclosure window. To see this information, select Disclosure from the File menu. (WinBench stores the current disclosure information at the end of each results file.)
	Saving your test results

	· A tab-delimited format suitable for use by Microsoft Excel (.XLS).
	· A comma-delimited format suitable for use by Excel or Lotus 1-2-3 (.CSV).
	· A plain text file (.TXT).
	· A Windows metafile (.WMF).
	Using the Table of Results to save files
	NOTE: If you use another application to change anything in the results file, WinBench may no longer be able to read the file.

	1. Open the Disclosure Questionnaire dialog box. There are two ways to do this:
	2. Enter a description or name in the box next to Test Description.
	NOTE: WinBench uses the text you enter here as the Comparison Machine name when you use the Compare option in either the Chart or Table menu.

	3. Select OK.
	4. Open the Table of Results Window.
	5. Select Save As from the File menu. WinBench displays the Save Results in File dialog box.
	6. Specify the drive on which you want to save your results file, the directory in which you want to save your results in, and the name of the results file. By default, WinBench saves your file in the WinBench subdirectory RESULTS.
	You also need to specify the format in which you want to save the file. To save the file in:
	You can later open the results file with WinBench regardless of the format in which you saved it. You can also open the results file outside of WinBench using any application that accepts the file's format. For example, if you saved the file in .XLS format, then you can open the file with Excel.
	7. Select OK.
	If you want to save these results in more than one file format, repeat steps 5 through 7.
	Using the Chart of Results to save files

	1. Make the Chart of Results window the active window.
	2. Select the option Save As from the Chart menu. The Save Chart as Metafile dialog box appears on your screen.
	3. Specify the drive on which you want to save the chart, the directory in which you want to save the chart, and the name of the file. Since you are saving the chart as a Windows metafile, give its name an extension of .WMF.
	4. Select OK.
	Adding results files from other PCs
	NOTE: The window for the Chart of Results or the Table of Results must be active for you to be able to use the Compare feature.


	Comparing results files
	Adding a results file to the results windows
	1. Open either the Chart of Results or the Table of Results window.
	NOTE: If you add a results file to either the Chart of Results or the Table of Results, WinBench displays the file in both results windows.

	2. Select either Chart (for the Chart of Results window) or Table (for the Table of Results window) from the menu bar.
	3. Select the option Compare. The Comparison Machines window appears.
	4. Select Add. The Open Comparison File dialog box appears.
	5. Specify the name of the file you want to add. WinBench lists all the files in the WINBENCH:RESULTS directory that have a .TXT, .CSV, or .XLS extension. You can change to another directory.
	6. Once you have selected the file you want and it appears in the File Name box, select OK. WinBench returns you to the Comparison Machines dialog box and displays the information you entered in the Test Description box in the Questionnaire window.
	7. You can add another comparison machine or remove a comparison machine:
	8. Click on OK when the Comparison Machines dialog box contains the machine (or machines) you want. WinBench adds the results information to the two results windows and you are done.
	Removing a set of results from the results windows
	1. Select the option Compare from either the Chart (Chart of Results) or the Table (Table of Results) menu. The Comparison Machines dialog box appears. Under the heading Comparison Machines, WinBench lists the names of all the open results files.
	2. Highlight the name of the results file you want to remove from the Chart of Results and the Table of Results.
	3. Click on Remove.
	NOTE: Clicking on Remove closes a currently open results file. It does not delete a results file from your PC.
	If you want to remove another results file, repeat steps 2 and 3.

	4. Click on OK when you have removed all the results files you want to remove.

	Normalizing your test results
	Specifying a baseline machine
	NOTE: You can only select a baseline machine for the Chart of Results. You cannot display normalized results in the Table of Results.

	1. Select the option Baseline from the Chart menu. WinBench displays the Baseline Machine dialog box.
	2. Select the name of the set of results you want to use for the baseline machine from the drop-down list of open results files.
	3. Click on OK.

	What's next
	· How to read the WinBench results in both the Chart of Results and the Table of Results.
	· How to print your test results.
	· How to save your test results to a file you can later open from within WinBench or from within a text editor, spreadsheet, or word-processing application. It also explained how to save your file as achart that you can open later with any application that accepts Windows metafile format.
	· How to compare different results files.
	· How to specify a baseline machine against which WinBench normalizes all other test results.
	· Understanding the results you get when you run the WinBench tests, see Chapter 5 and Appendix A.
	· Determining what affects your WinBench results as well as how you can track your system information, see Chapter 6.
	· Understanding the concepts used to develop WinBench, such as profiling, see Chapter 7. This chapter also notes some things the tests do not do.
	· Comparing your PC's test results to test results from other PCs, see 
Chapter 8.

	Chapter 5 Understanding WinBench's Results
	The Graphics WinMark
	· The market shares of the profiled applications that use the GDI calls being tested. An application's unit market share represents that application's percentage of the total number of products sold in that category of applications, such as spreadsheet programs. Thus, if one application has a higher unit market share than another application, the operation the first application performs most frequently will have a higher weight than the operation the second application performs most frequently (assuming that these are two different operations).
	· The frequency of the operation's usage by the profiled applications.
	The Disk WinMark
	WinBench's individual tests
	NOTE: When you run any of the individual tests, WinBench does not weight the test results. WinBench uses weights only when you run the Graphics WinMark.
	The graphics tests
	The disk tests

	WinBench's built-in test suites
	What's next
	· The Graphics WinMark.
	· The Disk WinMark.
	· The individual tests.
	· Determining what affects your WinBench results as well as how you can track your system information, see Chapter 6.
	· Understanding the concepts used to develop WinBench, such as profiling, see Chapter 7. This chapter also notes some things the tests do not do.
	· Comparing your PC's test results to test results from other PCs, see 
Chapter 8.

	Chapter 6 What Affects WinBench's Results
	Factors that influence the test scores
	· Operating system version
	· Windows system, including your PC's Windows graphics driver software
	· Processor type and speed
	· Off-chip processor cache (if any)
	· Amount of RAM
	· Type of hardware bus or buses
	· Type of hard disk
	· Type of hard disk controller and size of your PC's hardware disk cache (if any)
	· Disk fragmentation
	· Video adapter and the amount and type of RAM (DRAM or VRAM) on it
	· Video resolution and color depth
	· Refresh rate
	· Size, type, and version of software disk cache (if any)
	· Any other special conditions, such as enabled disk compression utilities
	Major factors that can affect the Graphics WinMark

	· Operating system
	· Windows system
	· Type of computer
	· Processor
	· Processor speed
	· Off-chip processor cache, if any
	· Processor RAM
	· Type of hardware bus
	· Video driver
	· Video adapter
	· Video DRAM
	· Video VRAM
	· Video refresh rate
	· Video resolution and color depth
	· Video driver options
	Major factors that affect the Disk WinMark

	· Operating system
	· Windows system
	· Type of computer
	· Processor
	· Processor speed
	· Off-chip processor cache, if any
	· Processor RAM
	· Type of hardware bus
	· Hard disk
	· Hard disk controller
	· Hard disk controller RAM
	· Amount of controller cache memory
	· Type, version, and size of the software disk cache (if any)
	· Disk fragmentation
	Tracking your system information
	Viewing information about your PC's configuration

	· Select Disclosure from the File menu.
	· Click on the Disclosure button in the Chart of Results window or the Table of Results window.
	Modifying information about your system configuration

	· Select Questionnaire from the File menu.
	· Click on the Edit button in the Disclosure window.
	· Test Description. Enter a description of your PC. For example:
	COMPAQ DESKPRO 66M, 1024x768 256 colors
	You can enter a special name here to identify this run of WinBench. This is the information WinBench displays if you later use the Compare feature to add or remove test results for a comparison machine.
	· Computer. Enter the type of computer you are using.
	· Processor. Enter the type of processor in your PC.
	· Processor Speed. Enter the speed of your PC's processor.
	· Off-Chip Processor Cache. Enter the size of this cache, if you have one on your PC. (WinBench cannot determine this value.)
	· Processor RAM. Enter the amount of RAM in your PC.
	· Video Adapter. Enter information about the video adapter your PC uses. For example:
	COMPAQ QVision 1024x768 256 colors
	· Video DRAM. Enter the amount of dynamic RAM your video adapter has, if any. (WinBench cannot determine this value.)
	· Video VRAM. Enter the amount of video RAM your video adapter has, if any. (WinBench cannot determine this value.)
	· Video Refresh Rate. Enter your PC's video refresh rate. (WinBench cannot determine this value.)
	· Hard Disk. Enter the name of the maker of your PC's hard disk and its name or model number. (WinBench cannot determine this value.)
	· Hard Disk Controller. Enter the name of the maker of your PC's hard disk controller and its name or model number. (WinBench cannot determine this value.)
	· HD Controller Cache Size. Enter the amount of hardware disk cache, if any, on your PC's hard disk controller. (WinBench cannot determine this value.)
	· Software Disk Cache. Enter the name of the software disk cache your PC uses, if any. WinBench will detect SMARTDrive, but not any other software disk caches.
	· Software Cache Size. Enter the size of your software disk cache, if any.
	· Additional Comments. Enter any comments you have about this test run.
	NOTE: You can only modify information for your current set of test results. You cannot change the information in any of the currently open comparison results files.
	Contents of the Disclosure window

	· Name (i.e., Test Description).
	· Benchmark. WinBench automatically fills in its name and version number.
	· Operating System. WinBench automatically fills in the version of the operating system you are using.
	· Windows System. WinBench automatically fills in the version of your operating system and the mode in which you are running it.
	· Computer.
	· Processor.
	· Processor Speed.
	· Off-Chip Processor Cache.
	· Processor RAM.
	· Video Driver.
	· Video Adapter.
	· Video DRAM.
	· Video VRAM.
	· Video Refresh Rate.
	· Video Mode.
	· Hard Disk.
	· Hard Disk Controller.
	· HD Controller Cache Size.
	· Software Disk Cache.
	· Software Cache Size.
	· Description. WinBench displays the Test Description you entered when you saved your results to a file.
	· Time. WinBench automatically enters the time at which you started the WinBench session.
	· Registered Name. WinBench automatically enters the name you entered when you registered your copy of WinBench.
	· Registered Organization. WinBench automatically enters the name of the organization (if any) you entered when you registered your copy of WinBench.
	· Tester Name. WinBench automatically enters as the default the name you entered when you registered your copy of WinBench. When you run WinBench as a batch file using the RUNWB.INI file, you can specify the Tester Name.
	· Tester Organization. WinBench automatically enters as the default the name of the organization (if any) you entered when you registered your copy of WinBench. When you run WinBench as a batch file using the RUNWB.INI file, you can specify the Tester Organization.
	· Comments. WinBench displays any comments you entered when you modified the Disclosure Questionnaire.
	· System Metrics. WinBench displays information about the system metrics, such as the height and width of objects on the screen. This information is useful to programmers.
	· Video Capabilities. WinBench displays information about what your video device driver is capable of doing, such as the number of colors it can support and objects it can draw. For example, if your video device driver cannot draw filled polygons, then the GDI needs to handle that operation. This information is useful to programmers.
	· Disk Settings. WinBench displays information about your PC's disk settings that may affect how the disk tests perform. This information comes from the file SYSTEM.INI.
	Printing the system information
	1. Save your current results to a file. (See Chapter 4 for information on how to do this.)
	2. Start an editor (such as NotePad), word-processor application, or a spreadsheet application.
	3. Open the results file from within that application.
	4. Print the results file using that application's print command.
	NOTE: If you saved your results as a text file, WinBench includes copies of your AUTOEXEC.BAT, CONFIG.SYS, WIN.INI, and SYSTEM.INI files in the results file. WinBench does not include these system files when you save your results as a .XLS or .CSV file.

	Requirements for publishing WinBench results

	Reference hardware platform
	What's next
	· The major factors that affect the Graphics WinMark.
	· The major factors that affect the Disk WinMark.
	· How WinBench records some information about your system configuration and stores the information in results file.
	· How you can modify the system information for your current results.
	· How to print your system information.
	· Understanding the concepts used to develop WinBench, such as profiling, see Chapter 7. This chapter also notes some things the tests do not do.
	· Comparing your PC's test results to test results from other PCs, see 
Chapter 8.

	Chapter 7 Concepts Behind the WinBench Tests
	Design goals behind the tests
	NOTE: You play the biggest role in generating valid comparison results. If you are switching subsystem components, make sure that everything else is the same on your PC except the subsystem component you want to test. If you are comparing different PCs, run WinBench with the same system setup on all of the PCs; otherwise, comparisons will not be valid. For example, if you run the Disk WinMark on one PC with software disk caching enabled and you run it on a second PC with software disk caching disabled, you will not get a valid comparison. This is because disk caching can significantly affect your disk score.
	To ensure that you have the same system configuration on all the test PCs, check the information in WinBench's Disclosure window.

	· They use operations that leading applications perform as their basis.
	· They use application profiling to determine the most commonly used operations.
	· They duplicate attributes, such as the types of Graphics Device Interface (GDI) operations, of the profiled applications.
	· They duplicate the types of disk operations the applications perform.
	· They vary the operations each test performs to reflect the way applications actually use operations.
	· They use weighted harmonic means to report the Graphics WinMark score.
	Using leading applications to determine test operations
	NOTE: Infocorp, an independent software industry research division of Ziff-Davis. supplied the research data that determined the historical and projected unit market shares for the categories Winstone 94 uses and for the applications within those categories.

	Profiling applications

	· The types of operations the applications perform.
	· The typical parameters of those operations (including the distribution and frequency of the parameters).
	· The number of operations the application scripts perform.
	· The number of pixels the operations draw.
	· How the applications interact with the GDI and USER components of Windows. The profiling tools trace every GDI and USER operation an application performs in the order the application performs it.
	NOTE: The log files contain all USER calls made by both the applications and the DLLs they use.

	· The parameters and return values for most of these operations.
	Using parameter distributions in the tests
	Actions modeled by the graphics tests
	Determining the GDI calls

	· The Graphics WinMark suite. This test suite mixes GDI calls to mimic the frequency of those calls in the applications. The Combined GWM Tests that make up this suite also attempt to match the application's typical parameters for those calls. In addition, WinBench assigns weights to the Combined GWM Tests based on data from the application profiles.
	· The Individual Combined GWM Tests. You can run each of the seven Combined GWM Tests that make up the Graphics WinMark separately. Each tests contains a mix of GDI calls that mimic how frequently actual applications make the different GDI calls. Thus, in these tests, some GDI calls occur a great deal while others only occur a few times.
	· Individual graphics tests. WinBench includes a large number of individual tests that exercise almost all the GDI calls available in Windows. The built-in graphics suites (GWM Tests and GDI Tests) also exercise these calls. See Appendix A for information on these tests.
	Graphics test parameters
	Using weighted harmonic means
	The Disk Mix
	How the individual disk tests work

	What the tests don't do
	What's next
	· The process used to select applications for profiling.
	· How the tests use distribution of parameters.
	· The actions that the graphics tests model.
	· How the Graphics WinMark uses a weighted harmonic mean.
	· What went into designing the Disk Mix.
	· What WinBench's tests don't do.
	· Comparing your PC's test results to test results from other PCs, see 
Chapter 8.

	Chapter 8 How Does Your PC Compare
	Checking published results
	Using multiple PCs
	NOTE: If you are comparing WinBench results on different PCs, make sure the PCs used the standard system setups. Otherwise, your comparisons may not be meaningful.

	Why results differ
	Which differences matter to you

	· What is appropriate for your system and the work you do? If most of your work does not rely heavily on a specific subsystem, then you probably should not worry about the speed differences.
	· How much of a difference will a particular subsystem really make to your overall application performance? WinBench tests the speed of the subsystems. Even if you change a component of one of the subsystems and get a faster WinBench score, you will not usually get the same of amount of improvement in the speed of an application. This is because WinBench only measures the speed of the graphics, text, and disk operations, not all the operations an application performs. Thus, the improvement you are likely to see if, for example, you switch to a faster graphics subsystem will depend on how much time the application performs graphics and text operations. If the application does not spend much time doing these operations, then you are not likely to see a large improvement.
	Publishing WinBench results
	Using WinBench with other benchmarks
	What's next
	· Where to find published reports on WinBench.
	· How you can use multiple PCs to compare results.
	· What you must include if you publish WinBench results.
	· Learn more about all the WinBench tests by reading Appendix A.
	· Discover some troubleshooting tips in Appendix B.
	· Learn how to request benchmarks and order printed manuals as well as how to contact ZDBOp by reading Appendix C.

	Appendix A A Closer Look at the Tests
	The names of all the WinBench tests
	· Graphics WinMark. Contains the Combined GWM Tests (1-7).
	· Disk WinMark. Contains the Disk Mix test.
	· All WinMarks. Contains the Graphics WinMark suite and the Disk WinMark suite.
	· All Tests. Contains every test available in WinBench.
	· Disk Tests. Contains the Disk Mix test and all the sequential and random read and write disk tests.
	· GDI Tests. Contains all the individual tests that perform GDI operations that the profiled applications did not use or that are not based on the profiled applications.
	· GWM Tests. Contains all the individual operation tests that are included in the seven Combined GWM Tests that comprise the Graphics WinMark. (Unlike the Combined GWM Tests, this test suite does not intermix the operations to reflect profiling information.)
	· USER Tests. Contains all the individual tests that exercise Windows USER calls.
	· The term "aligned" means that the horizontal start and end points of a rectangle are multiples of 8 pixels from the left side of the screen. As a result, the width of the rectangle itself is a multiple of 8 pixels. Some hardware handles operations that occur on aligned rectangles more efficiently than operations that manipulate unaligned rectangles.
	· The term "unaligned" means the objects in question had no forced starting or ending points.
	· The term "rounded" in a test using a square or a rectangle means that the corners have been rounded.
	· The term "other" indicates that the test uses several common operations.
	· The term "mono" in a test name indicates the memory bitmap used in the test is a monochrome image instead of a color image.
	· In the text tests, WinBench displays the name of the test, the font name, and height of the font in pixels. If there is another number, it is the angle of the text. For example, "TextOut, Arial 10, 45" displays text at a 45 degree angle in Arial font that is 10 pixels high.
	· The term "System" is the name of a font. For example, the test "GWM/TextOut, System" is an individual GWM Tests suite that displays text in System font.
	· All the test names that begin "GWM/" are part of the GWM Tests suite. For example, GWM/Line, Diagonal is an individual GWM Test that draws diagonal lines using parameters (such as line length) based on parameters found in the application profiles.
	· In the GWM/ExtTextOut, Square and the GWM/ExtTextOut, Rectangle tests, WinBench does not write any text. It uses this call to draw a rectangle with solid colors (i.e., no dithering). Profiling indicated that many applications use this method for drawing rectangles.
	· Tests involving squares are actually rectangle operation tests that WinBench forced to use squares.
	· BitBlt test names that include the letters "MS" move images from memory to the screen. BitBlt test names that include the letters "SM" move images from the screen to memory. BitBlt test names that include the letters "SS" move the images from screen to screen.
	· In the disk tests, the number of bytes indicates the size of the block that the test uses. For example, "Disk, Write, Sequential, 512 bytes" writes 512 bytes of data sequentially.
	· The term "Few-sides" indicates that a region has fewer than 16 sides while "HVD" indicates that the region contains horizontal (H), vertical (V), and diagonal (D) sides. For example, in the test "PaintRgn, Few-sides, HV" WinBench paints a region that has fewer than 16 sides, which are both horizontal and vertical.
	WinBench's graphics tests
	· Suites that reflect how the profiled applications used operations. These suites vary the test parameters they use in the same ways the profiled applications varied those parameters.
	· Suites that test operations the profiled applications did not use. These tests are useful for comparing similar operations and evaluating the speed of the operations the profiled applications did not use.
	The Graphics WinMark operations

	· Each Combined GWM Test is a single test that mixes different Windows graphics functions.
	The GWM Tests is a test suite that executes a single test for each graphics function.
	· The Combined GWM Tests reflect information received from profiling leading Windows applications. Each Combined GWM Tests varies how often a graphics operation occurs in the test mix to reflect how often the operation occurred in the profiled applications.
	The GWM Tests suite does not weight the operations or vary their frequency. It simply executes these operations one at time. Thus, this suite does not reflect how the profiled applications actually used these GDI operations.
	Combined GWM1 Test A (pixel weight determined by profiling applications=Na) Test B (pixel weight determined by profiling applications=Nb) Test C (pixel weight determined by profiling applications=Nc)
	Combined GWM2 Test D (pixel weight determined by profiling applications=Nd) Test E (pixel weight determined by profiling applications=Ne) Test F (pixel weight determined by profiling applications=Nf) Test G (pixel weight determined by profiling applicationst=Ng)
	Combined GWM1
	GWM/FillRgn, Rectangular
	NOTE: The Combined GWM1 test only contains one operation for historical reasons.

	Combined GWM2
	GWM/Ellipse GWM/PatBlt, ROP(0A), Unaligned GWM/StretchDIBits, 4 bpp, SRCCOPY, Unaligned
	Combined GWM3
	GWM/PatBlt, PATINVERT, Aligned GWM/Pie, Elliptical GWM/Rectangle, Rounded GWM/Square, Rounded GWM/PatBlt, Other, Unaligned GWM/BitBltMS, Other, Aligned GWM/BitBltSM, SRCCOPY, Aligned GWM/BitBltMonoSM, SRCCOPY, Unaligned GWM/BitBltMonoSM, SRCCOPY, Aligned GWM/BitBltMonoMS, SRCAND, Aligned GWM/PaintRgn, Rectangular
	Combined GWM4
	GWM/PolyPolygon GWM/PatBlt, ROP(A0), Unaligned GWM/PatBlt, DSTINVERT, Aligned GWM/BitBltSS, SRCCOPY, Unaligned GWM/BitBltSM, SRCCOPY, Unaligned GWM/BitBltMonoMS, SRCCOPY, Aligned GWM/StretchBltMS, SRCCOPY, Unaligned GWM/SetDIBitsToDevice, 4 bpp, Unaligned GWM/InvertRgn, Rectangular GWM/PaintRgn, Polygonal
	Combined GWM5
	GWM/Polygon, Many-sides GWM/Square GWM/ExtTextOut, Square GWM/PatBlt, WHITENESS, Unaligned GWM/PatBlt, WHITENESS, Aligned GWM/BitBltSS, SRCCOPY, Aligned GWM/BitBltMS, SRCCOPY, Aligned GWM/BitBltMS, Other, Unaligned GWM/StretchBltMonoMS, SRCAND, Unaligned GWM/StretchBltMonoMS, SRCPAINT, Unaligned GWM/InvertRgn, Polygonal GWM/TextOut, Times New Roman 16 GWM/TextOut, System GWM/TextOut, Times New Roman 11 GWM/TextOut, MS Sans Serif Bold 11 GWM/TextOut, MS Sans Serif 11
	Combined GWM6
	GWM/Polygon, Few-sides GWM/PolyLine GWM/Line, Diagonal GWM/Rectangle GWM/PatBlt, DSTINVERT, Unaligned GWM/PatBlt, BLACKNESS, Unaligned GWM/PatBlt, ROP(A5), Unaligned GWM/PatBlt, PATCOPY, Aligned GWM/BitBltMS, SRCCOPY, Unaligned GWM/BitBltMonoMS, SRCCOPY, Unaligned GWM/BitBltMonoMS, Other, Unaligned GWM/ExtTextOut, MS Sans Serif 13 GWM/ExtTextOut, Times New Roman 16 GWM/ExtTextOut, System GWM/ExtTextOut, Times New Roman 11 GWM/ExtTextOut, MS Sans Serif Bold 11 GWM/ExtTextOut, MS Sans Serif 11 GWM/TextOut, Times New Roman 13 GWM/TextOut, MS Sans Serif 13
	Combined GWM7
	GWM/Line, Horizontal GWM/Line, Vertical GWM/ExtTextOut, Rectangle GWM/PatBlt, PATINVERT, Unaligned GWM/PatBlt, PATCOPY, Unaligned GWM/ExtTextOut, Times New Roman 13
	The GWM Tests
	NOTE: Pixel weight is based on the number of pixels drawn using the operations in the profiled applications.


	GWM/PatBlt, PATINVERT, Aligned GWM/Square, Rounded GWM/PatBlt, Other, Unaligned GWM/Rectangle, Rounded GWM/DrawFocusRect GWM/BitBltMonoSM, SRCCOPY, Unaligned GWM/BitBltMonoMS, SRCAND, Aligned GWM/StretchDIBits, 4 bpp, SRCCOPY, Unaligned GWM/BitBltMS, Other, Aligned GWM/PolyLine GWM/StretchBltMS, SRCCOPY, Unaligned GWM/PatBlt, ROP(A0), Unaligned GWM/Ellipse GWM/ExtTextOut, Square GWM/Line, Diagonal GWM/Square GWM/Pie, Elliptical GWM/PolyPolygon GWM/BitBltMonoSM, SRCCOPY, Aligned GWM/PatBlt, ROP(A5), Unaligned GWM/PatBlt, DSTINVERT, Aligned GWM/BitBltSM, SRCCOPY, Unaligned GWM/StretchBltMonoMS, SRCAND, Unaligned GWM/StretchBltMonoMS, SRCPAINT, Unaligned GWM/BitBltMS, Other, Unaligned GWM/BitBltMonoMS, SRCCOPY, Aligned GWM/SetDIBitsToDevice, 4 bpp, Unaligned GWM/PatBlt, ROP(0A), Unaligned GWM/Line, Vertical GWM/Polygon, Many-sides GWM/TextOut, Times New Roman 11 GWM/TextOut, MS Sans Serif Bold 11 GWM/BitBltSM, SRCCOPY, Aligned GWM/TextOut, MS Sans Serif 11 GWM/TextOut, System GWM/PatBlt, BLACKNESS, Unaligned GWM/PatBlt, PATINVERT, Unaligned GWM/TextOut, Times New Roman 16 GWM/BitBltMonoMS, Other, Unaligned GWM/InvertRgn, Rectangular GWM/TextOut, MS Sans Serif 13 GWM/PaintRgn, Rectangular GWM/FillRgn, Rectangular GWM/PaintRgn, Polygonal GWM/BitBltMS, SRCCOPY, Aligned GWM/Line, Horizontal GWM/Polygon, Few-sides GWM/TextOut, Times New Roman 13 GWM/ExtTextOut, Times New Roman 11 GWM/ExtTextOut, MS Sans Serif Bold 11 GWM/ExtTextOut, MS Sans Serif 11 GWM/ExtTextOut, System GWM/PatBlt, DSTINVERT, Unaligned GWM/ExtTextOut, Times New Roman 16 GWM/PatBlt, WHITENESS, Unaligned GWM/BitBltMS, SRCCOPY, Unaligned GWM/InvertRgn, Polygonal GWM/BitBltSS, SRCCOPY, Unaligned GWM/ExtTextOut, MS Sans Serif 13 GWM/PatBlt, WHITENESS, Aligned GWM/BitBltMonoMS, SRCCOPY, Unaligned GWM/BitBltSS, SRCCOPY, Aligned GWM/ExtTextOut, Times New Roman 13 GWM/ExtTextOut, Rectangle GWM/Rectangle GWM/PatBlt, PATCOPY, Aligned GWM/PatBlt, PATCOPY, Unaligned
	The GDI Tests

	· Ellipse drawing tests. These tests draw GDI objects based on ellipses or parts of ellipses. For example, you can use the Arc tests to compare the difference in performance in graphics cards or drivers that have hardware or accelerated curve drawing operations and cards or drivers that do not.
	Arc, Circular, Partial Arc, Elliptical, Partial Arc, Circular, Complete Arc, Elliptical, Complete Chord, Circular Chord, Elliptical Circle Ellipse Pie, Circular Pie, Elliptical
	· The PatBlt tests. These tests draw patterns on the screen using several different parameters. PatBlt is a simple version of a BitBlt; however, PatBlt just uses a brush to draw the objects. It does not have a source the way BitBlt does. PATCOPY is a relatively important operation that draws the background of Windows. The PATCOPY tests copy a pattern (brush) into a rectangular pattern on the screen. The PATINVERT tests copy inverted patterns. Inverting a pattern object means that all ones are replaced by zeroes and all zeroes are replaced by ones. The WHITENESS and BLACKNESS tests simply fill the background with white or black; PatBlt does not use a brush in these tests. Since the distribution of parameters in these tests is the same, you can compare the PatBlt tests results with each other.
	PatBlt, PATCOPY, Aligned PatBlt, PATINVERT, Aligned PatBlt, DSTINVERT, Aligned PatBlt, BLACKNESS, Aligned PatBlt, WHITENESS, Aligned PatBlt, PATCOPY, Unaligned PatBlt, PATINVERT, Unaligned PatBlt, DSTINVERT, Unaligned PatBlt, BLACKNESS, Unaligned PatBlt, WHITENESS, Unaligned
	· Geometric figure drawing. This set of tests consists of geometric shapes you can draw with GDI calls. The Polygon tests exercise polygon filling operations that business graphics and drawing software often use. (To draw squares, WinBench uses the rectangle operation and forces the width to match the height.)
	Polygon, Many-sides Polygon, Few-sides Polygon, Triangle Polygon, Trapezoid PolyPolygon Rectangle Square Rectangle, Rounded Square, Rounded
	· Text drawing operations. These tests use the Arial font to draw text at horizontal (0 degrees), vertical (90-degree), and diagonal (45-degree) angles. (The 10 indicates the font height in pixels). You can use these tests to see how much longer it takes to draw text at an angle.
	TextOut, Arial 10 TextOut, Arial 10, 45 TextOut, Arial 10, 90
	· BitBlt tests (screen to screen). These tests perform Boolean operations between a source and destination area of the screen. The source copy (SRCCOPY) operation is important because scrolling uses that operation. WinBench defines two rectangles of the same size on the screen, one as the source and the other as the destination. The tests then move blocks from the source to the destination. Since all BitBlt tests use the same parameter distributions, you can compare the results of these tests to the results of other BitBlt tests.
	BitBltSS, SRCCOPY, Aligned BitBltSS, SRCCOPY, Unaligned BitBltSS, SRCINVERT, Aligned BitBltSS, SRCINVERT, Unaligned BitBltSS, PATPAINT, Aligned BitBltSS, PATPAINT, Unaligned BitBltSS, Other, Aligned BitBltSS, Other, Unaligned
	· BitBlt tests (memory to screen and screen to memory). These tests perform BitBlt operations between an off-screen bitmap and the screen. You can compare the results of these tests to the results of other BitBlt tests.
	BitBltMS, SRCCOPY, Aligned BitBltMS, SRCCOPY, Unaligned BitBltMS, SRCINVERT, Aligned BitBltMS, SRCINVERT, Unaligned BitBltMS, PATPAINT, Aligned BitBltMS, PATPAINT, Unaligned BitBltMS, Other, Aligned BitBltMS, Other, Unaligned BitBltSM, SRCCOPY, Aligned BitBltSM, SRCCOPY, Unaligned BitBltSM, SRCINVERT, Aligned BitBltSM, SRCINVERT, Unaligned BitBltSM, PATPAINT, Aligned BitBltSM, PATPAINT, Unaligned BitBltSM, Other, Aligned BitBltSM, Other, Unaligned BitBltMonoMS, SRCCOPY, Aligned BitBltMonoMS, SRCCOPY, Unaligned BitBltMonoMS, SRCINVERT, Aligned BitBltMonoMS, SRCINVERT, Unaligned BitBltMonoMS, PATPAINT, Aligned BitBltMonoMS, PATPAINT, Unaligned BitBltMonoMS, Other, Aligned BitBltMonoMS, Other, Unaligned BitBltMonoSM, SRCCOPY, Aligned BitBltMonoSM, SRCCOPY, Unaligned BitBltMonoSM, SRCINVERT, Aligned BitBltMonoSM, SRCINVERT, Unaligned BitBltMonoSM, PATPAINT, Aligned BitBltMonoSM, PATPAINT, Unaligned BitBltMonoSM, Other, Aligned BitBltMonoSM, Other, Unaligned
	· StretchBlt tests. These tests are like the BitBlt tests except that the source and destination areas do not need to be the same size; WinBench can stretch or shrink the source into the destination. These tests are normally slower than the BitBlt tests. You can compare the results of different StretchBlt Tests with each other.
	StretchBltSS, Other, Aligned StretchBltSS, Other, Unaligned StretchBltMS, Other, Aligned StretchBltMS, Other, Unaligned StretchBltSM, Other, Aligned StretchBltSM, Other, Unaligned StretchBltMonoMS, Other, Aligned StretchBltMonoMS, Other, Unaligned StretchBltMonoSM, Other, Aligned StretchBltMonoSM, Other, Unaligned
	· Device Independent Bitmap (DIB) tests. These tests measure the speed at which WinBench can draw DIBs on the screen. DIBs are bitmap images like those produced by Paintbrush that you can build using independent Windows screen devices. You can compute the speed of drawing DIBs with different color depths (1, 4, 8, or 24 bits per pixel) using the various operations GDI supplies.
	SetDIBitsToDevice, 1 bpp, Unaligned SetDIBitsToDevice, 4 bpp, Unaligned SetDIBitsToDevice, 8 bpp, Unaligned SetDIBitsToDevice, 24 bpp, Unaligned SetDIBitsBlt, 1 bpp, Unaligned SetDIBitsBlt, 4 bpp, Unaligned SetDIBitsBlt, 8 bpp, Unaligned SetDIBitsBlt, 24 bpp, Unaligned BltDIBits, 1 bpp, SRCCOPY, Unaligned BltDIBits, 4 bpp, SRCCOPY, Unaligned BltDIBits, 8 bpp, SRCCOPY, Unaligned BltDIBits, 24 bpp, SRCCOPY, Unaligned StretchDIBits, 1 bpp, SRCCOPY, Unaligned StretchDIBits, 4 bpp, SRCCOPY, Unaligned StretchDIBits, 8 bpp, SRCCOPY, Unaligned StretchDIBits, 24 bpp, SRCCOPY, Unaligned
	· Line drawing tests. Line drawing operations are some of the most frequently used Windows graphics operations. One way you can use the line drawing tests is to see the difference in performance between graphics cards that have hardware support for line drawing operations and those cards that don't. The diagonal, horizontal, and vertical tests use lines that are the same length. This approach lets you compare the results from these tests. The PolyLines tests draw a mixture of connected line segments. Many drawing applications use PolyLines to simulate curved lines.
	Line, Diagonal Line, Horizontal Line, Vertical PolyLine
	· Flood Fill tests. These tests involve filling an area on a screen until the GDI call reaches a border on the screen that is a particular color or reaches an area on the screen that is a different color from the fill color. The ExtFlood Fill, Border test starts at a point on the screen and fills the screen with a color until it reaches a black border.The ExtFloodFill, Surface test starts at a point on the screen and fills the screen with a new color as long as the original color remains the same. The FloodFill test is an older GDI call that is equivalent to the ExtFloodFill, Border test.
	ExtFloodFill, Border ExtFloodFill, Surface FloodFill
	· Region tests. These tests invert, fill, and frame regions. A region consists of an area composed of an arbitrary set of rectangles. If the test has HV in its name, the region contains predominately horizontal and vertical sides. If the test has HVD in its name, the region contains horizontal, vertical, and diagonal sides. When a region contains diagonal lines, each scan line becomes a rectangle, which slows down the test. The term "Few-sides" indicates that the region contains fewer than 16 sides.
	
	InvertRgn, Few-sides, HV PaintRgn, Few-sides, HV PaintRgn, Few-sides, HVD PaintRgn, Rectangular FillRgn, Few-sides, HV FrameRgn, Few-sides, HV
	· Miscellaneous tests.
	Pixel, Set This test sets a pixel to a color.
	Pixel, Get This test retrieves the color of a pixel on the screen.
	MoveTo MoveToEx These two tests do not perform any drawing; they change the current drawing position.
	GetNearestColor This operation determines the nearest color to a specified color that the system being tested can reproduce.
	FastWindowFrame Not all video drivers implement this operation. Therefore, you should not worry if you get an error message during this test. This operation draws a rectangular border for a window.
	The USER Tests

	· Text tests. (Remember that the number indicates the height of the font in pixels.)
	DrawText, Times New Roman 13 DrawText, MS Sans Serif 13 DrawText, Times New Roman 16 DrawText, System DrawText, Times New Roman 11 DrawText, MS Sans Serif Bold 11 DrawText, MS Sans Serif 11 GrayString, Times New Roman 13 GrayString, MS Sans Serif 13 GrayString, Times New Roman 16 GrayString, System GrayString, Times New Roman 11 GrayString, MS Sans Serif Bold 11 GrayString, MS Sans Serif 11 TabbedTextOut, Times New Roman 13 TabbedTextOut, MS Sans Serif 13 TabbedTextOut, Times New Roman 16 TabbedTextOut, System TabbedTextOut, Times New Roman 11 TabbedTextOut, MS Sans Serif Bold 11 TabbedTextOut, MS Sans Serif 11
	· The next group of tests fill, frame, or invert rectangular portions of the screen:
	FillRect FrameRect InvertRect FillRect, Square FrameRect, Square InvertRect, Square
	· The USER Tests suite also includes tests that scroll rectangular regions of the screen, draw rectangles that indicates selection or focus, and draw icons:
	ScrollDC DrawFocusRect DrawIcon
	WinBench's disk tests
	The Disk WinMark
	The Disk Tests

	Disk, Mix Disk, Read, Sequential, 200 bytes Disk, Read, Sequential, 512 bytes Disk, Read, Sequential, 2048 bytes Disk, Read, Sequential, 4096 bytes Disk, Write, Sequential, 200 bytes Disk, Write, Sequential, 512 bytes Disk, Write, Sequential, 2048 bytes Disk, Write, Sequential, 4096 bytes Disk, Read, Random, 200 bytes Disk, Read, Random, 512 bytes Disk, Read, Random, 2048 bytes Disk, Read, Random, 4096 bytes Disk, Write, Random, 200 bytes Disk, Write, Random, 512 bytes Disk, Write, Random, 2048 bytes Disk, Write, Random, 4096 bytes
	Other test suites

	Appendix B Troubleshooting
	· If your PC crashes while WinBench's disk tests are running, WinBench may not clean up its test files. Check the directory where WinBench puts the Disk Mix files. You may need to clean up the files in that directory. To do this:
	· If you receive error messages indicating that files are inaccessible or do not exist while installing WinBench, you may not have sufficient disk space to install WinBench. This error can also occur when you are running on a compressed drive because the disk compression product may be incorrectly estimating the compression ratio to be too high.
	· If you are trying to remove WinBench from your system, the UNINSTAL.BAT file may not run from the Windows File Manager program. If a problem occurs while running UNINSTAL.BAT, WinBench displays a message saying you may not have enough Environment space and suggests you run the .PIF version of the file. In that case, just run UNINSTAL.PIF.
	· Write down the error messages exactly.
	· Write down the contents of the status bar at the bottom of the WinBench screen.
	· Describe how you were using the PC.
	· Send this information to ZDBOp. See Appendix C for information on how to contact ZDBOp.
	WinBench error messages
	1. Restart Windows.
	2. Halt all other applications except WinBench.
	3. Try WinBench again.
	1. Make sure the file exists.
	2. Make sure you have access to the file and its directory.
	3. Check to see if the file is write protected.
	4. Check to see if the file has been corrupted.
	1. Make sure you have enough disk space available on the drive where the test is running.
	2. Make sure you have write access to the drive.
	3. If the drive is compressed make sure the disk compression product is not calculating the compression ratio too high.

	It must be a valid drive letter from A-Z.
	DOS Virtual machines can affect the performance of WinBench when Windows is running in enhanced mode. Terminate all DOS programs before starting WinBench.
	Moving the mouse generates interrupts that slow the performance of the test. Don't do it for maximum performance.
	1. Make sure you are using the correct version of the operating system.
	2. Reinstall WinBench to get the correct libraries.

	You can only run WinBench on Windows 3.1 or later.
	You clicked on the Run button when there are no currently selected tests.
	Terminate other applications before running WinBench.
	You do not have any disk tests in the set of currently selected tests.
	You must change the test Description field in the Questionnaire before saving the results.
	NOTE: See the README.WRI file for a list of known incompatibilities with video drivers.
	1. Restart Windows.
	2. Re-install WinBench,
	3. Do not run other applications except WinBench.
	If the error persists, contact ZDBOp.

	Check the file for corruption or inaccessibility.
	Check the file for corruption or inaccessibility.
	Replace it with the original version.
	Check for a corrupted file.

	Appendix C Technical Support
	Requesting a benchmark
	NOTE: The Winstone 94 CD-ROM also includes WinBench and PC Bench. Thus, if you get the Winstone 94 CD-ROM, you will actually get all three benchmarks.

	Ordering a printed manual
	Contacting ZDBOp
	· If you have a modem and communications software, you can use the ZDBOp forum on ZiffNet, the Ziff-Davis on-line service. The ZiffNet forum is a way for you to communicate your questions and comments to ZDBOp, get tips for running WinBench, report bugs, offer suggestions for the future, and get the latest versions of the Ziff-Davis benchmark. (You can access ZiffNet via CompuServeâ. CompuServe is available for a fee.)
	To get to the ZDBOp forum, type GO ZDBENCH at any prompt.
	You can find information on WinBench in the PC MagNet and PC Week forums on ZiffNet
	· You can fax your questions and comments directly to WinBench Technical Support at the ZDBOp benchmark fax number (919‑380‑2879).
	· You can mail your questions and comments to ZDBOp at the following address:

	Benchmark Request Form
	Ziff-Davis Benchmarks' Manual Order Form
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